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Foreword
Welcome to The Colorist Guide to DaVinci Resolve 18.
DaVinci Resolve 18 is the only post-production solution that combines editing, color 
correction, visual effects, motion graphics, and audio post-production all in one software 
tool! Its elegant, modern interface is fast to learn for new users yet powerful enough 
for the most experienced professionals. DaVinci Resolve lets you work more efficiently 
because you don’t have to learn multiple apps or switch software for different tasks. It’s 
like having your own post-production studio in a single app!

DaVinci Resolve 18 adds Blackmagic Cloud support for remote collaboration, DaVinci 
proxy workflow, new Resolve FX, intuitive object masking, improved subtitling for editors, 
Fairlight fixed bus to FlexBus conversion, and so much more!

Best of all, Blackmagic Design offers a version of DaVinci Resolve 18 that is completely 
free! We’ve made sure that this version of DaVinci Resolve includes more features than any 
paid editing system. That’s because at Blackmagic Design we believe everybody should 
have the tools to create professional, Hollywood-caliber content without having to spend 
thousands of dollars.

I invite you to download your copy of DaVinci Resolve 18 today and look forward to seeing 
the amazing work you produce!

Grant Petty  
Blackmagic Design
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Getting Started
Welcome to The Colorist Guide to DaVinci Resolve 18, an official Blackmagic Design-
certified training book that teaches professionals and students how to get the most out 
of color grading using DaVinci Resolve 18. All you need is a Mac or Windows computer, 
the free download version of DaVinci Resolve 18, and a passion to learn about the art of 
color grading.

This guide blends practical, hands-on exercises with the aesthetics and technical aspects 
of the colorist’s art to help you discover new techniques for whatever tasks you take on. 
You’ll learn how to use the program’s many grading tools and workflows and gain an 
in-depth understanding of advanced techniques and creative industry practices. Some 
exercises will even take you into the realm of compositing, which is an increasingly required 
skill of contemporary colorists.

About DaVinci Resolve 18
DaVinci Resolve is the world’s fastest growing and most advanced editing software. It also 
has a long history of being the world’s most trusted application for color correction. In 
addition to its world-class color grading toolset, DaVinci Resolve 18 is a professional-level 
nonlinear editing and effects application with a complete set of professional audio editing 
and mixing tools that enable you to complete projects using only one piece of software!
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What You Will Learn
In these lessons, you will work with multiple projects to learn fundamental and advanced 
techniques used in several editing genres. You’ll acquire practical skills that you can apply 
to real-world productions.

Part I
Part I of the book will have you restoring a documentary edit from a DaVinci Resolve 
archive file. The three lessons within this section focus on fundamental grading theory 
and practices. You will normalize and balance footage with the primary grading tools in 
Lesson 1, match shots for continuity in Lesson 2, and use secondary grading tools to target 
specific elements in Lesson 3.

Part II
Part II looks at more advanced approaches to the grade node structure in the context of 
a feature film trailer. In Lesson 4, you will migrate the project to DaVinci Resolve using an 
XML file format. In Lesson 5, you will more fully explore the importance of node order and 
consider incorporating mixer nodes to ensure the optimal color outcome. In Lesson 6, 
you will practice different methods of managing and copying grades with an eye toward 
developing efficient, quick workflows.

Part III
Part III will focus more strongly on the optimization of grading workflows to ensure a 
quick, accurate process, as well as looking at the unique properties of high dynamic 
range footage. In Lesson 7, you will look at a variety of methods of controlling the image 
frame and properties, as well as advanced keyframing, compositing, and noise-reduction 
techniques. Lesson 8 incorporates the classic grading workflow into a group-based 
pipeline that will allow you to grade entire segments of the timeline in one node tree. 
Lesson 9 demonstrates the different approaches you could take when starting a grading 
workflow with raw media and emphasize its extended grading potential in the HDR 
grading palette. Finally, Lesson 10 covers project delivery from basic preset setup to 
custom renders and DCP workflows.

The appendix at the end of the book provides additional information about the Davinci 
Resolve panels, as well as giving an overview of the DaVinci Resolve Mini Panel.
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The Blackmagic Design Training 
and Certification Program 
Blackmagic Design publishes several training books that take your skills farther in 
DaVinci Resolve 18. They include:

 — The Beginner’s Guide to DaVinci Resolve 18

 — The Colorist Guide to DaVinci Resolve 18

 — The Editor’s Guide to DaVinci Resolve 18

 — The Fairlight Audio Guide to DaVinci Resolve 18

 — The Visual Effects Guide to DaVinci Resolve 18

Whether you want an introductory guide to DaVinci Resolve or you want to learn more 
advanced editing techniques, color grading, sound mixing, or visual effects, our certified 
training program offers a learning path for you. Please visit www.blackmagicdesign.com/
products/davinciresolve/training to find the rest of the books in our training series.

System Requirements
This book supports DaVinci Resolve 18.1 for Mac and Windows. If you have an older 
version of DaVinci Resolve, you must upgrade to the current version to follow along with 
the lessons.

NOTE The exercises in this book refer to file and resource locations that 
may differ if you’re using the software version from the Apple Mac App Store. 
For the purposes of this training book, if you are using macOS, we recommend 
downloading the DaVinci Resolve software directly from the Blackmagic Design 
website rather than the Mac App store.

http://www.blackmagicdesign.com/products/davinciresolve/training
http://www.blackmagicdesign.com/products/davinciresolve/training
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Download DaVinci Resolve
To download the free version of DaVinci Resolve 18 or later from the 
Blackmagic Design website:

1 Open a web browser on your Windows or Mac computer.

2 In the address field of your web browser, type: www.blackmagicdesign.com/products/
davinciresolve.

3 On the DaVinci Resolve landing page, click the Download button.

4 On the download pop-up page, choose if you will work in the free version of DaVinci 
Resolve (left), or if you will purchase DaVinci Resolve Studio (right), and then click 
the button that corresponds to your computer’s operating system. The free version 
of DaVinci Resolve features most of the tools you will need to produce and deliver 
a professional grade. You can complete the lessons in this book and pass the 
certification exam using the free version of DaVinci Resolve, although some exercises 
will prompt you to use DaVinci Resolve Studio.

5 Follow the installation instructions to complete the installation.

When you’ve completed the software installation, follow the instructions in the following 
section to download the content for this book.

Acquiring the Lesson Files
The DaVinci Resolve lesson files must be downloaded to your Mac or Windows computer 
to perform the exercises in this book. 

To Download and Install the DaVinci Resolve Lessons Files:
1 Open a web browser on your Windows or Mac computer.

2 In the address field of your web browser, type: www.blackmagicdesign.com/products/
davinciresolve/training.

3 Scroll the page until you locate The Colorist Guide to DaVinci Resolve 18.

4 Click the Lesson Files Part 1 link to download the media for the first section of the 
book. The BMD 18 CC - Project 01.zip file is roughly 2 GB in size.

5 Click the Lesson Files Part 2 link to download the media for the second section of the 
book. The BMD 18 CC - Project 02.zip is roughly 1.10 GB in size.

6 Click the Lesson Files Part 3 link to download the media for the third section of the 
book. The BMD 18 CC - Project 03.zip is roughly 2.30 GB in size.

http://www.blackmagicdesign.com/products/davinciresolve
http://www.blackmagicdesign.com/products/davinciresolve
http://www.blackmagicdesign.com/products/davinciresolve/training
http://www.blackmagicdesign.com/products/davinciresolve/training
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7 After downloading the zip files to your computer, open your Downloads folder and 
double-click to unzip them (if they haven’t unzipped automatically). 

8 In your chosen storage location—for example, the Movies folder (Mac) or Videos folder 
(Windows)—create a new folder called BMD 18 - The Colorist Guide.

9 From your Downloads folder, drag the BMD 18 CC - Project 01, BMD 18 CC - Project 02, 
and BMD 18 CC - Project 03 folders into the BMD 18 - The Colorist Guide folder that 
you created in the previous step.

10 You are now ready to begin Lesson 1, “Balancing Footage.”

After you have completed an exercise, you have the option to review the completed 
timeline that is included in every project file provided with the media. Keep in mind that 
color grading is a subjective practice, and your results will often differ from the completed 
timelines. Rather than attempting to match your work exactly, use them for general 
comparison and troubleshooting.

Getting Certified
After completing this book, you are encouraged to take a 1-hour, 50-question online 
proficiency exam to receive a certificate of completion from Blackmagic Design. The link 
to the online exam can be found at the end of the last lesson in this book and on the 
Blackmagic Design training web page.

The training page also provides information about our official Training and 
Certification Program and features additional training videos: www.blackmagicdesign.com/
products/davinciresolve/training.

http://www.blackmagicdesign.com/products/davinciresolve/training
http://www.blackmagicdesign.com/products/davinciresolve/training
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Introducing Blackmagic Cloud
DaVinci Resolve is the world’s only complete post-production solution that lets everyone 
work together on the same project at the same time. Traditionally, post-production 
follows a linear workflow with each artist handing off to the next, introducing errors and 
mountains of change logs to keep track of through each stage. With DaVinci Resolve’s 
collaboration features, each artist can work on the same project, in their own dedicated 
page with the tools they need. 

Now Blackmagic Cloud lets editors, colorists, VFX artists, animators, and sound engineers 
work together simultaneously from anywhere in the world. Plus, they can review each 
other’s changes without spending countless hours reconforming the timeline.

Simply create a Blackmagic Cloud ID, log in to the online DaVinci Resolve Project Server, 
and follow the simple instructions to set up a new project library—all for one low 
monthly price! 

Once created, you can access this library directly from the Cloud tab in the Project 
Manager to create as many projects as you need—all stored securely online. Then invite up 
to 10 other people to collaborate on a project with you. With a simple click, they can relink 
to local copies of the media files and start working on the project immediately, with all their 
changes automatically saved to the cloud.

Enabling Multiple User Collaboration for your project means that everyone can work on 
the same project at the same time—edit assistants, editors, colorists, dialogue editors, 
and visual effects artists can now all collaborate wherever they are in the world in a way 
never before possible.

Media Sync with Blackmagic Cloud Store
Now you don’t need to buy expensive proprietary storage that needs an entire IT team to 
manage! Blackmagic Cloud Store has been designed for multiple users and can handle the 
huge media files used by Hollywood feature films. You can also have multiple Blackmagic 
Cloud Stores syncing the media files with your Dropbox account so that everyone has 
access to the media files for the project.

To find out more about these exciting workflows, visit blackmagicdesign.com/products/
davinciresolve/collaboration

http://blackmagicdesign.com/products/davinciresolve/collaboration
http://blackmagicdesign.com/products/davinciresolve/collaboration
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Interface Review
“No matter how much post experience you have, there’s always something new to learn 
about DaVinci Resolve. I sometimes find that going back and reviewing the basics helps 
give you perspective on finding a new way to give clients the look they want quickly and 
efficiently. Highly recommended for newcomers and veteran colorists alike.”

Marc Wielage, Senior Colorist - Chroma | Hollywood

This section contains an overview of the color page interface to inform 
you of its key functions and to establish the terminology that will be used 
throughout the book.

Color Page Layout
The default layout of the color page contains the following panels:

Gallery Thumbnail timeline

Primaries color wheels

Viewer

Curves

Node Editor

Keyframes EditorMini-timeline
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Gallery contains stills that can be used for visual comparison or for copying grading 
data. Stills can be generated from the color page or imported from an external source 
and organized into albums.

Viewer displays the selected clip with playback controls and offers additional 
interface tools.

Node Editor allows grades and effects to be structured to maximize the visual quality 
of each clip.

Thumbnail timeline represents each clip as a single frame, making it easy to navigate 
and find individual clips.

Mini-timeline more closely resembles the track structure of the edit page.

Primaries color wheels control the tonal and chromatic values of an image on the 
basis of three luminance ranges (lift, gamma, and gain).

Curves give precise control over the tonal values of an image based on RGB and 
luminance curves.

Keyframes Editor allows you to animate color grades, sizing parameters, and effects.

At the top of the color page, the interface toolbar features a series of buttons that allow 
you to show and hide panels as needed. Hiding panels (for example, the Mini-timeline or 
the Gallery) will create more space for the viewer and remaining panels.

NOTE If your screen resolution is less than 1920 x 1080 HD, there may be some 
differences in the interface layout. For example, your left and central palettes 
will be combined into a single list on the left side of the screen. In some palettes, 
parameters such as the Matte Finesse may be presented on two pages rather than 
as a single list. Regardless, you will still have access to all the tools described in this 
training manual.
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Viewer
The viewer shows the frame that the playhead is currently on. By default, clips are represented 
as they will appear upon final render. Some additional features allow you to temporarily 
bypass grades, see a representation of a clip’s matte, and to compare clips to one another.

Some additional controls at the top and bottom of the viewer maximize the functionality of 
the tools in the color page.

TIP You can position your mouse pointer over any tool in the color page to 
see its name.

Image wipe enables you to wipe between a still, reference frame, or another clip in 
the timeline for visual comparison and matching.

Split screen places clips alongside one another for review and comparison. It features 
several modes to allow comparison between clips on a timeline, in the same group, or 
even versions of grades within the same clip.

Highlight is enabled to reveal the matte that is associated with a selected node.

Onscreen control menu is a pop-up menu in the lower left of the viewer that 
features a selection of UI controls associated with some of the palettes and effects of 
the color page.

The bottom of the viewer contains a scrubber and transport controls that allow you to 
navigate the clip as you would in the edit page.
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Primaries Color Wheels
The Primaries color wheels (and the corresponding color bars and log wheels) allow you 
to affect the brightness and hue of the image by targeting specific luminance ranges. 
Adjustments to the color wheels are made by dragging the color balance indicators at 
the center.

Lift targets the shadows of the image. 

Gamma targets the midtones of the image. 

Gain targets the highlights of the image.

Offset affects the entire image uniformly.

Master wheels are the dark horizontal sliders beneath the color wheels that control 
the YRGB values of those respective ranges, with Y representing luminance and RGB 
representing the red, green, and blue channels of the image.

Clicking the Reset arrows in the upper-right corner of each wheel will neutralize the color 
and master wheel of that range. You can also reset the entire palette by clicking the Reset 
All button next to the palette tool buttons.

The adjustment controls at the top and bottom of the Primaries palette give additional 
control over the image with features such as contrast and saturation, temp and tint, 
and so on. 

Interface Review
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Palette Panel
A series of buttons under the timeline enable you to navigate between the palettes 
available on the color page. From left to right, these palettes are:

Left palettes—Camera Raw, Color Match, Color Wheels, HDR Grade, RGB Mixer, 
Motion Effects

Central palettes—Curves, Color Warper, Qualifier, Window, Tracker, Magic Mask, Blur, 
Key, Sizing, 3D

Keyframes Editor—Keyframes, Scopes, Info

Use these buttons to navigate between palettes when prompted during the exercises. The 
name of each palette appears in the upper-left corner when clicked, as well as over the 
button itself when your mouse pointer hovers over it.
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Part I

Color Correcting 
a DaVinci Resolve 
Timeline
Lessons

 — Balancing Footage

 — Creating Color Continuity

 — Correcting and Enhancing Isolated Areas

Part I of The Colorist Guide to DaVinci Resolve 18 focuses on establishing a strong practical 
foundation of primary and secondary grading techniques with additional focus on 
balancing and matching media in preparation for creative grading.

Each part of this guide focuses on its own project, and each project is set up to explore the 
variety of methods for starting a grade in DaVinci Resolve. In Part 1, the project is accessed 
using DaVinci Resolve’s archiving feature.

Project File Location
You will find all the necessary content for this section in the “BMD 18 CC - Project 01” 
folder. Follow the instructions at the start of every lesson to find the necessary 
project, timeline, and media files. If you have not yet downloaded the first set of 
content files, go to the “Getting Started” section of this book for more information.

NOTE Although you can use DaVinci Resolve 18 for most of this guide, 
some exercises will require DaVinci Resolve Studio 18. If you don’t have 
DaVinci Resolve Studio 18, you can still complete such exercises with a watermark 
overlay and are encouraged to do so to learn how they operate.
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Time
This lesson takes approximately 
90 minutes to complete.

Goals
Opening a DaVinci Resolve  
Archive 4

Setting Up Project Backups 5

Understanding the 
Grading Workflow 7

Setting Tonal Range and Contrast 9

Balancing Colors 19

Comparing Color and Log Wheels 23

Self-Guided Exercises 34

Lesson Review 35

Lesson 1

Balancing Footage

The first project you will grade is 
a documentary about protecting 
endangered rhinos. The workflow 
described is applicable to virtually 
all types of video project grading, 
but documentary cinematography 
is particularly dependent on the 
following actions:

 — Balance footage Documentary 
videographers often quickly change 
positions and locations during 
a shoot, which means they have 
less shot-to-shot control over 
lighting conditions.

 — Match shots Scenes, interviews, and 
B-roll can be shot over many days 
with different cameras, requiring you 
to visually match all content to create 
a cohesive narrative.

 — Improve imagery A variety of 
techniques are used to confine 
grading to specific portions of a shot 
to enhance skies, skin tones, and 
visual framing.
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You wouldn’t color grade a somber documentary about rhinoceros sanctuaries as you 
would grade a 30-second perfume ad featuring the latest Hollywood A-lister, even if 
both projects were shot on the same type of camera. So, in addition to addressing the 
technical requirements of the footage, you will also consider the documentary’s narrative 
considerations.

In this lesson, you’ll familiarize yourself with the primary grading tools used to normalize 
and balance clips on a timeline, learn to read waveforms and parade scopes for optimal 
matching, and employ secondary grading selection methods to enhance your final look. 
You will do so in the context of an overall grading workflow that addresses the needs of 
each timeline clip.

Opening a DaVinci Resolve Archive
This book is divided into three distinct parts, each devoted to a different genre and using 
three different project setup methods. The first method uses timelines that have been 
edited and archived in DaVinci Resolve 18 to create a DaVinci Resolve archive (.dra)  folder. 
This is one of the most efficient methods for sharing and launching timelines because it 
includes the original project file and all its associated media. By restoring the .dra folder, 
you can be certain that you are seeing the timeline exactly as intended by the editor, with 
all its tracks, transitions, graphics, and retiming intact.

Blackmagic Design Mini Panel Operations
DaVinci Resolve control panels are designed to give you fluid, hands-on control 
over multiple parameters at the same time, so you can work faster and be more 
creative. See the appendix, “Setting Up and Using the Blackmagic Design Mini 
Panel,” for an overview of how a control panel can optimize your workflow in 
DaVinci Resolve. Throughout this book, lesson notes will show how exercise 
workflows can be incorporated and enhanced using a Mini Panel.

NOTE For a quick refresher course on the DaVinci Resolve interface, see the 
“Interface Review” section earlier in this book.

1 Open DaVinci Resolve 18.

2 Right-click in the Project Manager window and choose Restore Project Archive.
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3 On your hard disk, locate the “BMD 18 CC - Project 1” folder.

4 Select the Project 01 - Disunity Documentary.dra file and click Open.

5 In the Project Manager, double-click the Project 01 - Disunity Documentary 
thumbnail to open the project.

6 To enter the color page, click the Color button at the bottom of the interface or 
press Shift-6.

7 Verify that you are on the 01 Main Timeline. 

The name of the timeline appears above the viewer. You can select the active timeline 
by clicking the disclosure arrow next to the timeline name and choosing from the 
dropdown list.

TIP You can archive projects by right-clicking a project thumbnail in the  
Project Manager and choosing Export Project Archive. Doing so will 
consolidate your project file, timelines, and media into a single folder for 
sharing or future retrieval.

You’re almost ready to start grading! However, before you begin, you should check that 
your project is being backed up correctly.

Setting Up Project Backups
As soon as you create or load an existing project, it is good practice to ensure that 
DaVinci Resolve’s Live Save feature is running in the background. Performing incremental 
background saves will keep track of every change you make to your project, as well as 
retain older variants of your project for future recall.



6 Lesson 1 Balancing Footage

1 Open DaVinci Resolve > Preferences.

2 At the top of the Preferences pop-up window, switch from System to User.

3 Click “Project Save and Load” to the left to access Save Settings.

By default, Live Save is enabled, so DaVinci Resolve will overwrite your active project 
file every time you make a change, no matter how small. Enabling this setting is crucial 
to minimize the risk of losing any project changes in the event of unexpected system 
or program shutdowns.

4 Select the “Project backups” checkbox.

Enabling this option saves a new copy of your project file at regular intervals to a 
designated backup location.

5 To select the backup location, click Browse and specify a save destination on your 
workstation or external drive.

By default, a backup project is generated every 10 minutes, regardless of the number of 
changes you make during that period. Eventually, older project backup files are cleared 
from the project storage, except for files that extend over longer hourly and daily 
intervals. This behavior can be extremely helpful when working on long-form projects 
because it allows you to return to the state of a project from a specific period (two 
weeks ago, for example) without sorting through thousands of backed up project files.

6 Click Save to commit the change and close the Preferences window. You may now 
continue working on your project, safe in the knowledge that your every change is 
backed up.
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NOTE To open a backed-up project file, you can access the DaVinci Resolve Project 
(.drp) file at the designated backup location on your drive, or you can open the 
Project Manager, right-click the thumbnail of the project you wish to restore and 
choose Project Backups. In a pop-up window, you can select from a list of all the 
backups associated with the project.

With the project loaded and Live Save enabled, you can proceed with actual color grading. 
But where to begin? When approaching an ungraded timeline, it’s not always obvious 
where your starting point should be. The next section provides a general overview of the 
grading process. 

Understanding the 
Grading Workflow
It is good practice to have a clear idea of what your workflow is before beginning a grade. 
Your workflow is informed by a variety of factors including the color space and format of 
your footage, the way the timeline was shared with you, the content of the scenes, and the 
aesthetic/emotional intention behind the project. Let’s review the most common phases of 
a grading workflow.

Balancing and Shot Matching
Before you can grade footage creatively, you must adjust shot luminance and chrominance 
to create a level starting point for your grade. This process is akin to laying down a primer 
on a canvas before painting to ensure that the pigment is applied to a consistent surface.

A single grade applied to five balanced and matched shots will establish a visual continuity 
that flows naturally from one shot to the next, whereas the same grade applied to 
unbalanced and mismatched shots will continue to reflect each shot’s differences.

This stage of grading is often referred to as color correction and is achieved by means of 
primary grading tools, in which the entire frame of the image is adjusted. Color correction 
is performed using techniques such as normalization, balancing, and shot matching.

Normalization and balancing involve creating a neutral starting point for clips in the 
timeline by consistently adjusting the luminance levels of each and neutralizing any issues 
with their color balance.
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Shot matching involves comparing clips and matching their contrasts and colors exactly. 
This technique is particularly advantageous when most of your clips already have a similar 
look, and you need to tweak only a few exceptional shots to create a smooth starting point 
for your scene grade.

Performing Secondary Grading
Secondary grading refers to any part of the grading process in which only a part of an 
image is altered. The potential for secondary grading is limitless, but it is mainly achieved 
by two means: keying and masking.

Keying targets a portion of an image based on a hue, saturation, or luminance range. In 
DaVinci Resolve, the main tool for key extraction is the qualifier, though other tools also 
rely on this method of selection, including HSL curves, Color Warper, and some Resolve FX. 

Masking employs geometric vector shapes to isolate a portion of an image. 
DaVinci Resolve’s masking interface, the Window palette, features Power Window tools in 
the form of preset shapes (linear, circle, polygon, and gradient), and a customizable curve 
window that enables you to generate garbage mattes and rotoscopes (animated masks). 
The Magic Mask palette performs a similar task by automatically detecting and tracking 
objects and people to generate masks.

Like the qualifier, Power Windows cannot alter the appearance of an image directly but act 
as selectors for the grading tools.

Secondary grading is most powerful when qualifiers and Power Windows are used in 
tandem. While the qualifier focuses on extracting an element with a clean edge, a window 
can confine the qualifier’s influence to a specific portion of the frame. In this way, it’s 
possible to target an object in areas of the shot that are of a similar key range.

Creating a Look
Once your clips are balanced and shot matched, and any individual secondary grading 
needs are met, your creative process, often referred to as color grading, can begin.

When performing creative grading, you should carefully consider the emotional and 
narrative implications of the scene. You can apply both primary and secondary grading 
techniques to influence an audience’s emotional perception of an environment by 
tweaking the scene’s color temperature to indicate positive (warm) or negative (cold) 
moods and evoke a wide range of psychological color and tone associations. Additionally, a 
creative grade can communicate practical narrative elements such as a change in location 
or time (for nonlinear stories).
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NOTE The grading workflow described here does not rigidly dictate the order in 
which these grades should be performed by the colorist. Although first completing 
the balancing and shot-matching stage is best practice, it’s often necessary to 
readjust grades applied in earlier stages to ensure a consistent final output, and 
in some cases, it may be necessary to skip color correction altogether. As you gain 
more experience as a colorist, you will develop an intuition for the appropriate 
approach when grading.

Visualizing the Grading Workflow 
in the Node Editor
The following chart represents a traditional grading workflow in the context of the Node 
Editor in DaVinci Resolve’s color page.

This graph is not intended as a literal guideline to how nodes should be structured 
but rather a representative overview of how nodes relate to one another and their 
relative positions.

Setting Tonal Range and Contrast
The human eye is particularly sensitive to light sources and shadows, which is why it makes 
sense to begin the color correction process by establishing the tonal range of an image.

In the following exercises, you will adjust luminance using master wheels and curves while 
also learning about the waveform monitor.
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Normalizing with Master Wheels
The color wheels are among the most integral primary color correction tools to learn to 
use when adjusting image hue. Beneath them, the master wheels allow you to set the tonal 
range and contrast of an image by altering its luminance.

TIP To reset a page to the default layout, choose Workspace > Reset UI Layout. 
You may want to do this at the start of every new project in this book to match 
the layout shown in the screenshots. Additionally, you can choose Workspace > 
Full Screen Window to dynamically resize DaVinci Resolve to fit your computer 
screen.In this exercise, you will adjust the shadows and highlights using the master 
wheels. You’ll also refer to the waveform scope to monitor your adjustments for 
unwanted clipping.

1 Select clip 02.

By default, the palette in the lower-right corner of the DaVinci Resolve interface is set 
to the Keyframes palette. You will switch it to display scopes so you can analyze your 
footage while you color correct it.

2 Click the Scopes palette button on the right side of the page.
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3 At the top of the Scopes palette, click Parade to reveal a scopes dropdown menu and 
select Waveform. 

The waveform scope displays the luminance and color channel values of the video at 
the precise timeline position of the playhead.

The vertical axis of the scope represents the entire potential luminance range of 
the image.

The bottom of the display represents the blackest black (0 in a 10-bit depth signal), and 
the top represents the whitest white (1023 in 10-bit). Everything in between represents 
the midtones range of the image in a grayscale format.

The horizontal axis represents the image itself and can be read across both the graph 
and the monitor. You can think of the display as showing the distribution of the pixels 
(the trace) across their respective vertical columns based on their luminance levels, 
with darker areas of the footage toward the bottom of the graph and lighter areas 
displayed toward the top.

Each color channel is overlapped in the trace. White in the trace indicates that each 
channel has an equal intensity. When adjusting tonality in an image, you can disable 
the RGB channels in the waveform and show only luminance.
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4 In the upper-right corner of the Scopes palette, click the Settings button.

5 Click the Y channel button at the top to display only the luminance of the image.

6 Deselect the Colorize option to display the trace with solid white pixels.

7 Click anywhere in DaVinci Resolve to close the waveform settings window.

Any part of the trace that goes below 0 (black point) and above 1023 (white point) in 
the luminance range will be clipped, which will result in a loss of image detail.

When normalizing footage, a good starting point is to ensure that the shadows are 
floating at around 5–10% above the black point (0) on the scope, while the pure 
white highlights (if any) should stop well under the white point (90%). This leaves the 
remaining 10% as headroom for super-white elements such as blown out headlights, 
lens flares, or metallic specular highlights that can extend beyond the white point.

8 Ensure that the Primaries palette is active in the left palettes of the color page. 

If you’ve already completed the book The Beginner’s Guide to DaVinci Resolve 18 or 
read the “Interface Review” section earlier in this book, you know that the Lift wheel 
affects the image shadows, the Gamma wheel affects the midtones, and the Gain 
wheel affects the highlights. The Offset wheel impacts the entire luminance range of 
the image uniformly.
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The horizontal wheels located under the color wheels are called master wheels and 
impact the lightness values of their respective ranges.

9 Drag the Lift master wheel to the left to darken the shadows. Because this image has 
detail in the darkest areas of the wood, aim to place the lowest parts of the waveform 
trace above 0 but below the 128 line.

Notice the three areas of the graph where the trace of the waveform dips toward the 
black level. Try to locate their respective positions in the frame.

Those three dark areas correspond to places where the barrier is visible behind the 
wooden poles in the enclosure. The darkest areas of the barrier are represented by a 
pronounced dip in the graph.

10 You can use the Gain master wheel to brighten the lighter areas of the image. The 
image has no chart or reference for pure white, but you could use the thumb in the 
image as a luminance indicator. The highlights on skin should rest between 50–75% on 
the waveform graph. Drag the Gain master wheel so the tallest traces do not go higher 
than three-fourths of the waveform graph.

This is an example of using image context for balancing and grade adjustment. In 
future exercises, you will continue to identify elements that you could use as a guide 
for grading decisions.

With the shadow and highlight levels set, you will want to adjust the brightness of 
the midtones.
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11 Drag the Gamma master wheel to the right to brighten the overall scene and enhance 
the details of the rhino’s wrinkled skin.

After establishing the tonal range, you can further enhance the image details. The 
master wheels affect the luminance too broadly at this stage, so you could use the 
contrast control to refine the distinction between the darker and lighter areas.

12 At the top of the Primaries palette, in the adjustment controls, drag the Contrast 
setting to the right to increase the level of detail in the skin and the wooden poles.

Your image may start to look a little dark, but that’s OK. So far, you’ve only been 
focusing on the depth of the shadows and the details in the midtones.

13 To increase brightness while maintaining the shadows and level of contrast, drag the 
Pivot control next to the Contrast parameter.

The Pivot control establishes the contrast balance by placing more priority or less 
priority on either side of the luminance scale. By pivoting to the left, you will increase 
the overall brightness and clarity of the image, at the inverse expense of the shadows, 
which will be reduced.

Finally, you will address the magenta tint in the resulting image. 

14 Drag the Tint field left until the pink tone of the rhino is reduced.

15 Drag the Temp field left to further “cool down” the image and turn the rhino gray.
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16 Press Command-D (macOS) or Ctrl-D (Windows) to toggle the grade on and off. 
Compare your before and after results to evaluate how normalization and contrast 
affected the image. Tweak the values if the grade appears overpowering.

Bypassed Graded

TIP Another way to disable/enable node grades is by pressing the number of a 
node in the Node Editor. 

The grading process usually requires a lot of back-and-forth tweaking of palette values 
while monitoring the waveform. Some changes dramatically offset the effects of prior 
adjustments—as in this example, when increasing the contrast darkened the shadows and 
prompted additional tweaks. Iteration is a completely natural part of the grading process.

NOTE You can undo an action in DaVinci Resolve by pressing Command-Z (macOS) 
or Ctrl-Z (Windows). The undo function is stacked to each clip in the timeline. So, 
when you undo, only the changes from the selected clip are removed, and not from 
any other clips on the timeline, even if you graded them more recently.
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Using the Mini Panel—Offset Mode
Whereas the DaVinci Resolve 18 interface shows four wheels within the Primaries 
palette (Lift, Gamma, Gain, and Offset), you’ll notice that the hardware-based Mini 
Panel has just three trackballs and rings. To access the Offset wheel functionality, 
press the Offset button directly above the Gamma trackball. When the Offset 
button is illuminated, the Gain trackball and ring will control the Offset color and 
master wheels. 

Additionally, when Offset mode is enabled, the Lift and Gamma wheels are 
mapped to control temperature and tint, respectively. To return to the default 
layout, press the illuminated Offset button again. When it no longer lights up, your 
trackballs and rings will return to controlling Lift, Gamma, and Gain.

Setting Contrast with Increased Flexibility
Curves are another major grading tool used to perform primary and secondary 
adjustments. Whereas the master wheels target the tonal ranges of an image, the curves 
affect the image based on its luminance or RGB color channels.

The curves controls allow you to manipulate the image with great precision and flexibility.

1 In the timeline, select clip 03, which shows an image of a scale.
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Because the colors in the image are flat, most of the waveform graph is condensed 
in the lower midtones. A significant elevation appears to the left, where a window is 
positioned behind the scale, and to the right you’ll see a gentle peak where the light 
reflects off the plastic rim.

2 Choose Workspace > Viewer Mode > Enhanced Viewer or press Option-F (macOS) 
or Alt-F (Windows) to enlarge the viewer.

The Clips timeline and surrounding palettes collapse, dynamically enlarging the size 
of the viewer panel. The image becomes much easier to see for grading work.

3 Ensure that the Curves palette is active in the central palettes of the color page.

The lower left of the curve graph represents the blackest potential point of the image, 
and the upper-right represents the whitest.

The horizontal axis represents the potential luminance range of the image, while the 
vertical axis represents the offset of that luminance range. By raising or lowering the 
two control points at either extreme of the curve, the black point and the white point, 
you can manipulate the distribution of the tonal ranges.

By default, the luminance curve (Y) will be visible for adjustment, ganged to all three 
color channels (R, G, B).

4 For finer adjustments, turn the Curves palette into a floating window by clicking the 
Expand button in the upper-right corner.

To move the window, drag the header. To resize the window, drag the sides 
and corners.
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5 Click the Y channel button to ungang the channels.

Now, instead of adjusting the RGB values, which will impact the image saturation, you 
will alter only the image luminance.

6 Drag the lowest control point on the luminance curve across the floor to the right.

Doing so lowers the waveform of the image linearly, darkening the shadows more than 
the highlights.

7 Stop dragging the control point when the bottom of the trace is still above the 0 line 
of the waveform.

8 To raise the top of the waveform, drag the highest control point across the top of 
the graph. 

Normally, you’d stop when the top of the trace touches the second horizontal line in 
the waveform graph (896), but because this part of the trace represents a very bright 
window in the video clip, it makes sense to continue raising it until the trace is about 
halfway between the top horizontal lines on the graph.

You can add more control points to the curve to manipulate the midtones of the 
image. Let’s tackle the lower midtones that appear too dark after performing that 
black point adjustment.

9 Click the lower half of the curve to create a new control point that will target the 
lower midtones.

TIP When creating a control point, Shift-click to prevent the curve from moving 
to the position of the mouse.
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10 Drag the control point up to raise the lower midtones and brighten the face of 
the scale.

Many colorists prefer setting the tonal range using curves because curves 
offer much finer control over every luminance level of the image and allow for 
customizable contrast.

Bypassed Graded

Balancing Colors
After adjusting the tonal range and contrast, you should carefully examine the colors and 
neutralize them in preparation for grading. An unbalanced image will affect the precision 
of your grade, along with the quality of any keyed elements, and will stand out in a 
sequence of balanced clips.

Balancing Color with Curves
You can use custom curves to manipulate the three color channels in great detail by 
creating dedicated control points on each segment of the channel luminance.

1 Open the Waveform settings and click the RGB button to view the RGB channels in 
the scopes.
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2 Select the Colorize checkbox to view the individual color channel representations in 
the Waveform trace.

When balancing an image using the RGB waveform, neutral tones like white, black, 
and gray, should result in an overlap of the three color channels, producing a white 
trace. In a clip with white highlights, the trace should appear white at the top of 
the waveform.

3 Review clip 03 alongside the waveform.

The red channel appears elevated above the other channels, which is giving the image 
a slightly warm tint.

4 In the Curves palette, click the red (R) button to select the red channel.

5 Click the top of the red curve and drag it downward. Pay attention to the waveform and 
drag until the red highlight overlaps the blue and green channels in the trace, resulting 
in white along the upper edge of the graph.

6 Create a second point on the red curve to perform the same action in the midtones. 
Drag downward until the lower half of the trace appears white.
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Though the red tint is corrected, the image now has a mild yellow tint because the blue 
channel has less presence in the highlights and midtones.

7 Click B to isolate the blue channel. 

8 Click the center of the blue curve line to add a control point and drag it up until the 
midtones in the waveform are aligned.

9 Press Command-D (macOS) or Ctrl-D (Windows) to disable the color adjustments and 
then re-enable the adjustments to review the corrected image.

With the luminance of the overall image altered, you could opt to return to the Y curve 
and further adjust the tonal range and contrast of the image, if necessary. When 
you’re satisfied with your work, press the X in the upper-left corner of the expanded 
Curves palette to collapse it.
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10 Choose Workspace > Viewer Mode > Enhanced Viewer or press Option-F (macOS) or 
Alt-F (Windows) to collapse the viewer back to its original size.

You have now learned how to operate the two most essential primary grading tools in 
the colorist’s arsenal. These are so vital that they are among the first two palettes to 
greet you when you enter the color page. Throughout the remainder of this book, you 
will refine your understanding of these tools and their variants, combine them with 
secondary tools and effects, and further hone your primary grading skillset.

Using the Mini Panel—Curves
You can use the Mini Panel to control curves with the help of dozens of preset 
points at your fingertips. Enter Curves mode by pressing the Curves button in the 
upper-left of the Mini Panel. If you’ve already selected a specific curve tool using 
your mouse, the Mini Panel will jump to that tool. Otherwise, the Mini Panel will 
open the custom curves interface.

The curves tools provide an excellent way to explore the versatility and 
functionality of your Mini Panel. You may activate every major curve type featured 
in DaVinci Resolve using the soft buttons above the 5-inch screens. The knobs 
below those screens allow you to control specific points of the currently activated 
curve. For custom curves, intervals of 0%, 20%, 40%, 60%, 80%, and 100% may 
be adjusted. This functionality allows you to control more than one curve point at 
once, which will save time, increase your grading efficiency, and allow you to make 
more creative color grading decisions.
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Comparing Color and Log Wheels
Before you normalize the next clip, let’s take a slight detour to understand another 
function that can be a fundamental part of primary grading and balancing: the log wheels.

It’s easier to grasp the difference between the Primaries color and log wheels by observing 
a graphic example before moving on to image adjustment. Let’s use the simple gradient 
graphic at the end of the timeline and manipulate its brightness to compare how the two 
adjustments affect it.

1 Select the last clip in the timeline (the grayscale image).

In the standard Primaries color wheels that you are familiar with, the Lift, Gamma, and 
Gain wheels target the luminance range as seen in the following figure:

Lift Gamma Gain

A wide overlap occurs between the segments. When you try to manipulate the 
shadows of the image using the Lift color or master wheels, the change also 
substantially affects the midtones, and even the lighter ranges of the image.

The waveform scope displays the gradient image as a flat diagonal line extending left 
to right from 0 to 1023, indicating its linear transition from black to white.
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2 Drag the Gain master wheel to the left to darken the upper ranges of the gradient.

In the waveform, the top of the line moves freely while the bottom of the diagonal line 
remains connected to the black point. In the viewer, the lightest part of the gradient 
is affected most severely, with tapered, but still substantial, impact visible on the 
remainder of the luminance range.

3 Reset the Gain master wheel.

4 Drag the Lift master wheel to the right to brighten the lower ranges of the gradient.

In contrast to the Gain wheel, most of the Lift wheel’s impact is on the darkest portion 
of the gradient, with the effect tapering off linearly as it reaches the top of 
the waveform.



25Comparing Color and Log Wheels

The main point is that in both the Gain and Lift adjustments, the entire image is 
changed, except for the white and black points. This is intentional because a wide tonal 
overlap creates nice, smooth transitions even in dramatic grades.

5 Reset the Lift master wheel.

When working with log wheels, the tonal ranges are much more defined:

Low Range High Range

Shadows Midtones Highlights

Manipulating the image shadows will have very little effect on the rest of the 
luminance because of the small amount of overlap between the shadows and the 
midtones ranges.

6 In the upper-right of the Primaries palette, press the rightmost icon in the list of 
primaries tools to launch the Log wheels.

On the surface, this interface looks almost identical to the color wheels. However, 
adjustments to the shadows, midtones, and highlights react very differently.

7 Drag the Highlight master wheel to the left to darken the highlights of the gradient.



26 Lesson 1 Balancing Footage

The upper half of the waveform bends until it is horizontal, but this has no impact on 
the shadows. This behavior is reflected in the viewer, in which the lightest portions of 
the gradient are darkened, while the midtones and shadows remain the same.

8 Drag the Shadow master wheel to the right to brighten the dark ranges.

This time, the lower-third of the line rises until it is parallel to the horizon.

With the waveform in this position, it’s easy to see how you can affect the overlap between 
the shadows and midtones (low range), and the midtones and highlights (high range).

9 In the log adjustment controls, drag the Low Range value left to move the shadow 
segment of the waveform lower, thereby giving priority to the midtones controls.

10 Drag the High Range value right to move the highlight segment of the waveform 
higher for the same effect, but in reverse.

TIP To further appreciate how color and log wheels differ, drag the color 
balance indicators inside the Lift and Shadow wheels to see how the gradient 
is affected. Adjusting the Lift wheel will cause the entire gradient to change 
hue, whereas dragging the Shadow wheel will constrain the color change to the 
darkest edge of the gradient.

Log wheels can be extremely useful when you’re attempting to change the brightness 
or hue of a narrower tonal range. The next exercise will demonstrate a practical use of 
switching between color and log wheels.
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Applying Log Wheel Changes to an Image
With a better understanding of how you can target different tonal ranges, you can now 
more accurately normalize and balance an image.

1 In the Scopes palette, open the Settings and change the waveform back to Y mode 
with Colorize deselected.

2 Switch the Primaries palette back to Color Wheels mode.

3 Select clip 07.

The luma waveform indicates there is some room for adjusting the image’s highlights. 

4 Drag the Gain master wheel right to increase brightness until the trace reaches the 
second horizontal line from the top.

Even though the waveform appears to be intact, the sunset on the horizon might start 
to appear “blown out.” To understand why this is happening, let’s check the Parade 
scope to determine the presence of color in the luminance ranges.

5 Switch the Scopes palette to Parade.

Waveform Parade
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The waveform represents the combined luminance of the channels, but it does not 
take into account instances of clipping within individual channels in scenes with 
pronounced chromatic brightness (such as this sunset). 

6 Reset the Gain wheel.

With reliable white and black references in an image, standard procedure is to 
neutralize the three channels to achieve balance. Without references, context is 
important. In this case, the context is the sunset with its accompanying red skyline, 
which requires an exception to the balancing rule.

7 Switch the scopes back to Waveform. With the highlights analyzed, you can focus on 
the overall brightness of the image and the balance of the dark foreground elements.

8 To increase the brightness of the image without clipping its highlights, drag the 
Gamma master wheel to the right until you have raised the darkest parts of the image 
between the 128 and 256 graticule lines. By avoiding the Gain master wheel, you’re 
more likely to prevent the red highlight from clipping.

The image shadows appear to be compressed along a narrow luminance range, which 
is causing loss of the detail in the image foreground. Adjusting the Lift master wheel 
will not sufficiently expand the compressed shadows.

9 To confirm this, drag the Lift master wheel to the left to see how dramatically it affects 
the foreground. The compressed shadows are pulled down until the entire image 
becomes too dark.

10 Reset the Lift wheel.

11 Switch the Primaries palette to Log Wheels mode.

TIP Press Option-Z (macOS) or Alt-Z (Windows) to toggle between the 
Primaries color and log wheels.

12 Drag the Shadow master wheel to the left to lower the black point without clipping it. 
Note that the tree details begin to pop out against the mountains and ground.
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13 In the adjustment controls, drag the Low Range parameter to the left to redefine the 
shadow range. Because of this narrower range, adjustments to the Shadow wheel will 
be more concentrated to the compressed shadows at the bottom of the image.

14 Drag the Shadow master wheel to the left to further expand the compressed shadows. 
Keep adjusting the Low Range and Shadow master wheel controls until you see a good 
amount of detail in the foreground of the viewer. 

Because the Shadow wheel is more dedicated to the lower ranges of luminance, it 
is not affecting the midtones as dramatically as the Lift wheel did. With the contrast 
adjusted, you can now address the colors. This image is particularly tricky because of 
the conditions under which it was captured. The sun is still rising, resulting in beautiful 
peach, purple, and blue gradients throughout the sky. You will strive to retain these 
unusual hues, while normalizing the colors in the foreground—most notably, the 
magenta in the shadows.

15 Switch the Primaries palette back to Color Wheels.

16 Gently drag the Gamma color balance indicator away from the magenta side of the 
wheel and toward green/yellow. Stop dragging before the green in the shadows 
becomes overpowering.

Bypassed Graded

You have successfully brought back a lot of detail to the foreground of the image, but this 
came at the expense of the beautiful gradient in the sky, which now appears a little washed 
out. In the next exercise, you will isolate the log grade to the foreground of the image while 
reducing its impact on the background. 
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Isolating a Grade to a Depth Plane
Resolve FX are a collection of effects and filters that enable you to adjust the physical or 
visual properties of footage in creative ways that are often not possible using common 
grading tools. You will learn secondary grading techniques in Lesson 3, but this clip is ideal 
for an early demonstration of the restorative power of secondary selection via an effect 
called Depth Map.

The Depth Map effect can automatically analyze and produce a 3D map of a scene, 
which can be used to isolate a grade to a specific plane of an environment, such as the 
foreground.

NOTE The following exercise requires DaVinci Resolve Studio to complete.

1 In the interface toolbar, click the Effects button to open the Effects panel library.

2 Scroll down the Effects Library until you find the Resolve FX Refine section.

3 Drag the Depth Map effect onto corrector node 01 until a + (plus sign) appears and 
then release. 
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The Effects panel switches to the Settings tab, which features the Depth Map effect 
parameters.

4 Wait a few moments for the Depth Map to run its analysis and output a black-and-
white image of the scene.

NOTE If you’re not using DaVinci Resolve Studio, a watermark will appear over 
the image. You can dismiss the warning dialog and complete this exercise with 
the watermark.
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The resulting matte resembles the mountain clip, with the foreground plane appearing 
the lightest gray, the mountains a darker gray, and the sky almost completely black. 
In addition to mapping the spatial environment of the scene, the matte also represents 
the area that a grade or effect will impact. White indicates full opacity, or a selected 
region, whereas black indicates transparency, or the lack of selection in that area. 
Gray implies semi-opacity and a diminished strength of selection.

You will adjust the Depth Map parameters to create a more pronounced selection of 
the foreground.

5 Under Resulting Map Adjustment, select the Adjust Map Levels checkbox to gain 
access to the Limit and Gamma controls.

6 Decrease the Near Limit (0.350) to brighten the foreground of the matte.

7 Increase the Gamma (1.050) to heighten the contrast, which will further isolate the 
foreground from the background. 

With the depth map modified to meet the needs of the image, you can now disable the 
matte preview in the viewer and review the final result. 
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8 Deselect Depth Map Preview at the top of the settings.

9 Press Command-D (macOS) or Ctrl-D (Windows) to disable the corrector node and 
then re-enable it again to see the corrected image. Review and adjust, if necessary.

TIP Press Shift-D to bypass the entire node tree and compare your work to 
the source footage. You can also bypass entire color pipelines by pressing the 
Bypass Color Grades and Fusion Effects button in the upper-right of the viewer. 

As you saw in this exercise, you can use Primaries color and log wheels together very 
effectively. Color wheels can be used to establish an initial tonal range and contrast, 
while log wheels behave like a secondary adjustment that can further refine the three 
luminance ranges.

Log wheels are particularly effective when working on underexposed or overexposed 
footage. They allow for restorative work in the high and low luminance ranges, as well 
as minor tweaks to the brightness and hues of those areas, without majorly altering the 
remainder of the image. In cases where unwanted change does occur, you can make use of 
secondary tools, like the Depth Map effect, to isolate the grade to the desired area.
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Self-Guided Exercises
Complete the following exercises in the 01 Main Timeline to test your understanding of the 
tools and workflows covered in this lesson.

Clip 01—Use curves to normalize and balance this clip by eye. Increase the Saturation 
parameter in the adjustment controls to bring out the natural colors in this underlit shot.

Clip 03—Use the contrast and pivot controls to enhance the details of the scale.

Clips 04, 05, 06, and 09—Use the Primaries color wheels and the Waveform scope to 
establish a tonal range and contrast on these clips.

Clips 12, 16, and 17—Use curves and the Parade scope to normalize these clips and 
balance their colors, as necessary.

When you’ve completed these exercises, open the 04 Completed Timeline to compare 
your balancing to the Balance nodes in this “solved” timeline. Note that normalization, 
balancing, and contrast in some of the clips was separated into individual actions in the 
Node Editor. In the next lesson, you will also begin the practice of separating your grading 
stages into nodes.
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Lesson Review
1 Does a DaVinci Resolve archive (.dra) contain the original project media?

2 What does the Y in YRGB represent?

3 What does the pivot in the adjustment controls do?

4 How do you add additional control points to curves?

5 What is the difference between the Primaries color and log wheels?
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Answers
1 Yes. Archived projects (.dra) consolidate all related project media within a single folder 

that can be restored through the Project Manager.

2 The Y in YRGB refers to luminance.

3 The pivot control adjusts contrast balance.

4 Click directly on a curve to add a new control point. Shift-click to add a new control 
point without adjusting the curve’s position.

5 The Primaries color and log wheels target different tonal ranges of the image.
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Lesson 2

Creating Color 
Continuity

When editing footage for a video 
project, the end goal often is to create 
a single running narrative that appears 
to be happening in real time. Much 
of the time—even in documentary 
filmmaking—this unity of time is 
an illusion. Materials for a single 
scene can take days or even weeks 
to photograph, which can result in 
fluctuations in light, temperature, 
and color dominance as both 
environmental and technical factors 
influence the footage from one day 
to the next.

The goal of shot matching is to assess 
how multiple clips compare to one 
another when placed into a timeline 
and to ensure that they create color 
continuity. When shots don’t match, 
the audience becomes aware of their 
artificial sequencing, which breaks the 
illusion of cinema and compromises 
the viewer’s suspension of disbelief.
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In the previous lesson, you looked at the most common tools and workflows for 
normalizing and balancing shots in preparation for a grade. In this lesson, you’ll examine 
the shot-matching process using many of the same tools.

Building a Shot-Matching Strategy
Your approach to shot matching will depend greatly upon the nature of the footage.

On a narrative production that was shot by an experienced cinematographer and camera 
crew, the quality of the raw content can have a reliable consistency throughout and require 
minimal normalization and matching.

For documentaries, fluctuation in locations, light sources, and temperatures (not to 
mention the use of multiple, different cameras) may require much more dedicated 
footage preparation.

It is normal to incorporate both balancing and shot matching during the first primary 
grade pass. You may opt to treat these as separate jobs and apply them to independent 
nodes, or you can forgo balancing on shots that you are matching to a single “key” shot 
in a scene.

Your shot-matching strategy can be narrowed down to the following approaches and 
considerations:

 — Balance all shots in a sequence. This workflow assumes a shot-by-shot approach to 
normalizing the luminance range and balancing every shot in the sequence, which will 
result in a uniform sequence of shots. This time-consuming method is best applied 
to projects with vastly mismatched media sources or lighting conditions (archival 
documentaries, festival promo videos, and so on).

Every clip balanced individually
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 — Adjust only mismatched shots in a sequence. If only one or two shots in a sequence 
have a contrasting color balance, it makes sense to adjust only those shots to create an 
even starting point for the scene grade. This approach is more common to standard 
grading practices.

Mismatched clips graded to match the rest of the sequence

 — Select a master reference shot. Sometimes you will have more than one clip that 
you could use as a reference for matching. In those cases, you may opt to use the 
reference shot that will have a less extreme impact on the color tone of the other clips.

Clips adjusted to a key shot that causes the least color distortion

Or you might consider settling on the clip that is closest in appearance to your 
intended grade. In doing so, any further creative grading you perform will aim to 
enhance the colors and not undo them.

Clips adjusted to a key shot that is closer to the final intended look

TIP When selecting a master reference shot, it’s best to select an establishing 
shot or any wide or long shot of the scene and match all other angles to it. A 
wide shot is likely to have the best overall representation of light sources and 
shadow tones, as well as include most of the physical elements in the scene, 
such as actors, costumes, set design, walls, and so on. In contrast, a close-up 
might contain less reliable data for balancing and share few elements with 
other shots.
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The exercises in the following lessons will focus on the practical implementation of shot 
matching based on these methods. Understanding the variety of matching methods 
available in DaVinci Resolve 18 will enable you to construct grading workflows that are 
best suited to your coloring abilities and project type.

Organizing Shots Using 
Flags and Filters
In the previous lesson, you clicked individual clips throughout the timeline. However, 
DaVinci Resolve provides helpful organizational tools, called flags, that can assist you in 
identifying and categorizing clips based on any criteria that you define. For example, you 
might flag clips that have overexposed skies, clips that require green-screen keying, or 
clips that need narrative-specific dynamic grades.

1 In the timeline menu above the viewer, open the 02 Balanced Timeline.

The timelines in this project already include some flags. You’ll add a few more to 
identify the clips you will use for the matching exercises in this lesson.

2 In the timeline, right-click clip 04, and select Flags > Green.

A green flag appears in the upper-left corner of the clip thumbnail to indicate that the 
clip is flagged.

Another method for applying flags is to use a keyboard shortcut.
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3 Select clip 05. Press G on your keyboard to add another flag.

While this is a faster technique for applying flags, in this case it applied the wrong 
color flag.

4 To change the flag to green, double-click the blue flag on the thumbnail to open the 
Flags dialog.

Notice that the Flags dialog allows you to attach notes to flags, which is very handy for 
detailing future grading intentions or identifying technical issues.

5 Select the green-colored flag and click Done to close the dialog.

The keyboard shortcut is configured to apply the default blue flag. To change the 
default color, you’ll need to change the flag color in the toolbar of the edit page.

6 Go to the edit page. In the toolbar, next to the flag icon,  
click the disclosure arrow, and choose Yellow.

7 Return to the color page.

8 Select clip 04 and hold Command (macOS) or Ctrl (Windows) 
to select clip 06 at the same time.
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9 Press G to apply yellow flags to both clips.

TIP You can apply a flag to multiple clips by selecting a range of thumbnails 
and then using any of the methods described to apply the desired flag to the 
selected clips.

The green flags in the timeline now identify the clips you will be working on 
throughout this lesson. You’ll find it easier to locate and navigate between them if you 
filter the timeline to show only the green-flagged clips.

10 At the top of the color page, click the disclosure arrow next to the Clips button and 
choose Flagged Clips > Green.

TIP When a filter is applied to a timeline, the Clips button is underlined in red 
to serve as a visual reminder that some clips in the timeline might not be visible 
due to the filter.

You have temporarily hidden all clips that do not have a green flag. The result is a 
significantly simplified timeline that will help you focus on those clips without the need 
to navigate around your timeline and locate them.
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TIP Like flags, you can also use markers for filtering purposes. The difference 
is that flags identify an entire clip (or source media), whereas markers identify 
a specific frame or range of time. Adding a flag to a clip applies it to every 
appearance of the source clip in all the timelines of the project, whereas 
markers will only appear in that single instance of the clip in the timeline. 
Markers can be applied using a keyboard shortcut (M), and their default colors 
can be set in the toolbar of the edit page.

11 Once again, click the disclosure arrow next to the Clips button and choose Flagged 
Clips > Yellow.

As you likely noticed in the previous steps, clips can be assigned more than one flag 
color. As a result, media classifications can overlap, allowing you to filter clips that have 
several workflow roles.

12 In the Clips pop-up menu, choose Yellow again to remove the yellow flags from 
the clip filter.

In DaVinci Resolve, flags and filters can perform a wide variety of functions. You can 
use different flag colors to identify clips that must be reframed due to a visible boom 
microphone, single out clips that need white balancing, or isolate clips that require 
a flashback look. When the timeline is filtered based on flag color, you can focus on 
addressing just one category of clips at a time.

Applying Shot Match
The Shot Match function in DaVinci Resolve analyzes the colors in one image and 
reconfigures the balance of another image (or multiple images) to match it.

The results of any algorithmic grading function should be carefully evaluated after 
application because an algorithm is unable to recognize the environmental factors behind 
scene colors. Even so, the Shot Match function can be a great starting operation when 
matching clips and can enable you to quickly prepare shots for on-set review or when 
processing dailies.
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1 In the green flag-filtered timeline, select clip 01.

You will match the colors in this clip to the balanced clip 02 directly after it. In 
the interest of organization and preservation of the video signal integrity, you will keep 
normalization, balancing, and matching on separate nodes.

2 In the Node Editor, create a new serial node by right-clicking node 02 and choosing 
Add Node > Add Serial or pressing Option-S (macOS) or Alt-S (Windows). 

It is good practice to label your nodes to keep track of their function and 
your workflow.

3 Right-click the new node and choose Node Label. Name the node Shot Match.

4 Right-click clip 02 and choose “Shot Match to This Clip.” It will take a few moments 
for the shot match to be performed on the active clip in the timeline, which is 
currently clip 01.
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The result is a much better match between the two images. Clip 01 becomes warmer 
and less contrasted to match the environment in clip 02. However, the shadows could 
be darkened to better match the mountains and the details in the animals, and the 
gamma could be brightened and cooled to remove the strong red tones.

5 Drag the Lift master wheel left until the shadows of the waveforms in clips 01 and 02 
match more closely.

6 Drag the Gamma master wheel right to brighten the image and increase contrast in 
the details.

7 Drag the Gamma color wheel indicator away from red until the rhinos appear more 
neutral in color.

8 Switch the Primaries palette to Log Wheels mode and drag the Shadows master wheel 
left to restore the detail in the rhinos. Pay particular attention to the shadows in their 
ears, underbellies, and legs. 

9 Use the Low Range parameter in the adjustment controls to fine-tune the shadow 
selection, which should be focused on the darkest elements of the frame.

Before match

After match

Automatic shot matching can be helpful for creating a starting point for manual matching 
and to quickly resolve mixed camera issues in front of clients. But ultimately, you should 
still learn how to assess images using the video scopes and manually match them with 
the primary grading tools. This will give you greater confidence when working with 
media that automatic tools struggle with, such as scenes with unconventional lighting or 
environments with context-dependent visual cues.
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Matching Shots Using Stills
Stills have a variety of functions in DaVinci Resolve, as you will learn in lessons throughout 
this book. One of the most direct uses of stills is for visually comparing clips in the viewer.

By superimposing a still, or snapshot, of a previous clip onto a current clip, you can visually 
assess their differences and similarities in contrast, saturation, and color dominance.

In this exercise, you will use stills to manually match clips.

1 In the green flag-filtered timeline, select clip 05.

In the 02 Balanced Timeline, this clip already has its tonal range and balance set via the 
Primaries color wheels.

2 Right-click in the viewer and choose Grab Still.

3 Double-click under the still that appears in the gallery and label it Match Reference.

NOTE The numbers under the stills refer to the timeline track, the clip number, 
and the number of stills generated for that clip.
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4 In the timeline, select clip 06. You will use the Primaries color bars and the Parade 
scope to match this shot to the still.

5 In the Scopes pop-up menu, choose Parade. This representation of the image is 
similar to that of the waveform scope but with the luminance value of all three 
channels represented separately.

6 In the Gallery window, double-click the Match Reference still.

You should now see the two clips in the viewer, separated by a wipe line that 
you can drag.

TIP You can invert a wipe using the keyboard shortcuts Option-W (macOS) or 
Alt-W (Windows). Doing so will switch the frames for a reverse reference view.
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The shot of the man by the fence is much cooler than the still with the men and the 
horse. The Parade scope, which is also split in half, reveals this difference.

The reference still’s blue channel trace appears substantially lower, indicating an 
absence of blue in the highlights and upper midtones. As blue’s complementary color 
is yellow, this results in the reference image looking warmer.

When shot matching, the goal is not to fully match the parades to each other. That 
is usually impossible because of the different contents of the frames. Instead, you 
must study the relationships of the three channels and try to recreate their respective 
relationships in the clip that you’re matching.

7 In the node graph, change the label of node 01 in clip 06 to Match.

TIP Labeling nodes has many benefits. It clarifies the grading workflow by 
specifying each node’s task, which enables you to make faster adjustments as 
you grade. Labels are also great for inserting reminders for future necessary 
returns to the clip grade.

To label nodes more quickly, consider creating a custom keyboard shortcut. 
Open DaVinci Resolve > Keyboard Customization. Find the Label Selected Node 
command in the Commands list (use the search field at the top, if necessary), 
and press the keyboard shortcut you wish to associate with the command. The 
Tab key is a good option because it is not assigned to any default command.



49Matching Shots Using Stills

8 In the Primaries palette, switch the mode to Color Bars.

The bars are an alternative representation of the color wheels, and changes in either 
mode will reflect in both modes. The bars offer greater precision over the individual 
color channels of the image than the wheels.

9 To match the shadows, drag the Lift Y (luminance) bar down until the shadows of clip 
06 match the shadows in the still. Keep your eye on the green parade and aim to set 
the lowest point of clip 06’s trace (the man and dog) to a similar level as the shadow in 
clip 05 (the men and horse).

TIP Use the scroll wheel of your mouse to adjust the Primaries color bars with 
more precision.

The next step is to address the overall balance to match the reference.

10 Drag down the Blue Gain bar until the tops of the blue parades align.

11 Drag up the Red and Green Gain bars to match the warmer reference look.

12 To address the coolness in the shadows of the mountains, drag up the Red Lift bar.

Finally, you will tweak the Gamma bars to offset any remaining color inconsistencies 
between the two images.
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13 While keeping an eye on the middle pattern of the traces, slightly drag up the Red 
Gamma bar and lower the Blue Gamma bar.

The result is a quick matching of the two clips using the Primaries color bars.

14 To turn off the reference wipe view, in the upper left of the viewer click the Image Wipe 
button or right-click in the viewer and choose Show Reference Wipe.

15 Disable and enable the match grade to compare clip 06 before and after the manual 
matching adjustment.

Before match

After match
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With the clips matched, you can now apply creative grades to them and continue to 
see consistent results. 

16 Select clip 05.

17 In the Node Editor, locate the Contrast node and click the number 02 in the lower-left 
corner to enable it. The image in the viewer will shift to display deeper shadows and 
more detailed midtones.

18 Select the Contrast node and choose Edit > Copy or press Command-C (macOS) or 
Ctrl-C (Windows). 

19 Select clip 06.

20 Right-click the Match node and choose Add Node > Add Serial.

21 Select the newly created node and choose Edit > Paste or press Command-V (macOS) 
or Ctrl-V (Windows).

Clip 06 adopts the same level of contrast because of the successfully matched tonal 
ranges and colors in the first node.

NOTE The Y (luminance) bar of the Primaries color bars affects the image 
differently to the color master wheel. The master wheel affects all RGB 
channels, which impacts saturation, whereas the Y bar targets only luminance.

When using stills for shot matching, your grading becomes even more precise when used 
in conjunction with video scopes. This is because scopes display an objective measure of 
the color and luminance values of each frame, allowing you to make informed adjustments.

Stills have the additional benefit of containing the grading data of the clips they were 
generated from. In later lessons, you will use this data to apply grades across scenes, or as 
a starting point for grading other clips in the timeline.

Comparing and Matching 
Shots Manually
You don’t always need to generate a reference still in the gallery for wiped shot matching. 
In this exercise, you will extract a reference directly from the timeline and match the 
images using custom curves.
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1 In the green flag-filtered timeline, select clip 04. You will match this clip to the 
previously balanced clip 03.

2 Review the Parade scope for clip 04.

You can see distinct differences in the shapes of the three channels. The red channel 
has the widest spread, extending beyond the green and blue channels in both the 
shadows and highlights. The blue channel’s highest point is almost level with the green 
channel’s highest point, although it is far more compressed in the midtone range.

3 Select clip 03 and review its parade.

The most obvious difference is in the overall spread and contrast of the three color 
channels. The shadows extend to the bottom of the scopes graph, with the red and 
blue shadows even touching the black point line (0).

In this situation, visual evaluation of the frame is vital. By understanding the context of 
the image, you can choose to ignore certain properties of the graph. Clip 03 contains 
a variety of elements that are not visible in the close-up in clip 04. The trees and field 
silhouetted against the mountains are portrayed as bunching at the bottom of the 
parades. You can choose to omit such elements from the scopes when shot matching.

4 Select clip 04.

5 Right-click clip 03 and choose Wipe Timeline Clip.

Both clips become visible in the viewer at the same time, divided by a wipe line.
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TIP Quickly toggle the wipe on and off by pressing Command-W (macOS) or 
Ctrl-W (Windows). Some colorists set their reference to fill up the whole screen 
and toggle the wipe continuously as they match the grade in the active clip.

In the timeline, a blue highlight indicates that clip 03 is currently being used as a 
reference.

One way to help you focus on the relevant elements of the parade is to reframe the 
reference clip within the viewer. Clip 03 is a much wider shot than clip 04, so you can 
zoom in and reposition it for a better representation of the colors.

6 In the middle palettes, click the Sizing button to open the Sizing palette.
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7 In the palette’s upper-right corner, choose Reference Sizing mode.

The Reference Sizing tool applies the transform changes only to the reference image in 
the viewer, not to the actual clip in the timeline.

8 Use the Sizing controls to zoom in to the reference image (by a factor of about 9.000).

9 Pan the image to the left and tilt the image down until the framing starts to match that 
of clip 04.

These transform changes place the reference image into a much better position for 
both visual evaluation and for a more usable Parade scope trace.

The side-by-side parade comparison reveals that the reference image has some minor 
discrepancies, like the stronger presence of red in the upper midtones and a lower 
blue channel trace. 
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When matching, remember that it’s impossible to recreate the exact shape of the 
graphs themselves. Instead, you should focus on matching the height, depths, and the 
midtone distributions of the graphs.

10 In the Node Editor, label node 01 as Match.

11 Open the Curves palette. Let’s perform a few adjustments to see how curves affect 
the parades.

12 Isolate the R curve and drag the white point left and the black point right until the red 
channel in both parades has an equal spread.

13 Isolate the G curve and drag the black point to the right.

As you drag the green control point, the two other channel parades begin to 
shift, affecting the output of the entire image. This happens because, by default, 
DaVinci Resolve tries to keep the luminance of the image constant when you change 
individual RGB channels in the Curves and Primaries palettes. Because each channel 
contributes to the overall brightness of the image, changing the strength of one 
channel forces the other two channels to compensate for the shift in luminance. This 
behavior is usually advantageous when performing creative color grading because 
it allows you to focus on designing a look for your scene without offsetting the 
brightness or contrast.

However, when shot matching, this behavior can be obstructive. To manipulate each 
channel independently, you need to indicate to DaVinci Resolve that you do not wish to 
maintain a constant luminance.

14 Open the Primaries palette and set the mode to Color Wheels.

15 In the lower-right corner of the adjustment controls, drag Lum Mix down to 0.

TIP In the Project Settings, you can set Lum Mix to default to a value of 0 
on every clip. Click the gear icon in the lower-right corner of the workspace 
to open the Project Settings window and go to General Options > Color and 
choose Luminance Mixer Defaults to Zero.

16 With the channels behaving independently, you can attempt to match the curves once 
again. First, reset the Curves palette.
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TIP When using the master wheels, you adjust the luminance together with 
the RGB channels, which impacts the saturation of the image. To adjust only 
luminance without altering saturation, Option-drag (macOS) or Alt-drag 
(Windows) the master wheel or the indicator inside the color wheel.

17 Isolate the R curve again and drag the black and white points until the red channel in 
both parades has an equal spread.

18 Isolate the G curve again and reposition the white point to align the shadows in the 
green parade.

19 Isolate the B curve and reposition the white point to align the shadows in the 
blue parade.

It appears that the parades now equally match each other, but the colors in clip 04 still 
do not match the reference in the viewer. This is because you have focused only on the 
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highlights and shadows of the images. The midtones are equally important and can 
have a profound impact on image appearance.

Notice the bunching occurring in the lower midtones of the channels. It represents 
the mountains in the image. Though the red and blue channels are aligned, the green 
channel is mismatched between clips 04 and 05.

20 Add control points to the green curve and drag them until the midtones of the 
green channel line up more accurately. Adjust the green curve’s black and white 
points if necessary.

The match between the two parades results in a satisfactory visual similarity in the 
mountains and the sky. However, you can now continue to assess the match by eye 
and further refine the result.

The close-up shot could use some contrast to create greater depth between the 
mountain ranges in clip 04. This difference in contrast is represented by much 
finer discrepancies in the clips’ parades that are too minor to target with primary 
grading tools. 

21 In the adjustment controls, tweak the Contrast to complete the match between 
the clips.

22 Open the Sizing palette. In Reference Sizing mode, click the reset arrow to return the 
reference image to its original placement.

If you do not perform this reset, all future reference images, including wiped stills from 
the gallery, will have the same transform placement in the viewer.

23 Disable the image wipe.

24 Toggle between clips 03 and 04 to verify that the match is successful.

When matching clips using the scopes, aim to equalize the heights and depths of the 
pixel spread and then detect any apparent bunching or mismatching in the midtones 
to address any remaining color issues. By displaying an exact readout of the RGB 
values of each clip, scopes can help you remove the guesswork that might accompany 
the minute tweaking of midtone ranges and allow you to approach the image from a 
more empirical, yet creative mindset.
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Using Split-Screen Views to 
Compare Multiple Clips
An alternative method of visually comparing clips within the viewer is using a split-screen 
display. Instead of overlaying the still of a single image, you can display the media from 
multiple clips side by side. The media you use could be from other clips in the timeline, stills in 
the gallery, different versions of grades (Lesson 6), or other clips in the same group (Lesson 7).

This comparison method is especially effective when you already have a collection of 
clips that are similar in appearance, and you need a wider visual reference of a scene or 
environment.

1 In the green flag-filtered timeline, select clip 07. This clip is already normalized and 
balanced with custom curves.

2 Shift-click clip 10 to highlight clips 07 to 10.

3 Right-click in the viewer and choose Split Screen > Selected Clips to display all 
four clips. 

4 For better visibility, press Option-F (macOS) or Alt-F (Windows) to enlarge the viewer.
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5 In the viewer, click the upper-right image to select clip 08 on the timeline. The selection 
is indicated by a white outline in the viewer and an orange highlight in the timeline.

Changes made to the color page palettes will impact whichever clip is actively selected 
in the split-screen view. You can perform approximate grade matching by switching 
between clips in split-screen view, visually comparing them, and making quick 
adjustments in the primaries color wheels and curves.

Although reading the scopes and evaluating their data can be a straightforward 
process, you’ll need practice to acquire a level of finesse to accurately adjust the colors 
in the highlights, midtones, and shadows. Shot matching is a highly valued skillset that 
requires plenty of experience and patience, so keep at it!

Self-Guided Exercises
Complete the following exercises in the green flag-filtered 02 Balanced Timeline to test 
your understanding of the tools and workflows covered in this lesson.

Clips 08, 09, and 10—Match these clips to clip 07 using any of the methods covered in 
this lesson.

When you’ve completed these exercises, open the 04 Completed Timeline to compare your 
matching to the Match nodes in this “solved” timeline.

Lesson Review
1 How do you prevent changes made to one color channel from affecting the waveform 

trace of the other two channels?

2 How can you filter the timeline to show only clips with a flag?

3 When performing an automatic shot match, you might right-click the clip you have 
selected and not see “Shot Match to this Clip” in the contextual menu. Why?

4 True or false? It is possible to use a timeline clip as a reference in the viewer without 
first creating a still.

5 Which viewer mode allows you to see multiple clips in the viewer at the same time?
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Answers
1 In the Primaries palette, set Lum Mix to 0.

2 Click the disclosure arrow next to the Clips button and choose Flagged Clips.

3 The clip you have selected is the one that will be receiving the automatic shot match 
adjustment, so “Shot Match to this Clip” cannot be an option. Right-click any other clip 
on the timeline and “Shot Match to this Clip” will appear in the contextual menu.

4 True. To do so, right-click a clip in the timeline and choose “Wipe Timeline Clip.”

5 Split Screen mode allows you to see multiple clips in the viewer at once.



Time
This lesson takes approximately 
150 minutes to complete.

Goals
Controlling the Viewer’s Eye 62

Sharpening Key Elements 71

Tracking Obscured Objects 74

Fixing Overcast Skies 79

Warping Color Ranges 95

Enhancing Skin Tones with 
Face Refinement 105

Adjusting Skin Tones Manually 113

Self-Guided Exercises 122

Lesson Review 123

Lesson 3

Correcting 
and Enhancing 
Isolated Areas
After completing balancing and 
shot matching, you’ll want to target 
details in the shots for more specific 
enhancement. This is the secondary 
color-grading stage.

Secondary color grading is not a 
standardized phase of the color 
grading process. Instead, it is a needs-
driven component of the workflow 
that is utilized only when a shot 
requires it. It enables you to achieve 
a wide variety of goals that improve 
the overall aesthetic and creative 
quality of the footage, as well as to fix 
continuity errors.

In the first part of this lesson, 
you’ll review some of the common 
applications of secondary grading 
using qualifiers and windows. 
Your goal will be to isolate areas 
of the image for color and effect 
enhancement with the purpose of 
drawing the viewer’s eye.
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In the second part of this lesson, you will use more nuanced tools to clean up overcast 
(or overblown) skies, adjust regions of an image based on hue, and calibrate skin tones to 
produce smoother, more natural results for the subject. Throughout the lesson, you will 
also employ some of the tools available in the Effects panel to see how subtle adjustments 
can exert an enormous effect on the emotional impact of an image.

Controlling the Viewer’s Eye
A film’s musical score and sound effects can have a resounding impact on audience 
perception. Similarly, color and light play a critical role in manipulating the way an audience 
interprets a scene. In this lesson, you will focus on the fine art of shaping light to control 
the viewer’s eye.

Drawing Attention Using 
Windows and Saturation
A simple alteration can dynamically reimagine the composition and mood of a shot. In this 
exercise, you’ll enhance the saturation in the vibrant, sunlit area of a field to give a scene a 
more dramatic feel.

1 In the Project 01 - Disunity Documentary project, open 03 Matched Timeline.

2 In the Clips pop-up menu, choose All Clips to remove the green filter in the timeline.

3 Filter the timeline to show only those clips with yellow flags.

4 In the yellow flag-filtered timeline, select clip 07. The clip already has a first node 
labeled Normal.
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5 Create a second node and label it Sunlight.

6 In the central palettes toolbar, click the Window palette button. You’ll use a Power 
Window to specify the region of the image you will grade.

7 Click the Linear window button to activate it. It’s the square-shaped window at the top 
of the preset windows list.

When activated, the button will have an orange outline, and you will see the onscreen 
window controls in the viewer.

8 Double-click next to the window button thumbnail and enter the name Sunlight Area.

9 In the viewer, move the four edges of the window to select the entire horizontal middle 
of the image where the sun hits the ground. Make sure to extend the shape to mimic 
the path of the sunlight.

10 In the viewer, drag the red points of the window outline to increase the softness 
around its upper and lower edges.

11 To review your Power Window selection in the viewer, click the Highlight button in the 
upper-left corner of the viewer.
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The viewer shows the part of the image that will be affected when you begin grading 
in this node and turns the area outside of this selection gray.

12 Click the Highlight button again to disable highlight mode and return to your 
full frame.

With the secondary selection created, you can begin to grade the image.

13 In the Primaries palette, increase the Sat to 65 and the Contrast to 1.1.

TIP Toggle the onscreen window controls in the viewer by pressing Shift-~ 
(tilde) on your keyboard. You can use this keyboard shortcut to hide the outline 
and better see the impact of your grade on the image. 

14 With the Sunlight node still selected in the Node Editor, right-click it and choose Add 
Node > Add Outside or press Option-O (macOS) or Alt-O (Windows). This inverse 
selection will allow you to grade the environment around the sunlight.

15 Label node 03 as Outside.
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One of the greatest benefits of working with nodes is the live nature of their video 
and key signal connections. The Outside node is directly using the previous node’s key 
(selection) data, so if you were to make changes to the Sunlight Area window in the 
Sunlight node, it would immediately reflect on the key of the Outside node.

16 Drag the Gamma master wheel (-0.05) to decrease the brightness and reduce the 
Contrast (0.900).

Doing so creates a dark framing effect around the figure of the man and further draws 
the eye toward the sunlight on the field.

Before

After
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Mimicking a Shallow Depth of Field
The Tilt-Shift Blur in the Effects panel imitates the look of a shallow focus lens to direct 
audience attention. However, you can also apply it to achieve effects that a lens could 
not—such as reducing the focus of elements contained within the same focal field and 
choosing the blur type, amount, and angle. 

NOTE The following exercise requires DaVinci Resolve Studio to complete.

You will continue to work on clip 07 in the yellow flag-filtered timeline.

1 Create a new serial node (node 04) and label it Tilt Shift.

2 In the interface toolbar, click the Effects button.

3 In the Effects Library panel, under Resolve FX Stylize, locate the Tilt-Shift Blur effect.

4 Drag the Tilt-Shift Blur effect onto the empty Tilt Shift node.

The Effects Library switches to the Effects Settings panel in which you can tweak the 
Tilt-Shift Blur effect controls.

5 In the Settings panel, in the Depth of Field category, select Depth Map Preview to 
review the matte map.

You encountered a Depth Map previously in Lesson 1. As a reminder, the matte 
represents the area where an effect is applied. White indicates full opacity, black 
indicates complete transparency, and grayscale is the range of semi-opacity 
between the two values.

Currently, the map is level with the horizon and is successfully targeting the rhinos in 
the background. However, it is not an entirely realistic composite. The depth of field is 
too extreme at the top and bottom of the image, while maintaining focus on both the 
man in front of the camera and the rhinos hundreds of yards in front of him.
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TIP Repeatedly select and deselect Depth Map Preview to visually assess the 
position of the Tilt-Shift Blur matte in relation to the image when determining 
the placement of the Tilt-Shift effect.

6 Adjust the width of the matte by dragging the In-Focus Range pointer to the right 
(0.330) to include more of the man in the focused range of the shot.

7 Adjust the height of the matte by dragging the Center Y value down (0.460) to ensure 
that the area directly behind the rhinos softly begins to go out of focus.

8 Deselect Depth Map Preview.

9 Slightly decrease the Near Blur Range (0.630) and Far Blur Range (0.630) values to 
reduce the severity of the blur and produce a more realistic result.

Before

After
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Focusing Attention with Vignettes
In classic filmmaking, a vignette refers to the darkened edges of a film frame caused by 
the matte box casting a shadow on the camera lens. With the advancement of camera 
equipment, and especially with the advent of digital film, natural vignettes are no longer 
an issue. However, their absence has caused an appreciation for the framing service they 
provided, and vignettes are now sought after for both creative and compositing purposes 
as an effective method of directing the viewer’s eye.

In this simple exercise, you will apply a circle window to a shot and reduce the brightness 
of the area around it to create a vignette around the central subject. You will continue to 
work on clip 07 in the yellow flag-filtered timeline.

1 Create a new serial node (node 05) and label it Vignette.

2 In the Window palette, click the Circle window button.

Vignettes are usually elliptical, as it reduces their visibility and makes it easier to 
seamlessly blend them into the footage, as compared to shapes with straight lines 
and corners.

3 Double-click the layer name field next to the circle window, and type Vignette Frame.

4 Use the onscreen transform controls to reposition and rescale the circle to completely 
fill the viewer frame. 

5 In the onscreen controls, drag one of the red points to create a wide, soft edge around 
the selection.

In the Node Editor, the Vignette node thumbnail preview shows that you have selected 
the subjects in the center of the frame. To use the node as a vignette, you will need to 
invert this selection.

6 In the Window palette, on the right side of the circle window row, click the invert icon.
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7 In the onscreen controls pop-up menu in the lower left of the viewer, choose Off to 
hide the window outline.

8 Now that the vignette shape is made, you can proceed to use the grading tools to 
create a vignette effect on the image. Reduce the brightness of the selected area by 
dragging the Gamma master wheel to the left (-0.05). Using the gamma tonal range 
will ensure that you are not darkening overly bright areas of the footage, such as the 
overcast sky, which would make the vignette too obvious.

TIP Vignettes are most effective when they are not noticeable. If you’re 
concerned that your vignette may be too prominent, review the thumbnail of 
the clip in the timeline to determine whether the vignette is too pronounced in 
the corners. If so, raise the Gamma back up to reduce its strength and further 
soften the Power Window’s edges to blend it more seamlessly into the image.

You can also save the vignette you just generated for future use as a preset.

9 In the Window palette, ensure the appropriate window (Vignette Frame) is selected in 
the window list.

10 In the upper-right corner of the palette, click the Options button and choose Save as 
New Preset.

11 Enter the preset name as Vignette.

From now on, when you want to apply this exact shape to a node in any other clip, you 
need only access the Window palette option menu and choose the preset Vignette.

This basic adjustment allowed you to reduce the brightness on the edges of the image 
to focus attention on the subjects in its center. The softness of the vignette is crucial to 
ensure that the adjustment does not draw undue attention to itself.

TIP A Vignette Effect is also available in the Effects Library (in the Resolve FX 
Stylize category) for quick application of a simple, customizable vignette.

It takes careful consideration and assembly of secondary grading to draw the eye of the 
audience without calling attention to the image manipulation. When an audience becomes 
aware of the colorist’s handiwork, it can break the illusion of realism and compromise 
viewer involvement with the content.
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Using the Mini Panel—Power Windows
Using a DaVinci Resolve Mini Panel offers a great deal of time-saving potential 
when you’re working with windows. To make a Power Window on the Mini Panel, 
you can use a few methods. When you’d like to apply a window to a node, press 
the Windows button in the upper left of the panel. The 5-inch screens will display a 
row of Power Window presets along the top. 

Select the desired preset and then press Window On to active it in the node. 

Then use the knobs under the screens to simultaneously adjust the size, pan, tilt, 
aspect ratio, softness, and opacity of your window. With practice, you’ll find that using 
the Mini Panel is a faster method of calibrating Power Windows than using a mouse.

It’s important to note that Power Windows also extend to the node controls on the 
Mini Panel. At the upper right of the panel, node controls allow you to create several 
types of common nodes. You’ll learn more about them throughout this book. 

For now, pay attention to the Node + buttons with which you can create a new 
serial node with a window already activated, thereby turning two commonly used 
shortcuts into one. Pressing the Node + Circle button, for example, creates a new 
node with a circular Power Window.
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Sharpening Key Elements
The Blur palette in the central palettes of the color page contains a Sharpening mode. 
It works best when used conservatively and when applied at the end of a grading 
pipeline. Too much artificial sharpening can stand out for the wrong reasons. When used 
precisely, sharpening can make details look more dynamic and draw the viewer’s eye to a 
desired object.

1 In the yellow flag-filtered timeline, select clip 06.

The clip begins with a man’s hand obscuring the shot. In such cases, it’s a good idea to 
play through the clip until you find a better point for grading and adding effects.

2 In the viewer jog bar, drag the playhead to the center of the clip.
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3 Create a second node and label it Sharp.

4 In the central palettes, open the Blur palette.

5 In the upper-right corner of the palette, press the second icon to activate the 
Sharpen mode.

The main control in the Sharpen palette is the Radius. Dragging it upward will blur the 
image, while dragging it down will sharpen the edges of any high-contrast detail.

6 Reduce the Radius to 0.40 by dragging down any of the three channel sliders. The 
RGB channels are ganged together by default, so adjusting one will equally alter the 
other two.

Although it’s easy to see that the engravings become more detailed with this 
adjustment, the impact that sharpening has on the rest of the image is more difficult 
to determine by eye.

7 Above the viewer, click the Highlight button, and then click the A/B Difference button in 
the upper-right corner.

A/B Difference shows you the change that has occurred in an image within an active 
node. If color grading, A/B will display the areas of the image that have changed hue 
and tone. If there have been pixel-based changes, like sharpening, A/B will display the 
object edges affected by the adjustment.

8 In the Sharpen palette, increase the Scaling to 0.5. Doing so will multiply the result of 
the Radius adjustment.

The adjustments add a satisfactory level of detail to the engraving but add too much 
detail to the gun barrel and the smoke coming out of it. You can limit the sharpening 
effect using the Coring Softness and Level controls at the bottom of the palette. Start 
by increasing the Level control to set a threshold for the sharpening.
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9 Increase the Level (around 10–15) until the detail in the smoke and on the barrel of the 
gun disappears.

10 Increase the Coring Softness to around 5 to recover some of the sharpening between 
the Level threshold setting and the most detailed areas.

To see the results on the image, you can disable the difference highlight.

11 Click the Highlight button above the viewer or press Command-Shift-H (macOS) or Ctrl-
Shift-H (Windows).

12 Toggle Command-D (macOS) or Ctrl-D (Windows) to bypass the Sharp node and 
compare your results to the original image.

TIP You could also achieve this effect using Sharpen Edges from the Effects 
Library panel. This filter includes an edge display in the Settings controls, 
among other sharpness fine-tuning parameters.

Although the sharpness looks very nice on the engravings, it’s causing some ringing on 
the left hand at the end of the clip, as well producing some pixel artifacting on the shotgun 
shell at the start. You can use a window to limit an effect to a specific area in the shot.
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Tracking Obscured Objects
Adding a simple circular window to the Sharp node will allow you to confine the sharpening 
to the decorative engravings on the shotgun handle.

1 In the Sharp node of clip 04, create a circle window, and name it Handle Detail.

2 Make the circle smaller and narrower, and rotate it so it confines the sharpening effect 
to just the engravings on the handle.

3 Drag the red control point on the window to soften the edges of the mask. 

The sharpening is now successfully isolated to the detail on the handle. However, 
scrubbing through the clip will reveal that this is a handheld camera shot, and the 
shotgun is moved as it is loaded. You’ll need to track the window for the effect to follow 
the engravings.

4 In the central palettes toolbar, click the Tracker button next to the Window button.

5 With the playhead still located in the center of the shot, and your circle window placed 
on the detail just under the barrel, click the Track Forward and Reverse button. This 
action will trigger an analysis of motion within the clip, resulting in the window moving 
together with the shotgun.
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As the analysis runs forward, the window disconnects from the shotgun detail due to 
the interference from the man’s hand. This occasionally occurs when performing a 
difficult or obscured track, and it is useful to know how to fix the issue. 

After the forward analysis, the playhead automatically jumps back to the starting 
frame and runs a backward analysis too. This analysis features no obstacles and 
successfully produces a clean track.

TIP It is common practice to track from the center or the end of a clip when 
doing so will provide more reliable tracking data.

6 In the upper-right corner of the tracker graph, click the right Keyframe navigation 
arrow to return the playhead to the central keyframe.

In the Tracker palette, you can see a visual representation of the amount of motion 
detected in each transformation parameter. Each colored line corresponds to the 
colored parameter label above the Tracker palette. Based on the sudden and dramatic 
movement on the pan and tilt graph lines in the second half of the graph, the tracking 
data has become distorted. To fix the track, you must first remove the unusable 
“bad” track data.
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7 Drag within the tracker graph to draw a dotted selection outline around the bad 
track data.

8 In the Tracker palette, in the options menu, choose Clear Selected Track Data.

The track data in the selected area of the tracker graph is removed. Knowing that 
the track cannot be analyzed with the obstruction, you’ll need to manually adjust the 
movement of the window during the time that the hand is in the shot.

9 Switch the Tracker to Frame mode.

In Frame mode, any changes you make to the window in the viewer will be recorded 
as a keyframe, as opposed to the Clip mode, which applies a uniform change to the 
window’s position in relation to the whole clip.

10 In the viewer, drag the playhead to a point in time where the obstruction has passed, 
and the area appears to be trackable again.
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11 Manually reposition the window to the area of the handle that you were previously 
tracking. Use the anchor point in the center of the window as a visual guide, if 
necessary.

A new keyframe appears in the tracker graph, and tracking data is automatically 
generated between it and the last tracked moment.

12 Click the Track Forward button to perform the rest of the track analysis.

Using the Mini Panel—Tracking
You can use the Mini Panel to track Power Windows without using your mouse by 
pressing the Tracker button in the upper-left of the panel.

By enabling Frame mode, you can also keyframe and manually animate windows. 
Pressing the Left Arrow and Right Arrow keys will display more advanced keyframe 
controls in the viewers.
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Due to the unsteady motion of the shotgun, you may choose to make further 
corrections to the manual window track to produce a smoother result.

13 Drag the playhead to the last frame where the handle is visible before the hand passes 
in front of it.

14 With the Tracker palette still in Frame mode, drag the window to the correct position.

15 Play through the clip a few times to review the motion of the window track and make 
necessary adjustments until you are satisfied with the result.

What About His Hand?
You have completed this exercise, but the man’s hand continues to pass under 
the tracked window. Is it not affected by the sharpening adjustment? The short 
answer is yes; if you were to analyze the footage frame-by-frame, you would find 
that the pixels in his hand are affected by the secondary grade. However, due to 
the speed of the hand motion and the mildness of the window adjustment, the 
result is barely visible and can be left in place. 

If you had increased/decreased the gamma or applied a stronger visual effect, 
the result would have been obvious, in which case you would need to have 
made further manual adjustments to hide the secondary effect when the hand 
passes under it. One solution would be to change the opacity of the window from 
100.00 to 0.00 (in the Window palette), animating the change using keyframes 
in the Tracker palette the moment the hand obstructs the view, and then adding 
another two keyframes, bringing the opacity back up after the obstruction is gone. 
Another common solution would be to introduce and track a second window to 
mask out the obstruction, which you will learn how to do later in this lesson.
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Fixing Overcast Skies
Capturing footage with skylines in-camera can sometimes be problematic. Due to the wide 
dynamic range of light involved, subjects in the foreground usually require substantially 
different exposure levels compared to the sky. Opening the aperture or raising the ISO 
may be optimal for capturing the foreground but often results in a blown-out sky. On 
fictional film productions, this is remedied with a lower ISO and additional lighting on 
the talent or by using controlled skylines in a sound stage, but on small productions and 
documentary shoots, these are rarely options. Thus, the footage is usually captured with 
the sky blown out, and it is up to the colorist to correct the shot. 

There are several approaches to correcting or matching a sky. The fastest is to apply a 
gradient window and blend color into the top of the shot. A higher-precision approach 
involves first isolating the sky with a keying tool, such as the qualifier, and then tweaking 
the color values using the standard grading tools.

1 In the yellow flag-filtered timeline, select clip 01. This clip was previously balanced and 
matched and now needs secondary grading to address the overcast sky.

2 Create a fourth corrector node called Sky.

3 With the Sky node selected, in the central palettes, open the Qualifier palette.
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4 In the viewer, using the qualifier tool, click anywhere in the sky. The Sky node 
thumbnail will change to show the initial qualifier selection.

To refine the qualifier values, you must change the viewer mode to display only this 
selection.

5 Switch the viewer to Highlight mode in the upper left of the viewer. Ensure that the 
mode is set to Highlight in the upper-right corner.

When a selection is first made using the qualifier, it will often miss necessary sections 
or include unwanted areas. You can use the HSL Qualifier palette to fine-tune the 
selection by dragging the Hue, Saturation, and Luminance sliders to define exactly 
what those values should be.

6 Toggle the Highlight button to compare the original image with the selection. You will 
see that areas of sky between the branches of the trees need refinement.
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TIP It can occasionally be unclear where you should click with the qualifier 
tool to identify the optimal starting selection. The best strategy is to click and 
drag close to the area from which you are trying to extract the selection. In 
this case, the best area is on the horizon directly above the mountains. Once 
the selection has a clean edge, you can easily isolate the remainder of the area 
using windows.

A good starting point to refining the HSL selection is to disable each parameter one by 
one to determine whether its absence improves the qualifier quality.

7 Click the orange toggle next to Hue to disable it.

Doing so has a positive effect on the selection. The horizon becomes refined, and 
more areas of sky in the trees are included in the qualifier result. This makes sense 
because the blown-out white sky is mostly made up of luminance data, not hue. 

Toggling the Saturation and Luminance parameters reveals that they are vital to the 
selection, so you will leave them enabled. 

The next step is to adjust the values of the parameters to ensure the cleanest 
selection. You may want to zoom in on the horizon in the viewer to better see the 
result of these adjustments.

TIP Use your mouse scroll wheel to zoom in and out of the viewer and drag 
your middle mouse button to pan. To reset the viewer, press Shift-Z.

8 Drag the right side of the Saturation range, or drag the High field beneath the 
Saturation bar, to remove the qualifier selection from the mountain treetops, if 
there is any.

9 Drag the left side of the Luminance selection (Low) to further refine the selection. Aim 
to include the darker areas of sky between the trees.
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The focus is on ensuring the cleanest possible selection along the horizon, so, for now, 
you can ignore any other regions of the image that are also being selected, such as 
the horses.

10 In the upper right of the viewer, click the Highlight B/W button to switch to a black-
and-white representation of the matte.
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You will use the Matte Finesse controls in the Qualifier palette to fine-tune this matte. 
Unlike the HSL parameters, which targeted the original image’s pixel color and 
luminance data, Matte Finesse impacts only the values of the black-and-white matte.

Using the Mini Panel—Qualifiers
After making an initial qualifier selection, you can use the Mini Panel to refine it. 
When you press the Qualifier button in the upper-left section of the panel, the 
two 5-inch screens and their surrounding buttons and knobs become the controls 
you’ll use to continue making adjustments.

At first, you’ll see the controls for Hue on the left screen and Saturation on the 
right. In the upper-left section of the panel, press the Right Arrow button to 
navigate to the Luminance controls. In certain tools, you must use the Left Arrow 
and Right Arrow buttons to access all the functions that a specific tool offers.

One more push of the Right Arrow button will bring you to the Matte Finesse tools.
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11 The Pre-Filter parameter performs some minor clean-up of the original image, 
reducing compression artifacts like macropixels. Increase the pre-filter (1.0) to soften 
the edges of the trees.

12 The Clean Black and Clean White parameters eliminate noise by shrinking very small 
selection areas of the matte. Adjusting Clean Black will reduce some of the minor spill-
off in the trees under the horizon. A setting of 5.0 should be enough for a satisfactory 
reduction.

13 Likewise, tweaking Clean White (5.0) will amplify the white matte between the 
tree branches.

14 The Post-Filter cleans up the resulting key by reintroducing some of the finer detail 
from the original image back into the selection. Increase the Post-Filter (1.0) to see 
branch and leaf details return to the trees.

The clarity of the qualifier often depends on the nature and quality of the footage. 
In this case, you might experience some difficulty in getting a clean extraction from 
both mountain tops due to the difference in depth of field between them. When one 
mountain has a clean key, the other appears too soft and vice versa. In such cases, the 
best approach is to break up the keying process into several nodes and combine them 
using a key mixer.

NOTE You can see the results of using a key mixer to clean up the sky selection on 
this clip in the 04 Completed Timeline. Open the timeline, right-click the clip, and 
under Local Versions, choose Mixed Key to see the version of the node pipeline with 
the key mixer.

Using Windows to Limit Qualifiers
If the HSL qualifier has selected areas of the image that are not needed, you can quickly 
exclude them with windows. In this exercise, you’ll remove the horses from the selection so 
that your secondary grade will only impact the sky.

1 Open the Window palette.

2 Activate the Linear window button, and label it Sky Window.



85Fixing Overcast Skies

3 Drag its corners around the sky selection to exclude the lower regions of the matte.

The sky should now be successfully selected and ready for color adjustment.

4 Click the Highlight button to disable the matte preview.

5 Drag the Gain master wheel to the left (0.95) to reduce the brightness of the sky. 
By turning the white pixels gray, you will make them more receptive to hue and 
saturation changes.

6 Drag the Gain color wheel toward cyan/blue to introduce blue into the sky.
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Making luminance and color adjustments within a qualifier selection sometimes 
reveals issues that were hard to spot in the original matte. In the case of this image, 
the horizon might adopt a dark border, which indicates that the trees are being 
impacted by the grade.

7 In the Qualifier palette, increase the Clean Black (60.0) until the selection retracts from 
the treetops.

Finally, to soften the grade along the horizon, you can gently blur the edge between 
the black and white portions of the matte.

8 In the Matte Finesse Controls, increase the Blur Radius (5.0).

A gentler edge will ensure a more organic-looking grade and hide any remaining 
imperfections in the selection.

Adding Atmosphere
When you look into the distance through several miles of air, you see the atmosphere 
slowly build up over trees, buildings, and mountains until it forms a solid color in the sky. 
In an air-polluted city, the atmosphere may have a hazy white, brown, or orange look; on 
a clear day, you would see a soft blue. This concept is known as atmospheric perspective 
and can be observed in real life and on film. The farther away an object is, the more its 
saturation and contrast is reduced and the more it adopts the color of the atmosphere.

When enhancing a sky, or replacing it altogether, you need to blend an equivalent hue into 
the shot’s horizon to replicate this atmospheric perspective. Otherwise, the replacement 
sky might look fake against the horizon.

1 In the Node Editor, right-click the Sky node and choose Add Node > Add Outside or 
press Option-O (macOS) or Alt-O (Windows). This inverse selection will allow you to 
blend the color of the sky into the horizon of the image.

2 Label node 05 as Outside.

TIP In the Node Editor panel, drag your middle mouse button to pan and 
adjust the slider at the top of the panel to increase or decrease the size of 
the nodes.
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3 At the bottom of the Window palette’s preset list, activate the Gradient window button 
and label it Atmosphere.

An outline of the gradient controls appears in the viewer in the form of a line with a 
perpendicular arrow extending from it.

The gradient window works a bit differently compared to the other windows you have 
created. Instead of defining a shape, you position a starting point and drag the arrow 
in the direction of the gradient fall-off. The further you drag the arrow, the softer the 
gradient will be.

4 Adjust the top of the gradient (the horizontal line) to start at the top of the distant 
mountain and drag the arrow to taper off the gradient toward the bottom.

5 Drag the Offset color wheel in the direction of cyan blue to give the distant mountain a 
slight blue tint.

6 Press Command-D (macOS) or Ctrl-D (Windows) to compare the results before and 
after your atmosphere addition.

The gradient looks good in the distance but covers too much of the foreground 
mountain. You will want to create a new window to mask out anything you don’t 
want affected by the atmosphere grade.

7 In the Node Editor, disable the Outside node by clicking its number (5) or by pressing 
Command-D (macOS) or Ctrl-D (Windows). Doing so will allow you to continue work 
without being distracted by the blue grade.

8 While still in the Window palette, activate the Curve button and label it Foreground.
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9 In the viewer, click around the foreground hill and the lower half of the frame to create 
a custom shape. To close the loop and define the shape, click the first point that 
you created.

TIP When creating custom windows, click to create linear points and drag to 
create rounded Bézier curves. To delete a point, select it and press the Delete 
or Backspace key, or middle-click the point with your mouse.

10 Enable the Outside node to see the result.

The atmosphere grade now affects both the background mountain and the entirety of 
the custom shape. This is because, by default, all windows are additive. You will need to 
indicate that you wish to subtract the selection from the final result.

11 In the Curve window row, next to the label, click the Mask button to extract this custom 
shape from the final key of the node.



89Fixing Overcast Skies

12 To the right of the Window palette, adjust the Softness parameters to feather the edge 
of the curve. Drag the Inside and Outside fields to make the border of the Foreground 
window less aggressive between the two mountains.

Performing Sky Replacement
More advanced approaches to fixing an overcast sky involve replacing the sky altogether, 
usually with a still photo, video, or computer-generated image. The Sky Replacement effect 
allows you to quickly perform such advanced composting and even track the sky to a 
moving shot while integrating it to the camera’s lens properties.

In this exercise, you’ll use the sky key and atmospheric perspective that you generated 
earlier the lesson to integrate a new artificial sky into the shot.

NOTE This exercise requires DaVinci Resolve Studio to complete.

1 Open the Effects Library.

2 Click the magnifying glass at the top of the panel to reveal the search bar.

3 Type sky to filter the library contents.
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4 Drag the Sky Replacement effect onto an empty space in the Node Editor, near the Sky 
and Outside nodes.

TIP Click the magnifying glass in the Effects panel to remove the effect filter.

5 Connect the Sky node’s RGB output to the Sky Replacement’s top RGB input. This will 
be the video signal used as a backplate for the sky replacement composite.

6 Connect the Sky node’s key output to the Sky Replacement’s top key input. This will 
feed the sky key data to the Sky Replacement node and determine the area of the 
image where sky replacement occurs.

7 Finally, connect the RGB output of the Sky Replacement node to the RGB input of the 
Outside node. This will incorporate the Sky Replacement effect into the clip pipeline.

Note that the key connection between the Sky and Outside node remains. This ensures 
that the Outside node is still providing the atmospheric grade to the mountaintop.

8 Select the Sky Replacement node to open its settings in the Effects panel.
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The settings are divided into categories that support a variety of sky replacement 
workflows. Click a category header to expand or contract its list of parameters.

Sky Mask Adjustments allow you to preview and adjust your incoming key mask.

9 Click Preview Mask to review the Sky node key.

By default, the incoming matte is contracted slightly to create a more refined edge. 
As you had taken care to extract the overcast sky precisely with the qualifier palette, 
you will want to increase the Shift Edge and Refine parameters to get back this original 
edge data. However, this is best left to a later stage of the composite, when you can 
better observe the result of the adjustments.

10 Click Preview Mask again to disable the matte preview mode.

Source Sky Appearance features the parameters you’ll need when working with 
external sky images or videos. 

To introduce a sky image or video into the clip composite, drag the media from the 
color page media pool into the Node Editor. The media will appear as an external 
matte with four key outputs and one RGB output. Connect the RGB output of the Ext. 
Matte node into the second RGB input of the Sky Replacement node to see the sky 
media in the keyed area of the clip. You can even opt to use the second key input to 
isolate a portion of the incoming image or video. 

11 Since you will not use any external media for this composite, leave the parameters in 
the Source Sky Appearance category as they are.

Artificial Sky allows you to generate your own sky using a variety of color and 
gradient parameters, as well as controls for cloud and sun detail. 
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12 Click Preview Artificial Sky and increase Sky Opacity to 1.000 to see the default sky 
gradient in the viewer.

13 Deselect Preview Artificial Sky to review how the gradient appears when masked.

14 Change the Sky Color to more closely match the saturation levels in clip 04.

TIP Disable the Sky Replacement node and use the color-picker tool to sample 
the blue color you had introduced in the original Sky node.
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When working with larger sky areas, or designing more intricate sky hues, adjust the 
Horizon parameters to determine the softness, height, and angle of the sky gradient.

Next, you will introduce some cloud detail to make the sky more dynamic.

15 Increase Cloud Opacity to 1.000.

16 Reduce the Cloud Scale to 0.300 to place the clouds at a greater distance.

17 Adjust the Cloud Time (0.800) to change the distribution of the clouds.

The Hotspot parameters help imitate the look of a sun in the sky. This element can 
be necessary when matching the lighting and shadows in certain shots. Since the 
foreground in this environment does not have direct sunlight, it will not be necessary 
to active it.

18 Leave the Hotspot Brightness on 0.0000.

19 Return to the Sky Mask Adjustments and drag up the Shift Edge (0.200) and Refine 
(0.200) to reintroduce detail across the edge of the matte.

Sky Position controls allow you to track the sky to the environment using a variety of 
tracking techniques and to adjust the sky’s final position and size. Auto-Size for Motion 
ensures that the entirety of the incoming matte is filled with the sky image.

20 Since there is a slight camera wobble in this locked-off shot, click Track Foreground to 
analyze the footage outside the input key. This will result in the artificial sky moving 
together with the rest of the shot.

21 Sky Integration is used for final sky preview and to adjust the composite based on 
the camera’s lens properties. Because there is no obvious lens distortion or change in 
focal distance, these settings can be left as they are.
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22 Foreground appearance allows you to adjust the foreground of the image based 
on the inverse of the sky key. Your goal in this exercise is to create a sky that matches 
the environment, not the other way around, so you can leave these parameters 
as they are.

23 If your artificial sky has strong hues, you can use the Global Blend parameter to fade it 
into the original environment, producing a more natural result.

Before

After
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TIP As well as a method of correcting blown-out or overcast skies, Sky 
Replacement can help you match the sky color and detail between shots captured 
on different cameras or at different times of the day.

To shoot fast and travel light, documentary filmmakers might sometimes need to 
compromise on best technical practices and visual quality. Good lighting and consistent 
exposure are often victims of this practice. Secondary grading techniques and effects 
are an invaluable part of the post-production process that allow us to produce the best 
image possible.

Warping Color Ranges
The Color Warper allows you to adjust two parameters at once, producing quick results in 
an interface that encourages intuitive grading. It features two grids for changing either 
Hue and Saturation, or Chroma and Luma. Its mesh interface produces a smooth transition 
between hues, which reduces image artifacts. The Color Warper is helpful for enhancing 
the appearance of objects or areas with a distinct hue and can be combined with other 
secondary selection methods for optimal results.

Warping Colors in the Viewer
The simplest way to interact with the Color Warper is through the color page viewer. This 
method works best on areas with well-defined color ranges, such as for vehicles, clothing, 
or the sky. In this exercise, you will adjust the color of the dry grass on the ground to give it 
a healthier, greener appearance.

1 In the yellow flag-filtered timeline, ensure that clip 01 is selected.

2 Create a new serial node at the end of the pipeline and label it Grass (node 06).

3 In the central palettes, open the Color Warper palette.

The Color Warper features a Hue-Saturation “spider web” mesh grid that you can 
adjust to warp the colors of the image. A vectorscope trace, representing the hues of 
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the image and their saturation levels, is projected behind the radial grid to guide your 
selection.

The right side of the palette features advanced selection and pinning tools, which are 
used to achieve optimal precision when warping.

4 Click the Expand button in the upper-right corner to turn the palette into a 
floating window. 

Drag the corners and edges to resize the window to your liking and drag the palette 
header to reposition it. The larger interface will make it easier to make precise 
adjustments in the grid. 

5 Hover your mouse over the image in the viewer.

An orange crosshair appears in the Color Warper grid, corresponding to the hue over 
which your mouse is placed. Additionally, a yellow box appears on the nearest grid 
control point, indicating that it is the optimal point for adjusting that hue.
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The Color Warper features the same hue layout as the color wheels and offers the 
same saturation control. Moving a point closer to the center will desaturate a hue, 
while moving a point outward will increase color intensity. Moving a point in a circular 
fashion will change the color of the selected hue.

6 While still in the viewer, click on an area of grass in the foreground of the scene and 
drag to the top and left (orange hue).

The result shows that a single point selection does not adequately capture the variety 
of hues found in the grass, nor does it omit undesired areas, like the rhinos. The Color 
Warper’s true strength is found in the variety of selection methods that allow you to 
achieve a clean grade on a range of hues and saturation levels.

7 Reset the Color Warper by clicking the reset arrow in the upper-right corner of 
the palette.
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8 Hover your mouse over the foreground of the image and review how the crosshairs 
behave in the Color Warper’s radial grid.

You will see that the yellow box jumps between multiple hue columns and saturation 
rings. This suggests that the grass features a wider range of hues and saturation 
values than can be captured with a single click in the viewer.

9 In the lower-left corner of the Color Warper palette, click the Hue resolution dropdown 
menu and set the resolution to 16.

The Color Warper grid now features 16 hue divisions, allowing for much more precise 
hue selection. By default, the hue and saturation resolutions are linked, although this 
behavior can be disabled by clicking the link icon next to the dropdown menus.
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10 Hover your mouse in the viewer to review the range of grass hues. 

They are mostly focused on control points in the three leftmost columns of the grid.

11 Hover your mouse over the rhinos in the image. 

They are mostly represented by control points in the orange-leaning columns.

With this successful identification of target hues, you can now focus on grabbing a 
broad range of greens.

12 In the Color Warper grid, click and drag to select a range of green hue control points 
near the outer edge of the vectorscope trace.

TIP You can also hold Command (macOS) or Ctrl (Windows) to make multiple 
point selections when clicking or dragging. Right-click a control point to reset 
its position in the grid.

13 Click any of the orange selected points and drag the entire selection toward a more 
vibrant hue.
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Observe the surrounding environment in the scene to ensure that you reach a realistic 
shade of green. Drag the selected control points toward and away from the center of 
the grid until you find a satisfactory saturation level. 

Finally, you can use additional secondary tools to isolate your grade to one area of 
the frame.

14 In the Window palette, create a linear window and label it Grass Matte.

15 Drag the corners of the window around the grassy field in the foreground of 
the image.

The adjustment is isolated to the grass, while keeping other elements, like the dirt on 
the ground, unaffected.
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The Color Warper allows for an intuitive method of controlling color, hue, and saturation 
directly within the viewer. As you likely noticed, the adjustment is optimal when the hue is 
kept close to the source color. If pushed too far, the grid mesh can begin to overlap itself, 
which can cause artifacts. In such cases, consider adjusting your selection method or 
using an alternative hue correction method like HSL curves or the qualifier.

Enhancing Colors Based on Luminance
The Color Warper’s Chroma-Luma grid allows you to simultaneously adjust the luminance 
and hue of a selected range. This opens up some creative and practical applications when 
working with bright areas, like skies, lights, and windows.

1 In the yellow flag-filtered timeline, select clip 03.

2 Create a new serial node called Sky (node 04).

3 In the upper-right corner of the Color Warper, press the Chroma-Luma button.

The Chroma-Luma panel features many of the same controls as Hue-Saturation, 
though the control point interface is now a pair of grids depicting two cross sections 
of a 3D chroma-luma cube. A trace is projected behind the grids, representing the 
distribution of the chroma and luma data of the current frame in the viewer from 
two perspectives.

The horizontal axis of the grid represents hues, while the vertical axis represents 
luminance. You will use these grids to enhance the vibrant colors of the sky.



102 Lesson 3 Correcting and Enhancing Isolated Areas

4 In the viewer, click on a light area of the sky and drag down.

In color grading, changing luminance based on a hue can often lead to 
distortion. Therefore, it is important to keep Chroma-Luma selections exact and 
adjustments subtle.

5 Reset the Color Warper.

6 To improve selection precision, change the Chroma and Luma resolutions to 12.

You will next lock off the darker regions of the image to protect them from 
adjustments made to the sky.

7 In the viewer, hover over the hill in the foreground and mountains in the background. 
The orange crosshair will indicate that the luminance range of those regions lies in the 
bottom two rows.

TIP You can check which region of an image will be affected by a control point 
in the Color Warper by holding Option (macOS) or Alt (Windows) while clicking 
the control point. A highlight of the selection will appear in the viewer.

8 Select any point on the row directly above the bottom of the grid.
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9 In the Tools sidebar, click the Select Row button to expand the selection to the 
entire row.

10 Click the Convert Selected to Pin button to lock all the control points on that row.

Pinned points are indicated by a black outline. Adjustments made near a pinned point 
will not affect it, and the surrounding grid mesh will warp around it.

11 Repeat steps 8–10 in Grid 2 (the grid on the right) to protect the shadows in those 
chroma regions too.

12 At the bottom of the palette, drag the Axis Angle parameter (20.00) to determine the 
hues you will be introducing to the sky. The aim is to reach a more yellow tone in the 
left grid, and a more magenta tone in the right grid.

As you do this, the waveform trace in the grid will rotate, revealing its 3D nature.

13 At the top of the Tools sidebar, select Grid 2.

14 In the viewer, click on the region between the orange and blue gradients in the sky and 
drag to the right and slightly upward to push a vibrant pink hue into the sky.

15 At the top of the Tools sidebar, switch to Grid 1.
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16 In the viewer, click the orange region right above the mountains and drag left and 
upward to brighten the sky and give the sunrise a warmer, more pronounced glow.

Continue to make finer adjustments to the control points in the grids to smooth out 
any artifacting.

Before After

TIP If you start to see banding in the sky as a result of dragging a control point 
too far, select the point and click the Smooth buttons under the Chroma and 
Luma parameters in the sidebar.

This will nudge the point toward its original position, softening the grade 
and reducing artifacts. The Smooth buttons can be clicked as many times as 
needed for incrementally smaller nudges.

17 When finished, copy the Sky node and paste it in a new node in clip 04.

18 Tweak the Color Warper in clip 04’s Sky node to achieve a better match for the close-up 
of the horizon.

Before After
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As you continue to work with the Color Warper, explore the remaining selection and 
pinning tools in the sidebar to gain a fuller understanding of how selections can be made 
faster and with more precision. Review the completed grade on these clips in the 04 
Completed Timeline to see how the luminance warp in this lesson was achieved.

Enhancing Skin Tones 
with Face Refinement
A common secondary grading task is refining skin tones. Whether a fictional narrative or 
a documentary, the audience will pay the utmost attention to the actions (and therefore 
the faces) of the people on the screen. Colorists and makeup artists share a common job 
in this instance, which is to “protect the talent.” This means we need to do our best to make 
skin look clear and natural. In DaVinci Resolve, this is achieved through a combination of 
Resolve effects and standard secondary grading methods.

NOTE This exercise requires DaVinci Resolve Studio to complete.

In this exercise, you’ll start with a well-framed and properly exposed shot. The only issue 
is that the speaker is wearing a wide-brimmed hat on a sunny day, resulting in harsh 
shadows on her face. Your goal is to make her face stand out more and then address 
general imperfections using the Face Refinement effect.

1 In the yellow flag-filtered timeline, select clip 02. In the Node Editor, you can see that it 
has already been balanced on the first node.

2 Create a new serial node, and label it Face.

3 Open the Effects panel.
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4 In the Resolve FX Refine category, drag the Face Refinement effect onto the Face node.

NOTE If you are not using DaVinci Resolve Studio, a watermark will appear over 
the image. You can dismiss the warning dialog and complete this exercise with 
the watermark.

When activated, Face Refinement automatically detects and tracks a moving face, 
giving you the option to enhance the skin and adjust individual features such as the 
eyes, lips, cheeks, chin, and forehead.

5 In the Face Refinement settings, click Analyze. Processing will take some time as the 
software identifies the face and constructs a travelling matte.
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When the analysis is complete, you will see a series of green trackers outlining the 
woman’s facial features.

To ensure the highest quality of the selection, you should check the matte of the face 
before proceeding with any adjustments. The matte quality can be compromised when 
analyzing a subject whose skin tones closely match their hair, clothes, or surroundings. 
In this example, the subject fits all three of these criteria.

6 Within the Face Refinement settings, click the Skin Mask header to expand it, and then 
select Show Mask.

7 Deselect Show Overlay at the top of the settings to remove the green trackers from 
the viewer.

8 Zoom inside the viewer to get a clearer view of the subject’s face.

The selection is clean overall. The only exception is the upper segment of the mask, which 
includes part of the tan hat that the woman is wearing.
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Combining Windows with Face Refinement
To remove the unnecessary hat selection from Face Refinement, you will use a window to 
exclude the top of the matte.

1 Move the playhead to the last frame of the clip.

2 With the Face node still selected, open the Window palette.

3 Create a new circle window and place it over the woman’s face.

4 In the upper-right options menu of the Window palette, choose Convert to Bezier to 
transform the circle’s points into Bézier curves. 

5 Label the resulting curve window Face Window.

6 In the viewer, adjust the points to fit around her face, paying extra attention to 
excluding the hat.

7 In the Face Refinement settings, deselect Show Mask.

8 Enter the Tracker palette.
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9 Click the Track Reverse button to track the motion of her face backward 
through the clip.

10 When tracking is completed, refine the shape of the Face window, if necessary. 

11 Use the viewer’s onscreen controls menu in the lower-left corner to turn off the 
window outline. 

TIP You can apply effects to an existing corrector node or drag them onto a 
connection line to create a Resolve FX node. Resolve FX nodes work slightly 
differently from standard corrector nodes in that you cannot use grading tools, 
windows, or qualifiers on them. They perform only the effect for which they 
were designed, and often feature additional RGB and key inputs to support 
their unique functionality.

Improving Skin Quality
There are a variety of reasons why skin tones might need adjustment:

General skin imperfections, such as variations of color, spots, dryness, oiliness,  
and so on—By applying the appropriate brightness, contrast, and blurring, you can 
reduce these issues and put the focus back on the performance.

Some skin undertones are prone to reflecting light with unpredictable tints—The 
most common variants are skin tones that appear magenta or green under harsh artificial 
lighting, like fluorescent office lights. The purpose of grading in this case is to remove the 
tint and bring the performer’s skin tone to a neutral position that more closely resembles 
their skin under natural light.

Overpowering primary grade—When a shot has been strongly graded at the primary 
stage to look a certain way (for example, to make the environment look cold), the skin can 
end up looking overpowered or washed out, as a result. These kinds of flat grades can 
drain the life out of a shot and make it look dull. By bringing back the skin tone, the shot 
develops chromatic contrast and once again becomes vibrant.

In this exercise, you’ll look at some of the commonly used settings of the Face 
Refinement tool with a focus on reducing minor imperfections and achieving a 
natural result.

1 In the Workspace menu, choose Full Screen Viewer or press Shift-F to expand the 
viewer to fill your screen while still granting you to access the Effects panel to the right.
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2 In the Face Refinement Settings, under Texture, adjust the Amount to 0.200. Doing so 
will gently blur the skin to soften minor wrinkles and imperfections.

Be careful not to push this setting so far that skin starts to look plastic. You should not 
aim to remove wrinkles but merely soften them.

TIP To see a wider range of skin-smoothing options, change the Texture 
Operating mode to Smoothing or Beauty Advanced. These modes break up the 
smoothing process into individual steps in which you can take into account skin 
texture and lighting.

3 Scroll down to the Color Grading section to begin work on the woman’s skin tone.

The Midtone parameter is responsible for the overall brightness of the skin. You can 
use it to reduce the shadows on her face.

4 Drag the Midtone slider to the right (0.030) to brighten the skin, but don’t drag it so far 
that the results become distracting.

TIP For more precision, drag within the numeric field of a parameter instead of 
the slider.

Color Boost enhances saturation in areas of the skin that are undersaturated.

5 Drag the Color Boost until you reach 0.020.

Tint is responsible for undoing the green or magenta color cast that some skin 
tones reflect.
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6 Drag Tint to -0.100 to reduce the redness in the skin.

7 Raise the Contrast (0.100) to return some detail into the shadows of her face.

There is a prominent highlight on her chin where her hat no longer casts a shadow. 
The Shine Removal parameter would be ideal for reducing this glare, but this area of 
her face is not included in the mask matte. You’ll need to expand the mask to include 
this area.

8 Return to the Skin Mask category and select Show Mask.

9 Increase the Face Mask Size to 0.100 to expand the mask matte shape.

10 Increase Face Mask Softness to 0.300 to ensure that the matte’s edge remains 
undetectable in the viewer.

11 Deselect Show Mask.

12 Return to the Color Grading category and raise Shine Removal (0.800) to remove the 
light glare on her chin.

13 Next, scroll down to the Eye Retouching section and click the header to expand it.

The controls in this section allow you to enhance details in the irises of the speaker, as 
well as brighten and soften the skin around the eyes.

14 Set Sharpening to 0.300 to refine the iris, eyelashes, and eye shape.

15 Set Eye Light to 0.050 to gently increase the brightness around the eye area.

16 Adjust Eyebag Removal to 0.200 to brighten the area directly under her eyes.

In addition to addressing general dark circles under eyes, Eyebag Removal can reduce 
shadows caused by headwear as in this clip.

Lip Retouching allows you to saturate and change the hue of a subject’s lip color and 
to smooth upper lip wrinkles in tight, close-up shots. As usual, context is key. The 
park ranger in question is not wearing lipstick, nor do you have a justifiable reason to 
glamorize her as she talks about the issue of rhino poaching in South Africa. In this 
case, the Lip Retouching tool is necessary only to add minor contrast to her skin tone.

17 In the Lip Retouching category, raise Saturation to 0.200 to better define her lips 
against her skin. 

The same guidelines apply to Blush Retouching.



112 Lesson 3 Correcting and Enhancing Isolated Areas

18 In the Blush Retouching category, set Saturation just high enough (0.200) to define her 
face shape without making it look like makeup.

19 Additionally, you could expand the Size to 0.500 to spread the gentle redness across 
either side of her face without concentrating it to the apples of her cheeks.

The Global Blend control at the bottom of the settings allows you to blend the original 
image back into the Face Refinement node. This is ideal when you are generally happy 
with the face refinement but find that it’s a touch too overpowering.

Before After

With just one node, you have successfully enhanced your subject’s skin tone, made it 
more pronounced by brightening and warming it, and added chromatic detail into her 
features. In the original clip, it now becomes apparent how much the shadow of her 
hat was affecting the visibility of her face and facial expressions.

TIP Another tool designed for professional-level skin touch-ups is Beauty 
Resolve FX. Its Ultra Beauty operating mode smooths rough skin textures 
while recovering finer details to produce natural results that complement 
the subject.

20 When you’re done with the adjustments, choose Workspace > Full Screen Viewer or 
press Shift-F to exit Full Screen mode.

TIP To remove a Resolve FX plug-in from a node, right-click the node and 
choose Remove OFX Plugin or click the bin icon in the upper-right corner of the 
Effects Settings panel.
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21 The Face Refinement tool is ideal when working with interview subjects, portrait-style 
compositions, or fashion shoots. When working on profile shots, or subjects with a lot 
of motion, more appropriate solutions would include tools such as the Beauty Resolve 
effect or the primary grading palettes combined with secondary grading techniques.

Adjusting Skin Tones Manually
The Curve palette’s HSL curves allow you to make rapid, targeted secondary adjustments 
to an image based on hue, saturation, or luminance ranges. This makes the HSL curves a 
popular tool for skin, hue, and saturation correction.

In this exercise, you will remove the magenta tint from the subject’s skin.

1 In the yellow flag-filtered timeline, select clip 05.

This clip has already been normalized with Primaries color wheels in node 01.

2 Create a new serial node, and label it Skin Hue (node 02).

3 Open the Curves palette, and in the upper-right corner, choose the Hue Vs Hue curve.
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TIP The naming convention of the hue curves describes the selection method, 
followed by the change type. Hue Vs Sat implies that you are targeting a 
specific range of color (hue) to adjust its saturation (sat), whereas Sat Vs Lum 
suggests that you are targeting a certain range of saturation in an image (sat) 
with the aim of adjusting its brightness (lum).

The Hue Vs Hue palette displays the full range of hues in a linear fashion, looping 
around the red hue. It enables you to sample a specific color and shift it toward 
another hue.

One method of hue selection is to use the swatch buttons at the bottom of the curve 
graph. Another method is to click in the viewer to sample pixel values.

4 In the viewer, click on an evenly exposed patch of the man’s face.

Three control points are added to the Hue Vs Hue curve. The center point identifies 
the selected hue, and the control points on either side act as anchors that limit the 
range of hue that is affected.

TIP If a hue selection lands near the left or right edge of the palette, the range 
will smoothly cycle back around to the opposite edge.



115Adjusting Skin Tones Manually

5 Drag the center control point down slightly to remove some of the red tint in the 
man’s skin tone. Be careful not to introduce too much green. If necessary, drag the 
two control points on either side farther apart to define a wider hue range for the 
skin tone.

TIP For more precision when moving a control point, use the Input Hue and 
Hue Rotation fields in the lower-right corner of the palette.

This might feel a bit like a guessing game. What is the right hue for his skin? To create 
more certainty in your adjustment, you will open the vectorscope and check what the 
adjustment is doing to the skin.

The first thing you’ll need to do is to get a clean view of the face by using a window to 
remove interfering elements.

6 Open the Window palette.

7 Create a circle window and label it Face Window. Position it over the man’s face to 
isolate a clean patch of skin.
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8 Reduce the window’s Softness Soft 1 parameter to 0.00 to get a clean edge on 
the selection. 

9 Click the Highlight button.

This temporary window will aid in providing a clean readout of the skin values to the 
vectorscope.

10 In the Scopes palette, choose Vectorscope as the scope type.

A vectorscope distributes the visual data of an image on a circular graph representing 
the hues in the current frame and their saturation levels. A well-balanced image 
will generally appear as a cloud of pixels in the center of the vectorscope with 
some deviations toward specific hues in images that contain prominent colors. You 
encountered a vectorscope previously when working with the Color Warper tool. 

11 In the upper-right corner, click the settings icon to adjust the appearance of the scope 
for easier readability.

12 Select Show 2x Zoom to increase the size of the trace.
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13 Select Show Skin Tone Indicator to display a line that indicates the angle for skin 
tone hues.

When working with skin tones, the vectorscope can be helpful for determining 
whether a subject’s skin is deviating toward unflattering hues. However, the skin tone 
indicator line itself is not meant as a strict determiner of all skin hues. Some skin tones 
have cool undertones, which naturally lean toward red, or warm undertones, which 
lean toward yellow. When grading, focus on any obvious arcs or distortions in the trace 
that might indicate an incorrect color cast on the skin.

14 Click anywhere in the color page to close the settings pop-up window.

15 Drag the center control point in the Hue Vs Hue palette up and down to observe the 
movement in the vectorscope. It’s important to keep in mind that you’re not trying to 
align the skin hue strictly to the Skin Tone Indicator line. Rather, you are using the Skin 
Tone Indicator to detect and gently reduce any obvious tone deviation. 
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16 A significant part of the man’s skin is in shadow, where it appears to have a prominent 
magenta tint. Add additional control points in the Hue Vs Hue curve and aim to place 
the man’s skin vectorscope trace parallel to the Skin Tone Indicator line.

17 When you are happy with the skin tone hue, turn off Highlight mode.

With the highlight off, the HSL grade is still confined to the circle window. 

18 Go to the Window palette and deactivate the window by clicking the circle icon.
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While the Color Warper allows you to intuitively adjust two values at once, the HSL curves 
are ideal for single-purpose precision, like working on skin tones. These tools should be 
your first choice when you’re trying to quickly adjust the hue, saturation, or luminance 
of an object. If the result is not immediately satisfactory, you can then switch to working 
with more advanced tools like the qualifier or Magic Mask, which offers a greater degree 
of control over your matte selection. Also, keep in mind that you can use the Color Warper 
and HSL curves in combination with the secondary selection tools for an even more 
refined selection.

How Do We Color Grade Skin?
With light meters, color charts, skin tone indicator lines, and more than a century 
of filmmaking, you would think that there would be a well-established standard 
for color correcting skin tones to produce an “optimal” result. And although a set 
of recommended values can be found for portrait and fashion photography, they 
tend to be absent when working with moving images. Why? Because there are too 
many variables to allow for a single working standard. 

There are far too many skin tones and undertones to categorize people, thereby 
eliminating a set of standards on a geographical or racial basis. Modern films tend 
to feature a lot of camera and subject movement, causing the lighting to be in a 
constant flux, which means any corrections applied to a single frame are undone 
as the scene progresses. Many scenes make use of dramatic lighting and shadows 
or bright color gels that artificially distort a subject’s skin tone, all of which results 
in imagery that cannot be corrected in a consistent fashion. 

The subject in this exercise is a perfect example of these factors: he is 
simultaneously overexposed by direct sunlight and underexposed in the shadows, 
and there is even a faint lens reflection near his hat, casting a slight green hue on 
his forehead.

Ultimately, the best practice to employ is to white balance your camera when you 
shoot or capture a white reference in frame (if the lighting in the scene will allow 
it), and then grade your subject in a way that will produce the most aesthetically 
pleasing result on your grading monitor. If the result is pleasing to you, then the 
grade can be considered successful. 
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Setting Skin Tone Saturation
With the skin hue adjusted, you can make use of another HSL curve to address 
skin saturation.

1 Create a new serial node, and label it Skin Sat (node 03).

2 Change the Curves palette mode to Hue Vs Sat.

You can use the Hue Vs Sat palette to make undersaturated items pop or make 
oversaturated colors less distracting. When dealing with skin tones, the right settings 
can be subjective. Generally, darker skin tones require less saturation, while lighter 
skin tones require more. In either case, pushing the saturation too far can cause 
the skin to look distorted. In this image, the saturation in the man’s skin needs very 
little adjustment.

To use the same window analysis technique as in the previous exercise, you can copy 
the window from the Skin Hue node.

3 In the viewer, click a saturated patch of the man’s face to drop the three control 
points in the Hue Vs Sat curve. Drag the two surrounding anchor points in opposite 
directions to widen the selected hue range.

4 Drag the central point up slightly to increase the saturation of the skin, taking care to 
keep the colors natural.

5 Press Command-D (macOS) or Ctrl-D (Windows) to disable the Hue Vs Sat node. Press 
the keyboard shortcut again to view the adjustment.
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Be careful not to get too aggressive when adjusting skin tones. The aim is not to produce 
a magazine-cover look but to reduce minor imperfections and enhance the visibility of the 
face. Getting too aggressive with the Resolve FX or HSL controls can result in plastic-looking 
or overly saturated skin that is even more distracting than the original imperfections.

Memory Colors
Memory colors are colors for which human beings have an instinctive reference. 
The most common of these are sky, grass, and skin tones that tend to be closely 
imprinted in our perception of the world. As you grade, try your best to keep skin 
hue and saturation natural to ensure audience immersion, unless the narrative 
specifically calls for a distortion of these hues. Man-made objects tend to have less 
color memory associated with them, so you have more freedom to tweak the hue 
of a car or the saturation of a character’s dress.

Continue using these techniques in new ways and combining qualifiers/Power Windows 
with your own footage. If you’re uncertain how to proceed with a certain shot, write 
out a workflow to help determine how you want the final output to look, and then work 
backward to choose the tools and adjustments that will realize your goals. You’ll always 
have several possible workflow options, so with experimentation and experience you will 
learn which are the most visually successful and time efficient for you.

Using the Mini Panel—Hue Curves
When working with HSL Curves, the color  
presets and swatches are available as knobs 
below the Mini Panel screens. You can find 
additional curves and tools by pressing the 
Left Arrow and Right Arrow buttons on 
the panel.
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Self-Guided Exercises
Complete the following exercises in the unfiltered 03 Matched Timeline to test your 
understanding of the tools and workflows covered in this lesson.

Clip 01—Use Lum vs Sat in the HSL Curves to increase the saturation of the deer 
in the center of the shot but keep the saturation of the blue gate and the fence 
shadows the same.

Clip 02—Apply a window to isolate the rhino’s face between the bars, and then apply the 
Contrast Pop effect (Resolve FX Color category) to increase the contrast in that portion of 
the frame. The effect should immediately guide the eye without being overpowering.

Clip 03—Apply a window and use any of the sharpening methods covered in this lesson 
(Blur palette, Sharpen Edge effect, or Soften & Sharpen effect) to enhance the numbers on 
the scale and make them more readable. Track the window to the movement of the scale.

Clip 04—Apply a subtle circular vignette at the end of the pipeline in the shot with the 
rhinos and horses. Create another node before the vignette and increase the brightness 
and contrast of the shot to enhance the color and detail.

Clip 05—Use the Color Warper’s Hue-Saturation grid to tint the ground in the field green. 
Use the greenery in the mountains behind the horses as a reference for the hue you 
should achieve. Apply a window to limit the correction to the field.

Clip 05—Create a new node and use the Color Warper’s Chroma-Luma grid to brighten the 
sky and add more blue to it. On the same grid, reduce the brightness of the grass to better 
match the mountains in the background.

Clip 11—Use the Tilt-Shift Blur effect to create an artificial shallow depth of field in the shot 
with the man and his dog. Consider the composition of the clip; you might want to rotate 
the angle of the Depth of Field to be nearly vertical.

When you’ve completed these exercises, open the 05 Completed Effects Timeline to 
compare your work to the “solved” timeline.
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Lesson Review
1 How are secondary color corrections different from primary color corrections?

2 In the Color Warper, how would you lock a specific saturation range of the Hue-
Saturation grid?

3 What does the Hue vs Lum HSL curve do?

4 Which tool can you use to create a vignette?

5 True or false? Track data generated in the Tracker palette can be copied and pasted 
onto another window or node.
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Answers
1 Secondary color corrections affect only a part of the image, whereas primary 

corrections affect the whole frame.

2 In the Hue-Saturation Color Warper grid, saturation is represented by the grid rings. 
To lock them, first select any point in the desired saturation range. Then, in the Tools 
sidebar, click Select Ring, and then click Convert Selected to Pin.

3 The Hue vs Lum HSL curve increases or decreases the brightness of a selected color. 
In the naming convention of HSL curves, the first word prompts the selection, and the 
second word affects the change.

4 A circle Power Window can be used to create a custom vignette, or you could use the 
Vignette effect from the Resolve FX Stylize category of the Effects Library.

5 True. The function to copy and paste track data is found in the options menu of the 
Tracker palette.



Part II

Managing Nodes 
and Grades
Lessons

 — Conforming an XML Timeline

 — Mastering the Node Pipeline

 — Managing Grades Across Clips and Timelines

In Part II of The Colorist Guide to DaVinci Resolve 18, you’ll look at workflows beyond primary 
and secondary color correction to improve your accuracy and speed when grading. Along 
the way, you’ll learn how to conform timelines from other applications, build grading node 
structures with purpose, and use stills and versions to copy and retain grade data.

Project File Location
You will find all the necessary content for this part of the book in the folder BMD 18 
CC - Project 02. Follow the instructions at the start of every lesson to find the 
necessary folder, project, and timeline. If you have not downloaded the second set 
of content files, see the “Getting Started” section of this book for instructions on 
how to do so.
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Lesson 4

Conforming an 
XML Timeline

XML and AAF are two file 
types frequently used to migrate 
timelines between different 
software applications.

However, XML and AAF migration can 
occasionally fail to fully share timeline 
metadata because of variances 
in application design. Migration 
inconsistencies can cause problems 
when you’ve received content edited 
in an external application and want to 
grade and finish it in DaVinci Resolve 
18. Upon import, you may find that 
some areas of the timeline contain 
incorrect clips or have failed to migrate 
transform changes or effects.
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To ensure that an imported timeline is an exact replica of the editor’s work, you must 
use a verification process known as conforming to compare the reconstructed edit 
with a reference video and confirm that every cut and effect is reproduced within 
DaVinci Resolve. When an element is mismatched or missing, you must manually correct it 
in the timeline.

In this lesson, you’ll look at the most common practices and issues associated with the 
conforming workflow. You will also look at more advanced project setup practices by 
utilizing DaVinci Resolve’s color management to produce optimal grading conditions.

Importing an XML Timeline
The project you will be working on is a film trailer for a documentary called Age of 
Airplanes. Due to its nonlinear nature, you will have more opportunity to experiment with 
grade construction and more dramatic looks on a clip-by-clip basis.

You will start by reconstructing the trailer timeline from an XML file exported from the 
editor’s software. You would ordinarily do this in a new DaVinci Resolve project, but for 
the purposes of the upcoming lessons in Part II, you will import a .drp file that has been 
prepared for you.

1 Open DaVinci Resolve 18.

2 Right-click within the Project Manager window and choose Import Project.

3 On your hard disk, locate the BMD 18 CC - Project 02 folder.

4 In the folder, select the Project 02 – Age of Airplanes Trailer.drp file and click Import.

5 In the Project Manager, double-click the 
Project 02 - Age of Airplanes Trailer thumbnail to open the project.

The project is already set up with bins but contains no media or timelines. You’ll import 
the timelines required for the following exercises and associate the necessary media 
with them.

6 In the edit page, select the empty Timelines bin as the destination for the XML timeline 
and choose File > Import > Timeline.

7 In the BMD 18 CC - Project 02 folder, navigate to the XMLs subfolder. Locate the 
Airplanes – 01 LQ Timeline.xml file and click Open.
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The Load XML dialog appears in which you can set up how your XML timeline and 
associated media are imported.

The default settings will work for this timeline because you want DaVinci Resolve to 
locate the media associated with this XML file.

TIP Selecting “Ignore file extensions when matching” will allow you to choose 
media that is in a different file format from the original timeline media, 
provided that the filenames have remained the same. This option can be 
extremely useful when switching between offline and online workflows, which 
you will learn about later in this lesson.

8 Click OK to close the dialog.

DaVinci Resolve will search for the files based on their last known locations in relation 
to the XML file. Most often, drives and paths change during transfer, and a dialog will 
ask for help in locating the missing files.
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9 If this dialog appears, click Yes to locate the missing clips.

This timeline should contain all your low-quality video renders (LQ transcodes). You 
must be specific when indicating their location.

10 Navigate to the BMD 18 CC - Project 02 folder and select the LQ Transcodes subfolder. 
Click OK at the bottom of the dialog. 

This action should reconnect most of your media. However, the dialog will appear 
again, suggesting that some remaining clips have not been located. This is because 
you’ve specified the location of the video clips but not the audio. 

11 Click Yes again to locate the audio.

12 In BMD 18 CC - Project 02, select the Audio subfolder and click OK.

A few remaining clips will not be found. This sometimes occurs when video clips in 
the timeline are renamed or changed after the XML file is generated. Because of this 
change, DaVinci Resolve cannot establish a connection with the media. You will resolve 
this during the conforming stage.

13 In the second dialog, click No.

Another window appears. The Log displays a summary of the migration process, 
including a confirmation of the imported timeline and a list of migration issues 
(translation errors). This summary can help eliminate some of the guesswork from 
the conforming process.

14 Read the Log to see the name of the missing clips and click Close when you are done.
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The timeline should now appear in the edit page and its media in the media pool.

TIP You can view the Log of an imported timeline at any time from the media 
pool. With the timeline open in the edit page, click the media pool options 
menu in the upper-right corner and choose Show Import Log.

15 For easier project management, organize the imported files in the media pool. The 
timeline thumbnail (identified by a white timeline symbol in the lower-left corner and 
indicated as the active timeline by an orange tick in the upper-left corner) can remain 
in the Timelines bin. The four audio files should be dragged into the Audio bin, and the 
video files to the LQ Transcodes bin. 

As long as the filenames of media files are not changed, relinking is a straightforward 
process. For this reason, it’s highly advisable to never rename media but work with the 
original camera filenames throughout the entire post-production process.

TIP When migrating with AAF files to and from Avid Media Composer, you must 
retain reel names when creating low-resolution dailies and relinking to high-
resolution original files. To do so, select the offline clips on the timeline, choose 
File > Reconform from Media Storage, and in the Conform Options select “Reel 
Name Using: Embedded source clip metadata.”

Syncing an Offline Reference
With the XML timeline imported and set up, you should now check the edit to ensure that 
every clip, cut, and effect was successfully migrated. To aid in this stage of the conforming 
process, the editor should provide a reference movie: a single exported video file of the 
final timeline that you can use for visual verification of the imported timeline.

In this exercise, you’ll associate a reference movie with a timeline and fix any issues that 
may have occurred during migration.

1 Go to the media page.

2 In the media pool, select the References bin as the target for the new clip you are 
about to import.
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3 In the media storage browser, navigate to the BMD 18 CC - Project 02 folder.

4 In the Other subfolder, find the Age of Airplanes REFERENCE.mov file and drag it into 
the References bin.

5 Open the edit page.

6 Access the source viewer options menu and deselect Live Media Preview. This will 
ensure that the viewer does not change modes when you interact with the clips in the 
media pool.

7 In the lower-left corner of the source viewer, open the mode dropdown menu and 
choose Offline. Doing so will switch the source viewer from showing source materials 
to displaying offline reference clips.

8 Drag the Age of Airplanes REFERENCE.mov from the media pool directly into 
the source viewer. This will associate it as an offline reference clip with the active 
Airplanes - 01 LQ Timeline. 

However, the viewer currently shows the red Media Offline frame. One of the most 
common reasons a reference clip appears offline is because its timecode does not 
align with the timeline timecode.

9 Click the List View icon at the top of the media pool to view the media metadata.

10 In the Start TC column, view the start timecode of the reference clip and compare it to 
the start timecode of the timeline.

In editing programs, timelines tend to begin at the one-hour timecode (01:00:00:00), 
whereas rendered video clips tend to begin at 00:00:00:00, as is the case with this 
reference. You can easily correct this by changing the start timecode of the reference 
clip to match the timeline.

11 Right-click the reference clip in the media pool and choose Clip Attributes.
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12 In the Clip Attributes window, click the Timecode tab and enter 01 as the Current 
Frame hour. Click OK to close the window.

If the reference movie does not immediately appear in the source viewer, check the 
source viewer mode dropdown menu to ensure that Offline is still selected and drag 
the timeline playhead to refresh the frame.

Conforming a Timeline
With the reference movie in place, you can now inspect the timeline to address any visual 
inconsistencies. Your primary task will be to ensure that the correct clips are on the 
timeline and to check that their cuts are occurring at the right time. To accomplish this, you 
must review the edit, cut by cut.

1 Enter the media page.

2 In the media storage browser, navigate to the BMD 18 CC - Project 02 folder and enter 
the Other subfolder.

The Log window had listed the credits of the trailer among the missing media.

3 Drag CREDITS.mov into the Graphics bin of the media pool. 

4 Return to the edit page.

The credits media file is automatically recognized and assigned to the missing media 
clip at the end of the timeline. Whenever source media maintains the same name as 
the clip paths in an XML file, it will immediately appear in the timeline, even if imported 
after the XML construction.

5 The audio files have linked successfully in the timeline, but audio level settings usually 
don’t travel when migrating in the XML format. To prevent being distracted by the non-
mixed audio, click the Mute button to the right of the timeline toolbar.

6 Move the playhead to the start of the Airplanes - 01 LQ Timeline.
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7 Press the Down Arrow on your keyboard until you navigate to the first video cut point 
at the start of the second clip on the timeline.

It is apparent that the timeline clip does not match the clip in the reference video. 
The text rendered with the reference video (called data burn-in) tells you that the 
clip should be AERIAL_SFO_02, whereas the clip in the edit page timeline is AERIAL_
SFO_01. This mismatch could be caused by a clash in the tape/reel name or the editor 
making a change after exporting the XML file. 

To resolve this, you can manually import and assign the correct clip to the timeline.

8 Enter the media page.

9 In the media storage browser, enter the Other LQ Transcodes subfolder.

10 Drag the AERIAL_SFO_02.mov video clip into the LQ Transcodes bin of the media pool.

11 Return to the edit page.

12 In the LQ Transcodes bin of the media pool, click the AERIAL_SFO_02.mov thumbnail.

13 In the timeline, right-click the second clip and choose “Conform Lock with Media Pool 
Clip.” Doing so replaces the clip in the timeline with the selected media pool clip, which 
now matches the clip in the reference movie. 

NOTE If the clip in the media pool and the clip in the timeline have the same 
available timecode range, the conform action will place the incoming clip using 
the same In and Out points as the original cut. If the incoming clip does not 
have the necessary timecode range, the first frame of the incoming clip will be 
aligned to the cut point.

You have likely noticed that the contrast and saturation of the clips in the two viewers 
appear to be different. This is because the reference clip was rendered with a Rec.709 
color gamut, while the source media still has its original log-encoded gamma curve. 
You will address this with the help of DaVinci Resolve’s color management at the end of 
this lesson. 



135Conforming a Timeline

Fixing Translation Errors
Continue to navigate down the timeline and look at the reference movie to check the clips, 
edit points, and effects to make sure that everything is successfully translated.

1 Press the Down Arrow to jump to the next video cut at the start of clip 3 
(TAKE_OFF_SFO.mov).

In addition to checking the timeline clips and their edit points, your conforming 
process should ensure that all transitions and effects are present. A simple side-by-
side comparison cannot always do this, so DaVinci Resolve provides the option to 
superimpose the reference movie on the timeline viewer. This procedure helps you 
check whether clips are framed identically.

2 Right-click the timeline viewer and choose Horizontal Wipe.

The timeline clip is displayed to the left, while the reference clip is displayed to the right.

3 Drag the wipe left and right to compare the placement of the timeline clip to the reference.
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Using the wipe for comparison reveals a mismatch in the shot framing. To fix it, you 
can switch to a difference composite.

4 Right-click the timeline viewer and choose Difference to highlight where the clip is 
misaligned.

5 In the timeline, click the TAKE_OFF_SFO clip and open the Inspector panel in the upper-
right corner.

6 In the Transform controls, increase the Zoom value until the size of the cockpit 
windows appear the same (1.200).

7 Using the windows and wings as guides, drag the Y Position down (-100.00) until the 
timeline clip overlaps the reference. When performing these matches visually, you may 
need to go back and forth between the position parameters to get a perfect fit.
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TIP You can use the Inspector’s Anchor Point parameters to simplify the 
process of matching a reframed clip. First, click the Transform button in the 
lower left of the timeline viewer to activate onscreen controls. Then drag the 
anchor over a distinct object in the frame (like a window frame or banner text). 
When you now adjust the Inspector’s Transform controls, the zoom will expand 
from the new anchor position, simplifying the process of lining up the shot 
scale and position.

When you no longer see a “double effect” on the plane in the viewer, the framing is 
successfully matched. If you were working on images with identical color gamuts, the 
viewer would become black to signify that no visual differences remained between 
the clips.

8 Right-click the timeline viewer and choose No Wipe to return to the standard viewer. 

9 Close the Inspector. If you are working on a 1920 x 1080 resolution (or smaller) 
monitor, this action this will bring back the source viewer.

10 Press the Down Arrow to navigate to the next video cut. This is the clip that was 
missing when the XML timeline was imported.

11 Return to the media page. In the media storage browser, locate the Other folder and 
open the Other LQ Transcodes subfolder.

12 Drag the BA4662_54.mov and BA4662_55.mov clips into the LQ Transcodes bin of 
the media pool and return to the edit page.

13 Press Command-+ (plus sign) in macOS or Ctrl-+ (plus sign) in Windows to zoom in to 
the offline clip in the timeline.

14 Right-click the clip and choose Conform Lock Enabled to disable the conform lock. The 
clip is now receptive to all media that contains similar metadata.

In the lower-left corner of the timeline clip, a red attention badge icon <!> indicates a 
potential metadata clash with another clip in the media pool.
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15 Double-click the attention badge on the clip.

The Conflict Resolution window appears, displaying all the clips in the bin that match 
the metadata of the clip in the timeline. You can now select the correct clip according 
to the reference movie.

16 In the Conflict Resolution window, select the water shot BA4662_55.mov and 
click Change.

The correct clip is placed in the timeline and matches the reference movie. To remove 
the now black-colored resolved badge and confirm the new clip as correct, you can 
lock the conformed selection.

17 In the timeline, right-click the clip and choose Conform Lock Enabled.

18 Press the Down Arrow to navigate to the next video cut, which features an interview 
with a jump cut near the end. The first instance of the interview is correctly timed, but 
the second instance appears to be off. The speaker’s facial expression has changed, 
and his speech is no longer synced to the INT_02.aif audio clip on audio track 1.
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The most likely cause for a clip to become unsynced is a mismatch in metadata tags 
between applications or a difference in framerates between the timeline and the 
edited clip. 

19 In the timeline, zoom in on the second INT_02 clip so that you can interact with it 
more easily.

20 Enable Mix Wipe mode in the timeline viewer.

21 In the timeline toolbar, change the edit mode to Trim Edit mode. 

This will allow you to perform rippling, trimming, slipping, and sliding functions that 
are not possible in the default Selection mode.

22 Click the center of the second INT_02 clip and drag in either direction to see the 
change in the timeline viewer.

By slipping the clip, you keep its place in the edit, while changing the range of media 
that appears between the In and Out points.

23 Slip the clip left until the mixed images in the timeline viewer are lined up and then 
release the mouse button.

Before After

24 Turn off the Mix Wipe mode and compare the frames in the two viewers.
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25 In the timeline toolbar, change the edit mode back to Selection mode.

26 Press the Left Arrow and Right Arrow keys to ensure that the speaker’s movement 
remains consistent with the reference clip.

27 Continue to press the Down Arrow to check the remainder of the clips.

When you reach clip 08 (YELLOW_PLANE.mov), you will notice that the clip has very 
different colors compared to the reference movie.

It is common practice for editors, cinematographers, or other creative directors to 
leave preliminary grades baked into the reference movie as a guide for the colorist. 
Grading data does not usually travel with migration files unless the project is sent in 
a native DaVinci Resolve format or it includes accompanying LUTs (Lookup tables) or a 
CDL (color decision list) file.

It will not be necessary to do anything with this clip at this time, but it will be useful 
later when you begin the grading process.

TIP To import LUTs into DaVinci Resolve, open the Project Settings and 
enter the Color Management tab. In the Lookup Tables section, click Open 
LUT Folder, and drag your LUTs into the DaVinci Resolve LUT folder on 
your workstation. When finished, return to the Project Settings and click 
Update Lists.

To set up a custom LUT folder path, open DaVinci Resolve > Preferences. In 
the System menu, open the General sidebar, and under LUT Locations, click 
Add. After adding your LUT folder location, open the LUTs panel on the color 
page, right-click the sidebar, and choose Refresh. Folders in your custom file 
path will appear as subfolders in the LUTs master folder, while LUTs will be 
imported directly.

In addition to the LUTs panel, imported LUTs are also accessible in every clip 
and node contextual menu.
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Although it’s natural to feel that something has gone wrong with your workflow when the 
timeline presents issues during XML migration, it’s important to remember that this is a 
completely normal and anticipated stage of postproduction. It is encountered in projects 
of all calibers and stems from the fact that no single migration standard exists among the 
dozens of applications that you may use when collaborating on a film project.

One of the major advantages of performing your entire post-production workflow in 
DaVinci Resolve is its substantial reduction of migration and project management issues. 
An edit can be ingested, edited, graded, mixed, and delivered without ever needing to 
be conformed.

TIP When sharing a timeline with someone who is also working in DaVinci Resolve, 
you have several options:

 — Export the timeline (from the media pool) in the native DaVinci Resolve .drt 
format for a conform-free migration

 — Export the entire project (from the Project Manager) as a .drp to share all 
project bins and timelines

 — Export the project archive (from the Project Manager) as a .dra to share the 
entire project and all its media contents

Associating HQ Footage with a 
Timeline for Online Workflows
The timeline you reconstructed for this section is currently associated with media from the 
LQ Transcodes folder. These low-quality video files are generated from the source media 
with the intention of providing the editor with light video files that are easy to transfer due 
to their small file size and do not lag when played in real-time. Working with transcoded or 
proxy media is referred to as offline editing.

The accuracy of an image’s pixel data is not vital to editors because they are focused 
on constructing a narrative and feeling the flow of the edit. However, when the timeline 
reaches the colorist or VFX compositor, the quality of the image becomes paramount. At 
this stage you will want to create a copy of the timeline that links to the HQ video files that 
are optimal for grading. This process, and all editing workflows that utilize source camera 
footage, is known as online editing.
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1 In the edit page, in the media pool, open the Timelines bin.

2 Right-click the Airplanes – 01 LQ Timeline and choose Duplicate Timeline.

3 Slowly click twice on the name of the new timeline and rename it Airplanes – 
01 HQ Timeline.

4 Double-click the HQ Timeline to open it in the edit page timeline window.

5 In the media pool, click the empty HQ Transcodes bin to select the destination for 
the high-quality media.

6 In track V1, drag to select all the video clips on the timeline. Do not include the credits 
or audio in your selection.

7 Right-click any clip in the timeline and deselect Conform Lock Enabled. Doing so will 
disable the clips’ lock on their media file paths and prompt them to acknowledge all 
media that shares similar metadata and timecodes in the media pool.

8 In the File menu, choose Reconform from Media Storage.

The Conform from Media Storage window allows you to refine the media that is being 
associated with the clips in the timeline.

9 Under Timeline Options, choose “Attempt to reconform Selected Clips in timeline.”

10 Under Choose Conform Folders, select the BMD 18 CC - Project 02 > HQ 
Transcodes folder.
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11 Under Conform Options, deselect Timecode.

12 Select File Name and choose “Tight filename match.”

13 Click OK.

The HQ Transcodes bin is populated with the higher-quality clips that also replace the 
LQ clips on the timeline. 

However, this clip state might be difficult to see in the HQ Timeline because the clips in 
the timeline appear the same. You can adjust the appearance of the clips to verify that 
the link was successful. 

14 In the HQ Transcodes bin, select all the newly imported clips. 

15 Right-click one of them and choose Clip Color > Orange. All the clips in the timeline 
that were successfully switched to the higher-quality media will appear orange in 
the timeline.

Before

After

16 To lock the HQ clips to the timeline, select them, right-click, and choose Conform 
Lock Enabled.

This method of switching source file locations gives you full control over the media used in 
the timeline without the need to import additional XML files or to change the file paths of 
the clips in the media pool. An important component of this workflow is a well-organized 
and consistently labeled file system, which is a practice recommended across all post-
production workflows.

Having successfully imported and prepared the XML timeline for grading, you can proceed 
with the knowledge that the timeline is accurate and that you are in control of your footage 
quality at all times. However, the media in this project is currently in a log-encoded color 
gamut that does not give an accurate visual reproduction of the hues and luminance of 
the recorded images. The next set of exercises will show you how to manage log-encoded 
content to output to the more visually accessible and grade-friendly Rec.709 color gamut.



144 Lesson 4 Conforming an XML Timeline

DaVinci Resolve Proxy Workflows
The online/offline workflow covered in this lesson assumed a collaboration 
between an editor and a colorist on separate platforms. If you are both the editor 
and colorist and using DaVinci Resolve for the entirety of your postproduction, 
you can opt for some faster and more efficient options when switching between 
transcoded proxy media and original camera footage in your timeline.

Generate Proxy Media in the Media Pool 

You can generate proxy media directly in the media pool after importing your 
source clips. Select the necessary clip(s) in the bin, right-click, and choose 
Generate Proxy Media. This will prompt proxy media to be generated in the 
location specified in the Working Folders (‘Proxy generation location’) of the 
Project Settings. If you already have transcoded media on hand, you can link it to 
the camera originals in the media pool by selecting the clips, right-clicking, and 
choosing Relink Proxy Media.

Blackmagic Proxy Generator

DaVinci Resolve comes with a stand-alone application that you  
can use to generate proxies in the background while you 
continue to work on your project. The Blackmagic Proxy 
Generator features a Watch Folders list, which creates a live link 
between a location on your drive and its respective proxy folder. 
As soon as you drag media from each day’s shoot into the watch 
folder, the proxies will automatically begin generating, and will then link to the 
camera originals as soon as those are added to the media pool.

Switching Between Proxy Media and Original Camera Footage

In every instance described above, the proxies and camera originals will occupy 
the same space in the media pool. This enables you to edit and grade with just one 
set of media and choose which version you wish to see at any given time. To switch 
between the versions, go to the Playback menu and navigate to Proxy Handling. 
Selecting “Disable all proxies” will force only the camera originals to be visible 
in the timeline. If the original media is absent, you will see a red Media Offline 
frame in the viewer. This is optimal for final grading and delivery, when you want 
to be certain that you’re only working with the original media. Selecting Prefer 
Proxies will switch all media to its associated proxy clips, where available. If any 
clips have no proxies, the original camera footage will be used. The same applies 
to “Prefer Camera Originals,” which will show proxy media in instances where the 
original camera footage cannot be found. These last two options are optimal if you 
want to avoid the red Media Offline frame from appearing in your timeline and 
final render. 
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Maximizing the Dynamic Range
The grading potential of an image is determined primarily by its dynamic range, which is 
the range from its darkest point to its brightest point.

HD consumer and broadcast video cameras tend to record using a standard dynamic range 
based on the Rec.709 color standard. This standard ensures that the image looks as close 
to real life as possible and displays as such on an HDTV or computer monitor. However, 
higher-end prosumer and professional digital film cameras can capture and transcode 
footage with a wider dynamic range by using a nonlinear, or log, gamma curve. This curve 
gives you greater flexibility for manipulating brightness and contrast without distortion.

Ungraded video in log gamma curve

Ungraded video in Rec.709 gamma 2.4 color gamut

A byproduct of encoding footage with a log gamma curve, however, is that footage initially 
appears flat and with low saturation when viewed on an HDTV or computer monitor.
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Therefore, a colorist must first correct the log gamma curve so that it appears correctly 
on the display. This process is called display-referred color management. Because 
DaVinci Resolve receives no direction on how the source media is meant to look, 
configuring that look is left to the colorist. This process often employs LUTs to convert 
from log to Rec.709, assuming that is the intended final output format.

However, DaVinci Resolve also supports scene-referred color management that allows the 
colorist to assign color profiles to media based on how that media was captured. Each 
clip’s native color gamut and gamma are then converted to the desired output. The colorist 
no longer must manage LUTs for different sources or manually convert each clip from log 
to Rec.709 using standard grading tools because DaVinci Resolve’s color management 
performs this action in the background automatically.

Setting Up Color Management in a Project
It’s highly advised to set up color management at the earliest possible stage of 
color correction to ensure that the color grading tools behave in an accurate and 
consistent manner.

1 Open the Project Settings by clicking the gear icon in the lower-right corner of the 
workspace.

2 Click Color Management in the Project Settings sidebar.

3 In the Color Space & Transforms section, set the Color science menu to DaVinci YRGB 
Color Managed. Doing so will activate scene-referred color management and reveal 
the color processing modes and output color space options.

With “Automatic color management” enabled, the color processing mode is simplified 
to include just two working environments: SDR and HDR. When you select a preset 
in this dropdown menu, a brief description underneath will summarize the preset’s 
intended use.
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4 There is no HDR media in the Age of Airplanes trailer, and it’s unlikely that this 
project will be seen anywhere other than on your computer screen, so Rec.709 is an 
appropriate working gamut.

5 Leave the “Color processing mode” as SDR.

6 The “Output color space” determines the standard that the processing mode is 
mapped to. This should generally be the color space/gamut and gamma of your 
computer or grading monitor, or your intended deliverable standard. 

7 If you’re working on a computer monitor, leave the “Output color space” as 
SDR Rec.709.

8 Click Save to close the Project Settings.

Color management is now set up in the project, but you might not see an immediate 
change in the viewer. This is because video media adopts the default Rec.709 (scene) 
input color space when it is imported into a non-color-managed project. You will need 
to override the input color space of the clips on the timeline for the color management 
to take effect.

9 In the media pool, open the HQ Transcodes bin.

10 Drag to select all the clips in the pool or press Command-A (macOS) or 
Ctrl-A (Windows).

11 Right-click any of the selected clips and choose Input Color Space > Blackmagic Design 
Film Gen 1. This identifies the camera model, data level, and firmware version that 
were used to record the footage in this project.

By correctly setting up the input color space of the media, the colors of the timeline 
clips will shift from the Blackmagic Design log color space to Rec.709 with the 
standard 2.4 gamma curve. As a result, the clips will appear more vibrant and with 
more pronounced contrast.
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TIP If the image in your viewer feels too flat when completing the exercises in 
this lesson, change the Output color space to Rec.709 Gamma 2.2. This is a more 
appropriate gamma curve for many standard computer monitors, especially in 
rooms with less controlled lighting than a grading suite.

If you’re using a Mac display, you’ll need to choose an Output color space based on 
your ICC display profile. To find your display profile in your macOS, go to System 
Preferences > Displays > Color tab. On newer displays, the profile will usually be 
Display P3. To set the correct “Output color space” for Display P3 in the Project 
Settings, disable “Automatic color management,” select “Use separate color space 
and gamma” above the Output color space field, and set the left field as P3-D65 
and the right field as sRGB.

DaVinci YRGB color management applies to all the clips in a project. If certain clips come 
from different sources from the rest of the timeline, you can reassign their individual input 
color spaces through the media pool’s contextual menu (or the color page clip timeline).

Using DaVinci Resolve with Mac Displays
The macOS internal color management utility, ColorSync, uses metadata to match 
colors between its applications. As a third-party software, DaVinci Resolve is not 
impacted by ColorSync, which is why the videos rendered out of DaVinci Resolve 
might look different when viewed in Safari or QuickTime. To avoid this, you 
can choose to include DaVinci Resolve in ColorSync’s internal matching. Go 
to DaVinci Resolve > Preferences > System and in the General category select 
Use Mac Display Color Profile for Viewers. This will enable DaVinci Resolve to 
use whichever color profile you currently have selected in the macOS Color 
preferences, including custom color profiles and calibration software profiles. 
Please note that this will only affect the appearance of the footage in the viewers. 
In Lesson 10, you’ll find additional instructions on how to correctly render videos 
to appear the same across all applications and web browsers.
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TIP You could use a smart bin to filter clips based on their sources and then set 
their input color spaces in batches to save time.

DaVinci YRGB color management offers a structured, solid foundation for color grading 
by remapping the starting point of video media (from any number of sources) to a 
single, grade-appropriate color standard. Its advanced tone mapping ability means that 
highlights are gently rolled off, preserving maximum quality. Compare the treatment of the 
highlights in the reference movie (which underwent standard log-to-Rec.709 conversion) to 
the DaVinci YRGB color management tone remapping.

This method of color management results in higher-quality visual output, more consistency 
in the performance of the color page grading tools, as well as an easier delivery process 
in which the project output color space can be remapped to any number of deliverable 
standards.

When You Don’t Know the Camera or Format
DaVinci YRGB color management operates at its best when you know and indicate 
the correct input color space data. But identifying that data can be tricky when 
the origins of the footage are unknown, or when the color space details were 
not included during file transfer. You can derive some useful information by 
examining clip properties, but that will not usually provide information about the 
camera model or gamma range. You can acquire the most definitive information 
by contacting the director of photography or the camera operator directly and 
requesting this information. 

If all else fails, you can bypass DaVinci YRGB color management altogether and 
manually normalize the clips. In such cases, it is still advisable to review your color 
management project settings at the start of every project and set your Timeline 
Color Space to a common working standard like Rec.709 Gamma 2.4.
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Changing the Output Color Space
One of the most powerful aspects of using a color-managed workflow in DaVinci Resolve 
is that you can change the output color space at any time based on your final 
delivery requirements.

Doing so is particularly helpful when you need to output multiple masters to different 
destinations. You might want one master for Rec.709 (broadcast/internet), another for 
Rec.2020 (UHD television), and yet another for DCI-P3 (digital cinema). DaVinci Resolve 
manages the color transformations without the need to regrade the timeline or change 
anything on the color page.

1 Open Project Settings > Color Management.

2 Click “Automatic color management” to disable it.

The color management options have mostly stayed the same, but you now have a 
wider selection of color processing modes and output color spaces to allow for more 
precise setup.

3 Set the Output Color Space to P3-D65 ST2084 4000 nits.

4 Click Save.

The color space is changed, and the viewer reflects the updated results. On a standard 
computer monitor, the colors will now appear flat. However, if you had a calibrated 
HDR P3-D65 monitor capable of displaying 4000 nit luminance, the clips would look 
nearly identical to their appearance on your HD Rec.709 display. If you had graded 
the media in the timeline, the final colors would be remapped similarly to adhere to 
P3-D65 ST2084 standard. This is how you can use color management to effortlessly 
switch between different monitor and deliverable standards when you need to.
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Accurate Color Monitoring in DaVinci Resolve
DaVinci Resolve was designed to work with industry-standard calibrated external 
displays connected via video output interfaces for critical color evaluation.

Most computer monitors are incapable of displaying the color gamut and gamma 
range required for broadcast and theatrical distribution. Additionally, most 
computer displays have their own color and contrast calibration as determined by 
the manufacturer, which is further altered by the operating system’s internal color 
management. For this reason, their color accuracy cannot be guaranteed upon 
delivery, and the resulting video could even shift in appearance when viewed in 
different video players on the same machine.

Ideally, you should use an external monitor and video interface if color accuracy is 
important to you. Alternatively, you could use a color calibration probe to analyze 
your computer display and generate a LUT that will remap the display to the 
correct standard.

5 Open Project Settings > Color Management.

6 Set the Output Color Space back to the default Rec.709 Gamma 2.4.

7 Enable “Automatic color management.”

This is the simplest option for color managing a project. You leave it up to 
DaVinci Resolve to do much of the under-the-hood analysis and calibration that will 
result in the best-looking images in the viewer and the ideal performance from the 
color page tools. If you’re new to color grading, or if your output is mainly web content, 
this setting is perfect for you. 

8 Click Save.

TIP If you know in advance that you will deliver content in multiple color gamut 
standards, consider starting your workflow at the widest gamut. For example, if 
delivering for web (Rec.709 Gamma 2.2), digital cinema projection (DCI-P3), and 
HDR broadcast (Rec.2100 ST2084), the best option would be to grade your project 
for HDR first. Then, duplicate the project and calibrate the Output Color Space to 
DCI-P3. Review the timeline, make the necessary highlight adjustments to complete 
and render the cinema grade, and then remap the Output Color Space to Rec.709 
for the web deliverable. 
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You can change the gamma range separately from the color space/gamut by selecting 
Use Separate Color Space and Gamma above the color space menu. Separating the color 
space/gamut and gamma settings gives you further control over the chrominance and 
luminance processing of your footage. It enables you to indicate gamma ranges that are 
not part of the standard preset selection of the color space/gamut menus.

NOTE You will continue to work on the timeline created in this lesson over the 
next two lessons. If you would like to verify that your timeline is correct or are 
uncertain of the accuracy of your conforming, you may import Project 02 – Age of 
Airplanes Trailer COMPLETED.drp into the Project Manager and open Airplanes 
- 01 HQ Timeline. If the media appears offline, click the red Relink Media button in 
the upper-left corner of the media pool and specify the location of the Project 02 
media on your workstation. You can then use this ungraded, conformed timeline to 
complete the next two lessons in this book.
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Lesson Review
1 During project migration, what is a translation error?

2 How do you designate a video file as an offline reference movie?

3 When loading an XML file, why would you opt to “Ignore file extensions when 
matching”?

4 What does File > Reconform from Bins allow you to do?

5 Where do you activate DaVinci YRGB Color Management?
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Answers
1 Translation errors are inconsistencies that appear in reconstructed timelines 

between applications.

2 To designate an offline reference movie, first disable Live Media Preview in the source 
viewer and activate Offline mode. Any clip you drag from the media pool into the 
source viewer will be associated as a reference clip with the active project timeline. 
You can also designate video files as reference movies in the contextual menu of the 
media storage browser.

3 You would choose to ignore file extensions to link to a different media file format 
during timeline reconstruction. This is commonly used when switching between offline 
and online editing, or vice versa.

4 Reconform from Bins allows you to change the source media of a timeline based on 
a bin in the media pool.

5 In Project Settings > Color Management, set Color Science to DaVinci YRGB 
Color Managed.
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Understanding Node-Based 
Grade Compositing
Node-based compositing is different from the layer-based system familiar to many 
nonlinear editing (NLE) editors. Unlike layers, in which the visuals are compounded 
based on their order in the layer stack, nodes process a single RGB signal, modifying it 
along the way.

As each node affects the image, it outputs the altered signal via an RGB connection line 
until the final RGB data reaches the output node of the Node Editor. This output node 
presents the image in its final state to the viewer and determines how the media will look 
when rendered.

Nodes are capable of reusing information from previous nodes, substantially reducing 
the amount of processing power required to assemble and output a final image. This 
capability is particularly useful when working with keys, such as those generated by 
qualifiers and Power Windows.

The Anatomy of a Node
The node graph is read from left to right. The RGB signal that constitutes the image begins 
at the leftmost green node—the source input—and travels through the connection lines 
that link the corrector nodes until it reaches the node tree output to the right. The RGB 
signal must be uninterrupted for the node grades to be correctly compiled and output.

Standard corrector nodes have two inputs and two outputs.

Inputs Outputs
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The green triangle and square shapes at the top of either side are the RGB inputs and 
outputs. These carry the pixel data of the image, which is manipulated within the node 
using the grading tools of the color page. Corrector nodes can accept only one RGB 
input but can output multiple RGB signals to other nodes.

The blue shapes are the key inputs and outputs. These enable you to transfer the key 
data generated by qualifiers and Power Windows (or external mattes) to be used by 
other nodes.

Key data is predominantly represented by a black-and-white matte, although depending 
on the tool and highlight mode, it might appear in the viewer as a frame with transparent 
values. You used key data in Lesson 1, in which a black-and-white matte was generated by 
the Depth Map effect, and in Lesson 3, in which a linear window was shared between two 
nodes (Sunlight and Outside). Although the key appeared as a transparent rectangle in 
the Outside node’s frame, enabling Highlight B/W mode in the viewer would prove it was 
also a matte.

Recognizing the 
Importance of Node Order
The RGB signal output of each node carries the full weight of its grade and directly affects 
how subsequent nodes interact with it. The following set of exercises demonstrate how 
nodes impact one another.

NOTE The node structures of every exercise in this segment can be found in the 
Node demos album of the gallery in the color page.

Influence of Color and 
Saturation Across Nodes
You can see how a node placed at an early stage of the grading pipeline influences the 
following nodes by removing its saturation and observing the results.

1 Open the Project 02 – Age of Airplanes Trailer project.

2 Enter the color page.

3 Select clip 05 in the Airplanes – 01 HQ Timeline.



158 Lesson 5 Mastering the Node Pipeline

4 Label the first node BW.

5 Open the RGB Mixer palette, which is in the left palettes.

6 Select Monochrome (at the bottom of the palette) to convert the image into black 
and white.

The RGB Mixer gives you full control over the strength of the individual RGB channels 
and is often used for tweaking black-and-white images to create an aesthetically 
pleasing balance of natural elements such as skin, sky, and trees.

7 Drag up the Red Output’s R bar to increase the strength of the red channel in the 
image. This change will brighten the man’s face against the background and create 
a good contrast.

8 Create a second node and label it Sepia.

9 Open the Primaries color wheels palette and drag the Offset color wheel toward 
orange–yellow to give the image a sepia tint.

10 Click node 01 (BW) and return to the RGB Mixer palette.

11 Drag the Blue Output’s B bar up and down to increase and decrease the strength of 
the blue channel in the image.

The effect on the final sepia grade shows that the contrast created in the first node 
continues to impact the image even after a second node dramatically changes its 
appearance.

For an even clearer visualization of how node order impacts the grade, you can switch 
the order of the two nodes.

12 Click node 02 (Sepia) and press E to extract it from the pipeline.
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13 Drag the disconnected node onto the connection line to the left of node 01 until the 
line turns yellow and a + (plus sign) appears.

TIP A quick way to switch the order of two nodes is to hold Command (macOS) 
or Ctrl (Windows) and drag one node over another.

When reconnected, the image becomes black and white. Although the sepia grade is 
still performing its function in the first node, it is being completely overwritten by the 
BW node, which is turning the RGB signal monochromatic and sending it to the node 
tree output.

14 For a further demonstration of earlier nodes’ continued impact on later nodes, select 
node 01 (Sepia) and drag the Offset color wheel toward blue.

Once again, there is a change in the viewer, although there are no visible blue hues 
at this stage of the pipeline. This is because you had initially boosted the red channel 
output in the BW node’s RGB Mixer, which has made it sensitive to changes in the red 
channel. Dragging the Sepia node’s Offset wheel toward a cooler shade then directly 
impacts the brightness achieved by the RGB Mixer in the BW node.

Adjusting Contrast and Luminance on Nodes
With a clearer understanding of the function of RGB inputs and outputs, you can now 
check how adjustments to luminance and contrast can have substantial impact on an 
image’s signal quality.

1 Press Command-Home (macOS) or Ctrl-Home (Windows) to reset the grade in clip 05.

2 Label the first node Lift crush.
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3 In the Primaries palette, drag the Lift master wheel to the left until it reaches -0.20.

The clip will lose a great amount of detail in the shadows, and the bottom of the 
waveform trace will appear to be crushed against the black point of the scopes graph.

4 Create a new node, and label it Curves restore. 

You will attempt to restore the shadow data in this new node.

5 Open the Curves palette and ensure that the YRGB channels are linked.

6 Click the center of the curve to create a new control point and drag it up to brighten 
the image.

The resulting image appears distorted. The fine detail in the man’s shirt is lost in 
the contrast, and his face becomes patchy and overexposed. This demonstrates 
a “destructive” workflow in which the changes made in one node can restrict the 
RGB data available to subsequent nodes.

Thankfully, you cannot truly destroy RGB pixel data in the pipeline. By using the correct 
part of the curve, for example, you can fully restore the shadows of the original image.

7 Right-click the control point on the curve to remove it.

Let’s first gain a better understanding of how the video signal changes from one node 
to the next.

8 Click node 01 in the node pipeline to review the Curves palette histogram trace.



161Recognizing the Importance of Node Order

9 Click node 02 to compare the histogram trace in the same graph.

01 Lift crush RGB input histogram 02 Curves restore RGB input histogram

The histogram changes to represent the state of the video signal as it enters the 
selected node. When grading, such changes can be extremely useful for determining 
where to click on the graph to target specific luminance and chrominance ranges. The 
histogram readout in node 02 signifies that most of the data is crushed against the 
lower left of the graph. 

10 Drag the black point of the YRGB curve upward along the left side of the curves graph. 
Stop dragging when you are halfway between the second and third horizontal lines 
from the bottom.

The black point of the curve is equivalent to the Lift master wheel, which is why you were 
able to retrieve the crushed details in the shadows. By dragging the center of the curve, 
you were impacting the gamma range, which targets a very different range of luminance.

TIP You can set the Curves palette histogram to react to your node 
adjustments as you make them. To do so, open the Curves palette options 
menu in the upper-right of the palette and choose Histograms > Output. 
The histogram now represents the outgoing RGB signal of the node instead 
of the input. 

This is a useful feature if you need to consistently reach certain ranges while 
grading (such as when matching clips) but bear in mind that it is a processor-
intensive setting, and the histogram will no longer represent the active video 
signal as soon as you make your first change.
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Although you were able to restore the image in this instance and continue using 
the previously crushed shadows, you can imagine how more subtle changes to 
the brightness and contrast of an image in early nodes can impact the quality of 
adjustments made to the shadows and highlights in later nodes.

It’s important to keep in mind the potential of destructive grades. As a rule, balancing, 
matching, and secondary grades should come before bold contrast adjustments and 
sweeping creative grades. It is far more acceptable to distort and crush data in the 
final nodes because no other nodes rely on them for RGB info.

Breaking Rules to Preserve the Video Signal
In previous chapters, you normalized and balanced images with the intention of 
creating a “clean slate” to color grade. However, the proposed grading workflow 
in the first lesson also came with a word of caution: do not let these steps rigidly 
dictate all your grading. Certain scene compositions require a lateral approach 
that enhances the captured image instead of merely correcting it. Imagine a scene 
in which a cave explorer hears mysterious growling just as her flashlight goes out. 
Would you normalize such footage to the full height of the waveform scope? How 
about a night club scene in which the environment and talent are bathed in red 
light? Would it need to be white balanced?

As you gain experience with color grading, observe when these rules work in 
your favor, and when they work against you. In the following example images, 
a timelapse of the night sky was graded using two separate approaches. The 
first grade used the established grading rules, while the second took a creative 
approach with emphasis on the colors, stars, and tree silhouettes.

Normalizing, balancing, contrast Contrast, saturation, red highlights

With the normalized version, it would be harder to achieve the clean, rich look of 
the second example. The highlights in the Milky Way have been expanded and 
flattened, losing too much detail, and the mild preservation of the hill and trees in 
the foreground was unnecessary, considering how much more dramatic they look 
when silhouetted.
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Impact of Dominant Color Grades 
on Surrounding Nodes
Another consideration when grading is choosing the order in which to apply color changes 
to an image. In this exercise, you will try to create a clip with a distinct blue cast, while 
retaining control over the skin tone in a subject’s face.

1 Reset the grade on clip 05.

2 To save time, a Balance node for this clip has already been created for you. Open 
the gallery and click the Still Albums icon to reveal a side panel with a list of 
available albums.

3 Open the Base grades album.

4 Right-click the INT 5 Balance still and choose Apply Grade.

5 Create a new serial node called Blue Look (node 02).

6 In the Primaries palette, drag the Gain and Gamma wheels toward the blue–cyan 
range to cool down the image, and then counteract the blue dominance in the 
shadows by dragging the Lift wheel slightly toward red.

7 Use the Contrast and Pivot settings to refine the contrast and brighten the upper 
midtones of the image. Aim to create fine shadows on the man’s shirt.
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8 Finally, reduce the Saturation to 40 to remove the blue vibrancy and end up with a 
cold, desaturated image.

This look has a strong, purposeful design. It effectively conveys a somber mood or 
suggests a different point in time in a nonlinear narrative. However, its impact on the 
speaker’s skin tone reduces its effectiveness and could end up tiring the viewer’s eyes.

9 Create a final node (node 3) called Skin Tone.

The man’s face is close in hue to the color of the wall behind him, so using HSL curves 
might not be the most effective choice. A qualifier selection would give you a better 
chance of isolating the skin in this shot.

10 Open the Qualifier palette and drag across the man’s face to grab a sample range.

Due to the RGB signal passing through the Blue Look node, the qualifier is forced to 
work with a very cold, contrasted version of the man’s skin. This is definitely not an 
ideal point in the timeline to be keying or grading skin.



165Recognizing the Importance of Node Order

11 Select the Skin Tone node and press E to extract it from the pipeline.

12 Drag it onto the connection line between nodes 01 (Balance) and 02 (Blue Look).

13 Reset the qualifier on the Skin Tone node and select the skin again. In the Qualifier 
palette, adjust the HSL and Matte Finesse controls to get the best extraction. Remember 
to turn on the Highlight mode in the viewer to best observe the result of the selection.

This time the qualifier gives a much better result.

NOTE The qualifier is actively influenced by the nodes preceding it. Changing 
the hue or brightness of an earlier node at any point of the grading workflow 
will impact the selection (and quality) of the qualifier.

14 Use the Window palette to isolate the selection to the man’s face.
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15 In the viewer, turn off the Highlight mode.

16 Track the motion of his face in the Tracker palette and then return to the start 
of the clip.

17 In the adjustment controls, raise the Sat value of node 02 (Skin Tone) to 60 and drag 
the Offset wheel slightly toward orange.

Overall, the resulting grade is much more acceptable. You were able to derive a clean 
qualifier key for the skin tone and adjust it to act as a chromatic contrast to the blue 
grade. However, because Blue Look is the final node to impact the image before the 
node tree output, you know that the original skin tone hues and luminance range will 
always be tinted blue no matter how much you grade the Skin Tone node.

This exercise demonstrates how you might determine the placement of nodes based on 
your RGB needs. For example, when using a qualifier, you almost always want to process 
the ungraded or balanced version of the image, free of any severe color or contrast impact.

In the upcoming exercises, you’ll see examples of how you can derive primary and 
secondary grades from the same point in the node pipeline and recombine them with the 
help of mixer nodes.
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Creating Separate 
Processing Pipelines with 
a Parallel Mixer Node
Mixer nodes allow you to combine multiple nodes into a single RGB output. The two mixer 
node types, parallel and layer, have identical structures but process the incoming node 
data differently.

The parallel mixer combines grades by blending them to an equal degree. The result 
appears similar to working on a linear node pipeline with the main difference being that 
nodes can extract RGB data from the same point in the node tree.

1 In the Airplanes – 01 HQ Timeline, select clip 05.

You will continue to work with the grade you constructed in the previous exercise. 
This time, the Blue Look and Skin Tone nodes will be placed alongside one another for 
optimal routing of the RGB signal between them.

2 Right-click node 03 (Blue Look) and choose Add Node > Add Parallel or press Option-P 
(macOS) or Alt-P (Windows) to add a parallel mixer node.

A new corrector node (node 04) is created, as well as a parallel mixer node that 
combines the RGB outputs of the two nodes before it.

3 To reuse the qualifier selection of the skin tone, you can select node 02 (Skin Tone) and 
press Command-C (macOS) or Ctrl-C (Windows) to copy the node data.

4 Select node 04, and press Command-V (macOS) or Ctrl-V (Windows) to paste the Skin 
Tone data.

5 With the qualifier copied, you can delete the old node 02 (Skin Tone) by selecting it and 
pressing the Delete or Backspace key.

You now have a node structure in which both the Blue Look and Skin Tone nodes are 
using the same RGB data from the optimal Balance node. Their respective grades are 
combined in the parallel mixer node, which sends a single RGB connection to the node 
tree output.
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In the viewer, you should notice only a subtle change in the skin tone. In the linear 
version of the grade, the Blue Look node casts a blue veneer over the frame, resulting 
in a slightly green tint to the skin where the blue combined with the warmer tones. 
This is particularly evident in the shadows under the man’s chin and the highlights on 
the left side of his face. In the mixer version of the grade, this blue/green tint has been 
bypassed, resulting in neutral shadows and a more natural skin tone. If the skin tone 
still appears too dramatic in your clip, you can select the Skin Tone node and reduce 
the Sat value in the Primaries palette or drag the Offset color wheel control point 
closer to the center.

Skin tone adjustment using linear nodes (left)  
and mixer nodes (right)

The parallel mixer is perfect for organic or natural-looking adjustments such as when 
performing skin tone correction or when subtly pushing colors into a scene based on 
tonal range (i.e., creating warm shadows or magenta highlights).
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Morphing Mixer Nodes
An alternative to the parallel mixer is the layer mixer node. Over the next few exercises, 
you will explore the differences between the two in more detail. In the meantime, you will 
morph the current clip’s parallel mixer into a layer mixer node to see the impact it will have 
on the image.

1 Select clip 05 in the Airplanes – 01 HQ Timeline.

2 In the Node Editor, right-click the parallel mixer node and choose “Morph into Layer 
Mixer Node.”

This change has a jarring effect on the image. The skin tone now appears far less 
realistic, and the edge around the face is harsh and solid. This is because node 03 (Skin 
Tone) is being treated as an RGB image layer. The keyed face has 100% opacity and is 
overlaid onto the node 02 (Blue Look) image underneath.

In its current state, the grade is unusable. However, by adjusting the opacity of the 
Skin Tone layer, you can still blend it into the Blue Look layer.

3 Select node 03 (Skin Tone).

4 In the central palettes, open the Key palette.

5 Enter the Key Output Gain as 0.300 to reduce the opacity of the skin tone node.
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The face now blends much more naturally into the blue background node. However, 
note that the result is not identical to that of the parallel mixer version. If you were to 
compare the two grades, you would see that there is less contrast in the layer mixer 
composite, as evidenced by the less pronounced highlights on the side of the man’s 
face. This is neither a good thing nor a bad thing; it merely demonstrates that the two 
mixers have different methods of combining nodes.

After switching between the two nodes and seeing how differently they affect an image, 
let’s take a closer look at how these mixers operate. Understanding their operations will 
help you determine when to choose one mixer over another.

Visualizing Mixer Nodes
A simple way to familiarize yourself with how mixers operate is to create a basic RGB 
graphic setup that will clearly display the relationship between the nodes.

First, you will need a plain grayscale background.

1 Enter the edit page.

2 Open the Effects Library by clicking the icon in the interface toolbar at the top 
of the page.

3 Inside Toolbox > Generators, locate the Grey Scale generator.
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4 Drag the Grey Scale generator to the end of the timeline.

To work on the generator in the color page, you must first transform it into a 
compound clip so that it can take on video properties.

5 In the timeline, right-click the generator and choose New Compound Clip.

6 Name the compound clip Grey Scale.

7 Enter the color page.

8 With the Grey Scale clip (clip 12) selected, create a new serial node.

9 Right-click node 02 and choose Add Node > Add Layer or press Option-L (macOS) 
or Alt-L (Windows) to add a layer mixer node.

10 With node 02 still selected, create another layer node to produce a stack of three 
layer nodes.
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11 Label the nodes (from top to bottom) Red, Green, and Blue.

12 Select the Blue node at the bottom of the stack.

13 In the central palettes, open the Window palette, and click the circle button to create a 
circular window.

14 Open the RGB Mixer palette and make the circle blue by dragging up the B bar of the 
Blue Output.

15 Move the circle window to the lower right of the viewer. Your goal is to create three 
intersecting circles (red, green, and blue).

16 Select the Green node and create a circle window in it.

17 In the RGB Mixer palette, make the circle green by dragging up the G bar of the 
Green Output.
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18 Move the Green node window to the lower left of the viewer.

19 Finally, create a red circle in the Red node. Turn it red using the RGB Mixer and move 
it to the top.

The result demonstrates how nodes interact when combined in a layer mixer node. 
Their behaviors are reminiscent of layer-based systems in which the upmost RGB input 
of the layer mixer constitutes the lowest layer and is compounded by each subsequent 
RGB input. The default status of the nodes is to have full opacity until a Power Window, 
qualifier, or other secondary tool introduces transparency.

20 Right-click the layer mixer node and hover your mouse pointer over the blending 
options in the Composite Mode submenu.

TIP If you do not see a preview of the blending options in the viewer while 
you are hovering over them, go to the gallery panel options menu and enable 
Live Preview.

Doing so allows you to preview how the colors of the nodes interact under the 
different hue and luminance blending methods. Note that all the top nodes are 
blended into the bottom layer (Red), which remains at full opacity.

21 Select Lighten to apply the composite mode.
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22 To remove the color blending, return to the Composite Mode submenu and 
choose Normal.

Next, you’ll change the order of the node layers.

23 Move your mouse pointer over the connection line between the Red node and the 
layer mixer until you see a blue highlight. Drag the connection to the bottom input of 
the layer mixer to change the Red node order and disconnect the Blue node from the 
layer mixer.

24 Drag the RGB output of the Blue node to the top input of the layer mixer.

The red circle now overlaps the green and blue. This further demonstrates how the 
RGB input order in the mixer node works. Additionally, it emphasizes that the physical 
location of the nodes in the Node Editor has no impact on the grade and the final 
results in the viewer.

25 To compare the interaction of the color circles in the parallel mixer, right-click the layer 
mixer node and choose Morph into Parallel Node.

This operation changes the behavior of the three circles. Instead of displaying the 
layers at full opacity, it blends them equally into one another.
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NOTE By default, the RGB Mixer preserves image luminance, which results in 
a neutral gray in the area where the three circles intersect. Deselect Preserve 
Luminance in the RGB Mixer palette (in all three nodes) for the channels to 
compound their signal strength, resulting in pure white where the three 
channels overlap.

The composite blending options in layer mixer nodes can produce very dynamic looks. 
You can use them to emphasize certain areas of a scene, imitate lighting effects, or even to 
compile graphic design elements.

Compositing Color Effects 
with the Layer Mixer Node
In this exercise, you will use a layer mixer to construct an image that has several secondary 
grading needs. Unlike the interview example, the focus is not on seamlessly blending the 
colors of the image into each other but to work on each distinct element separately.

1 Select clip 08 in the Airplanes – 01 HQ Timeline.

In the previous lesson, the offline reference clip indicated that the water in this shot 
needed to be blue.

2 In the viewer, drag the playhead closer to the end of the clip to better see the plane 
against the water.

3 The end of clip 08 is in mid-dissolve with clip 09. To disable transitions and effects 
that are on the edit page timeline, click the Unmix button in the lower-left corner of 
the viewer.

4 To bring up the reference video in the color page, right-click the viewer and select 
Reference Mode > Offline. Doing so will adjust the Image Wipe mode to use the 
reference clip associated with the timeline instead of the gallery stills.
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5 In the upper-left corner of the viewer, click the Image Wipe icon to compare the 
current clip to the one in the reference video.

You have several ways of approaching this secondary grade. You could use HSL curves 
or the qualifier, together with the RGB mixer, color wheels, or custom curves. When 
confronted with a specific grade problem, it is common to cycle through several 
options until you find the optimal grading solution. In this instance, you will use a 
combination of techniques, including the 3D qualifier and custom curves.

6 In the Gallery panel, from the Base grades album, apply the 1.8.1 Balance still to 
normalize and balance clip 08.

7 Create a second node and label it Blue Water. You will use this node to turn the image 
blue with a focus on getting the correct hue in the water.

8 In the Primaries palette, drag the Hue adjustment control (20.00) until the water 
turns blue.

9 Create contrast in the image using the Y channel of the custom Curves palette. Aim to 
make the shadow of the plane the darkest element in the frame and ensure that the 
sky reflected in the water in the top half of the frame stands out against the rest of 
the water. 

NOTE Dragging down the lower midtones of a curve and dragging up the 
upper midtones will always increase contrast in an image. In the industry, this 
is known as an S-curve, and it is utilized both during corrective workflows and 
during creative grading.
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10 Drag the Gain color wheel to neutralize the clouds reflected in the water. Bear in mind 
that you have just rotated the hues in the palette, so you will need to drag toward 
green to add blue to the image highlights.

11 If needed, reduce the saturation until the water begins to look more natural to the eye.

Note that the plane will also be affected by these grade changes. This is acceptable 
because in subsequent layer nodes you will extract the plane and grade it separately.

12 Press Option-L (macOS) or Alt-L (Windows) to add a layer mixer and a new node 
(node 04). Label the new node Yellow Plane.

13 Open the Qualifier palette and, in the upper-right corner, change the mode from 
HSL to 3D.

This is the recommended qualifier mode for chroma key work because of its ability 
to intuitively predict hue and shadow fluctuations found on green screens. It even 
features a despill parameter for removing chroma spill from performers.
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14 In the viewer, drag the qualifier across the green water to make a selection. Start with 
a broad stroke that covers a good range of green hues 

15 Enable Highlight mode in the viewer and change it to B/W mode to review the result of 
the initial selection.

To get a more accurate result, you will add more strokes to build a reliable color 
reference.

16 Drag the playhead through the clip and stop when you see areas with insufficiently 
selected water.

17 Select Picker Add in the Qualifier palette.

18 Drag in the viewer to add more strokes. 

Before After
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Every time you create a stroke, a swatch is placed in the 3D qualifier list to document 
the hues that are being sampled for the key.

19 When finished, adjust the Matte Finesse controls to cover up any remaining 
unselected areas.

20 In the Qualifier palette, click the Invert button to focus the selection on the plane 
instead of the water.

21 In the viewer, disable the Highlight mode.

22 In the Qualifier palette, to the right of the Invert button, deselect Show Paths to hide 
the selection lines.

You have successfully extracted the plane and now have full control over its 
RGB values.

23 In the adjustment controls of the Primaries palette, decrease the saturation (40.00) of 
the plane until it looks more natural.
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24 Drag the Gain color wheel toward orange if you wish to tone down the plane’s 
lemon hue.

25 Create an S-curve in the Y channel of the custom Curves palette to enhance the 
contrast and detail on the plane.

Using Key Inputs and Outputs to 
Share Matte Data Across Nodes
The key inputs and outputs allow you to reuse node mattes and further adjust them in the 
receiving node.

In this blue water exercise, you have not yet addressed a remaining component of the 
composite: the flamingos at the end of the clip. In the reference video, the flamingos in 
the upper-right corner of the shot are graded pink. In the current grade, the birds look 
desaturated and flat. Because you have already keyed-out the green water in the Yellow 
Plane node, it will be enough to reuse its key data and add a Power Window to isolate the 
focus onto the birds in the corner.

1 In clip 08, click the Yellow Plane node.

2 Press Option-L (macOS) or Alt-L (Windows) to create a new layer node, and label it 
Flamingos.
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3 To reuse the matte data of the keyed Yellow Plane node, drag the key output square of 
the Yellow Plane node toward the key input triangle of the Flamingos node.

4 Scrub to the end of the video until you see the area that the flamingos occupy in 
the frame.

To isolate the matte to include just the birds, you will use a curve window.

5 Open the Window palette and click the Curve window button. Label it 
Flamingos Matte.

6 Click around the perimeter of the flamingos in the image. Remember to click the first 
point again as the final step to close the loop and generate a shape.
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The birds appear in the shot only toward the end, so you will perform a rudimentary 
animation of the window across the screen as the shot progresses. A simple way to 
animate windows in the color page is by using the Frame mode of the Tracker palette.

7 Open the Tracker palette and switch the mode to Frame.

8 Click the diamond-shape in the center of the keyframe controls in the upper-right 
corner of the Tracker graph.

Doing so places a keyframe for the current position of the curve window.

9 Drag the playhead left until the birds are offscreen, and then drag the curve window 
in their direction outside the viewer. The Tracker graph automatically places a second 
keyframe, and an animation is generated between the two.

The Tracker graph reveals some additional frames at the end of the clip. This is the 
content of the clip used in the transition with clip 09. 

10 Drag the playhead to the end of the tracker graph and further refine the shape and 
placement of the window.

Finally, there is also a default frame in the Tracker graph at the start of the clip. 

11 Use the keyframe controls to jump to the start of the clip and move the window 
offscreen.

12 Scrub through the clip timeline to ensure that the window is following the 
birds’ movement.

You can now make the necessary grade adjustments to enhance the birds’ pink color.

13 Drag the Gain master wheel left to darken the birds slightly.
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14 Drag the Gain color wheel toward magenta to turn the birds pink.

To simplify your pipeline and prepare it for further grading nodes, you can combine all 
the layer mixer nodes into a single compound node.

15 Drag in the Node Editor to select all the nodes except the Balance node.

You now can press Command-D (macOS) or Ctrl-D (Windows) to quickly disable and 
evaluate the selected nodes without affecting the Balance node.
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16 With all the nodes enabled, right-click any selected node and choose Create 
Compound Node.

This step is an effective organizational tool when working on clips with large node 
tree structures. And you can still disable the compound node to bypass the color 
composites without affecting the Balance node.

You also still have access to the original layer mixer structure within the 
compound node.

17 Right-click and choose Show Compound Node.

18 To navigate back to the main Node Editor, click Project 02 – Age of Airplanes Trailer in 
the path control at the bottom of the panel.

19 If you want to bring back the original node structure of the compound node, right-click 
it and choose Decompose Compound Node.

TIP Another method for decluttering the Node Editor is to hide node thumbnails. 
In the upper-right corner of the Node Editor, click the options menu and deselect 
Show Thumbnails. Doing so will collapse the nodes to just their labels, numbers, 
and palette icons.

The exercises in this lesson gave you an overview of the potential of the Node Editor. 
Although you’ve practiced a variety of possible workflows, there is ultimately no single 
correct way to utilize nodes when grading. Continue to practice using nodes for more 
advanced grading, and you will soon arrive at your own preferred style. Above all, aim for 
the dual goals of workflow efficiency and the preservation of image quality.
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Check Your Work 
When you’ve completed these lessons, you can open Project 02 – Age of  
Airplanes Trailer COMPLETED.drp to compare your work with the finished 
version of this timeline, Airplanes - 03 HQ Timeline COMPLETED. If the media 
appears offline, click the red Relink Media button in the upper-left corner of the 
media pool and specify the location of the Project 02 media on your workstation.

Lesson Review
1 Can a corrector node have multiple RGB inputs?

2 What are the blue symbols on either side of a node?

3 True or false? A node key can be connected to the input of a node that is in the same 
parallel or layer mixer stack.

4 In the Key palette, what does the Key Output Gain affect?

5 True or false? You can add additional RGB inputs to mixer nodes.
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Answers
1 No. A corrector node can have only a single RGB input, though it can have multiple 

RGB (and key) outputs.

2 The blue symbols represent the key input and key output.

3 True. A node output (both RGB and key) can be connected to any other input further 
down the pipeline, as well as to other nodes in a mixer stack.

4 Key Output Gain affects the opacity of a selected node.

5 True. Right-click a mixer node to add more inputs or drag a connection line over a 
mixer node to automatically generate a new input.
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Lesson 6

Managing Grades 
Across Clips and 
Timelines
Grading a film or video project requires 
a considerable level of attention to 
detail and the use of a variety of 
tools throughout both primary and 
secondary stages. However, once a look 
is established, a project often makes 
repeated use of existing grades that 
propagate throughout the timeline. An 
obvious example of this is when you’re 
working on multiple clips that came 
from the same source file, or clips used 
from different takes of the same scene.

DaVinci Resolve 18 features a wide variety 
of workflows that help reproduce and 
refine grades across clips. These include 
a straightforward copy and paste, 
extraction of individual nodes for isolated 
adjustments, and even the migration 
of grades across whole timelines. In 
this lesson, you’ll examine the workflows 
that will enable you to efficiently copy 
and manage grades within a single clip, 
timeline, project, and beyond.
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Copying Grades from 
Clips and Stills
When copying grade data across clips or stills, you copy the entire node pipeline of the 
original clip. This pipeline includes all primary grading adjustments, secondary selections, 
mixers, and compound nodes. Because secondary selections tend to be specific to the clip 
they were generated on, you must double-check and adjust them before continuing with 
your grade.

In the previous lesson, you applied a grade from a still in the gallery. You can perform the 
same action using clips in the timeline.

1 Open the Project 02 - Age of Airplanes Trailer.

2 Enter the color page.

3 In the Airplanes - 01 HQ Timeline, selected clip 06. Selected clips are always the target 
when copying grading data.

4 Right-click clip 05 and choose Apply Grade. 

The node pipeline from the clip 05 interview clip is copied to the selected clip 06, 
overwriting any previous nodes. The clip-specific face tracking in the Skin Tone node 
was not migrated, giving you the opportunity to perform a track of the new face 
motion in clip 06. However, if you ever want to copy track data across clips, in the 
Tracker palette options menu, you can choose Copy Track Data and Paste Track Data as 
you navigate from the source node to the target node.

Another useful tip when copying grades between clips and stills is to use your middle 
mouse button, if available.

5 Select clip 04.

6 In the gallery, open the Base grades album. 

7 Middle-click the 1.4.1. Balance still.

This simple motion transfers the still’s balance grade to clip 04.

In the next exercise, you will build upon the grade in clip 04 and start to experiment with 
different looks using local grade versions.
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Working with Local Versions
Versions enable you to associate multiple grades with a single clip in a timeline. You 
can use versions to preserve a grade at earlier stages of the grading process or when 
creating a series of shot-grading options to share with a creative supervisor for selection 
and approval. Each version remains intact and can be recalled when needed. Versions 
are easily accessible in the contextual menu of each clip and can be created, deleted, 
bypassed, and switched between local and remote.

In this exercise, you will begin by creating a new grade on a clip, after which you’ll apply 
preexisting grades from the gallery to quickly build a set of local versions.

1 In the Airplanes - 01 HQ Timeline, continue to work on clip 04.

2 For a better representation of the clip’s content, drag the playhead to the middle of the 
clip where the plane is in view.

3 Create a second node and label it Cross Process.

TIP Double-click repeatedly under a clip thumbnail to change the metadata on 
display. You can opt to see the media codec, clip name, or version label (local 
version 1 will always appear blank).
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4 Open the Curves palette. To create a cross-process look, you will want to push 
opposing complementary colors into the image highlights and shadows. This tends to 
result in a retro film camera look.

5 Click the YRGB link to ungang the channels.

6 Isolate the blue channel and drag the black point up to turn the shadows blue. Then 
drag the white point down to turn the highlights yellow.

7 Isolate the red channel, create a new control point in the upper midtones, and drag 
upward to add a slight red tint to the highlights and midtones.

8 Create a new serial node 03 and label it Contrast.

9 In the Primaries palette, increase contrast by darkening the shadows using the Lift 
master wheel (-0.02).

10 In the adjustment controls at the top, increase midtone detail (50.00) to sharpen the 
detail in the underwater reefs.

You have now successfully created the first look for this shot. By default, every clip 
begins as Local Version 1. You can rename clip versions to identify a specific look or 
purpose of a grade.

11 In the timeline, right-click the clip 04 thumbnail, and under Local Versions, choose 
Version 1 > Rename.

12 In the Version Name dialog, enter the name Cross process and click OK.
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You will apply several grades to this clip, each of which will be designated as a new local 
version. To save time, you will use the preexisting grades in the Clip 04 grades album 
of the gallery.

13 Right-click clip 04 and choose Local Versions > Create New Version. 

Enter the name Bleach bypass.

14 Reset the cross-process grade by choosing Color > Reset > All Grades and Nodes or 
press Command-Home (macOS) or Ctrl-Home (Windows).

This is a necessary step if you want to start with an ungraded clip every time you 
design a new look. Otherwise, you can continue tweaking the image using the 
previous grade’s settings.

15 In the Clip 04 grades album, middle-click the 1.4.2. Bleach bypass still to apply 
the grade.

TIP When you hover over stills in the gallery, a preview of their grades will 
appear over the clip in the viewer. To disable or change Live Preview behavior, 
click the three-dot (ellipsis) options menu in the upper-right corner of the 
gallery. Select Live Preview to disable it or move your mouse pointer over Hover 
Scrub Preview to choose if the image will scrub in the Thumbnail and Viewer, 
Thumbnail only, or neither.

16 To make another version, right-click clip 04 again and choose Local Versions > Create 
New Version. Enter the name Simple pop.

You could reset the grade again, but because you are simply overwriting the current 
grade with the still grade, that won’t be necessary.

17 In the Clip 04 grades album, middle-click the 1.4.3. Simple Pop still to apply the grade.

18 Right-click clip 04 and choose Local Versions > Create New Version. Enter the name 
Navy blue.

TIP You can also press Command-Y (macOS) or Ctrl-Y (Windows) to create a 
new version in a clip.
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19 In the Clip 04 grades album, middle-click the 1.4.4. Navy blue still to apply the grade.

Having created a series of versions, you can now compare them in the viewer using the 
split-screen display.

20 In the upper-left corner of the viewer, between the Image Wipe and Highlight buttons, 
click the Split Screen button.

21 In the upper-right corner of the viewer, make sure Version is selected.

The split-screen view is enabled, displaying all four grades in a grid.

Comparing the versions might be difficult now because they have been scaled down 
to fit the small viewer window. You can resize the viewer for full-screen playback and 
optimal viewing.

22 Choose Workspace > Viewer Mode > Cinema Viewer or press Command-F (macOS) or 
Ctrl-F (Windows).
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In the next few exercises, you will apply the cross-process look to other clips in 
the timeline.

23 In the upper-left corner of the split-screen view, double-click the “Cross process” 
version to select it.

24 Press Esc to exit the full-screen mode.

25 Right-click in the viewer and choose Split Screen > On/Off to disable the split-screen 
view or click the Split Screen button in the upper-left corner of the viewer.

TIP Press Command-B or Command-N (macOS) or Ctrl-B or Ctrl-N (Windows) to 
cycle through the versions of a clip in the viewer.

Remote Versions
In the contextual menu, under the Local Versions options, you might have noticed 
a similar section for Remote Versions. This area offers another method of retaining 
multiple grades in a clip.

Remote versions are different from local versions in two ways: first, when a clip is 
graded within a remote version, its grade affects all other timeline clips derived 
from the same source media; second, the grade appears on all subsequent uses of 
the source clip in all other timelines of the active project (provided that the clips in 
those timelines are also set to use remote versions).

One popular application for remote version grading is when working with 
master timelines. After importing the footage from a shoot, you can place all 
the media on a remote timeline and apply preliminary grades to the clips. When 
you eventually create a cut in the edit page or import the editor’s timeline, those 
remote grades will automatically transfer to the new remote timeline, saving 
you time with the grade. You can then use the clip timeline’s contextual menu to 
Copy Remote Grades to Local and continue to grade locally without affecting the 
master timeline.

In short, local-version grades are applied on a timeline basis, whereas remote 
versions are applied on a project basis.
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Appending Grades and Nodes
In the previous exercise, you applied still grades to a clip by choosing the Apply Grade 
contextual menu option or by pressing the middle button of your mouse. Doing so 
overwrites the existing grade on a clip and replaces it with the entire node tree of the 
copied grade. At times, you will want to add the node tree after a clip has undergone 
balancing or matching or apply just portions of a node tree.

The following exercises show you how to be selective when copying grades.

1 Select clip 02 on the Airplanes – 01 HQ Timeline. You will apply the previously created 
cross-process grade to this clip.

Clip 02 is currently unbalanced with a strong yellow tint. You could normalize and 
balance it, but that would not necessarily optimize it for the cross-process grade. 
As you learned in Lesson 2, clips must be matched to share grade data accurately. 
Without matching, grading tools will behave less predictably, and the differences 
between the clips will be preserved even if the same creative grades are applied.

To save time, a match grade for this clip has already been created for you.

2 Open the Base grades album and apply the 1.2.1. Match still to the clip. To match clip 
04 more closely, the clip has been brightened and cooled.

3 Open the Clip 04 grades album.

A cross-process grade is already prepared and stored in the gallery. If you directly apply 
the cross-process still from the gallery, it will overwrite the Match node you just applied 
to the clip. Instead, you will append the cross-process grade to the current node graph.
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4 Right-click the 1.4.1 Cross process still and choose Append Node Graph.

TIP You can also drag a still from the gallery onto a connection line in the node 
graph to append it to an existing grade.

Clip 02 now has its original Match node followed by the Cross Process pipeline. 
However, the grade still does not look right. By appending the grade, you added all the 
nodes from the original cross-process grade, including the original Balance node that 
was created specifically for clip 04. That node does not work in the context of clip 02 
and should be deleted.

5 Select node 02 (Balance) and press the Delete or Backspace key.

You now have a clean cross-process look on the second airplane shot that more closely 
resembles the one in clip 04. Next, you’ll apply this same look to a third shot but 
without the Balance or Contrast nodes.

TIP Window tracking data is reset when applying grades from stills in the 
gallery, which allows you to run new tracks based on the unique content of 
each clip. However, when appending nodes, window tracking data is retained.
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Copying Individual Nodes from a Still
So far, you’ve used all the grading data stored within the stills. You copied and appended 
an entire node pipeline to the Node Editor and tweaked the nodes based on the 
clips’ needs.

However, you also have access to a still’s node graph while it is still in the gallery, as well as 
to a clip’s node graph while it is still in the timeline. This allows you to apply very specific 
adjustments from a saved or existing grade.

1 Select clip 03 on the Airplanes – 01 HQ Timeline.

This clip looks relatively neutral but is distinctly different from the starting looks of 
clips 02 and 04. As in the previous exercise, you will apply a match still to prepare it 
for the cross-process look.

2 Open the Base grades album and apply the 1.3.1. Match and Contrast still to the clip.

Doing so significantly alters the look of the clip, but it is vital for ensuring a good base 
for the incoming grade. The Match node is there to mimic the brightness and coolness 
of clip 04, while the Contrast node addresses the stark difference in location and shot 
angle to match the final luminance ranges of clips 02 and 04 more closely.

You can now proceed to apply the cross-process grade. Because the clip is balanced 
and already has correct contrast, you need only transfer the Cross Process node itself.
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3 Open the Clip 04 grades album, right-click the 1.4.1 Cross process still, and choose 
Display Node Graph.

The node graph appears in a separate window with the node pipeline of the grade as it 
appeared in the Node Editor when the still was generated. To the right of the window, 
you can choose to isolate and apply only the color or sizing adjustments (PTZR: pan, 
tilt, zoom, rotation) of the entire clip. Tabs at the top allow you to switch to a node-
based refinement of the parameters that will be included when copying node data.

4 From the still’s node graph window, drag node 02 (Cross Process) to the Node Editor 
of clip 03 and position it over the connection line between node 01 (Match) and 
node 02 (Contrast).

A + (plus sign) will appear over the line to signify that you can release the mouse 
button and attach the Cross Process node between Match and Contrast nodes.

5 In the still’s node graph window, click Close.

Having access to the node structure of every still facilitates cleaner, more precise copying 
workflows. You can separate the primary balance and match nodes from the contrast and 
creative-look nodes and copy only what is necessary for every new clip grade. As with all 
grading, you should tweak and refine the grades to ensure maximum visual quality and 
color consistency.
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Shared Nodes
In this exercise, you copied the same cross-process look across three clips while 
retaining their individual balance and contrast adjustments. Should you decide 
to tweak the creative look of the sequence, you might find the task of copying 
the grade across the clips very time-consuming. Shared nodes are a grading 
optimization function that allows you to link and lock a single node across 
multiple clips. 

To turn a standard corrector node into a shared node, right-click the node and 
choose Save as Shared Node. Two blue arrows indicate the node’s new status and 
a lock symbol in the lower-right corner prevents unwanted changes from being 
made to the grade. Label shared nodes the same way you would regular nodes. 
When you right-click and choose Add Node in the Node Editor of any clip in the 
current project, you will now see the shared node at the bottom of the node list. 

This method allows you to quickly migrate grades between  
clips, and even make universal tweaks by disabling Lock 
Node in the shared node’s contextual menu. Note that 
because the undo function is stacked per clip in the color 
page, changes to individual shared nodes cannot 
be undone.

Saving Grades for Other Projects
The stills contained in the gallery albums of the color page will ordinarily be accessible only 
in the active project. A different kind of gallery album, the PowerGrade album, makes stills 
accessible to all other projects generated by the user in the same project library.

1 In the Still Albums list of the gallery, open the Clip 04 grades album.

2 Hold Command (macOS) or Ctrl (Windows) and drag the 1.4.1. Bleach bypass still to 
the PowerGrade 1 album near the bottom of the album list.

TIP Dragging stills between albums moves them, meaning that the source 
album will no longer contain the original still. Holding Command (macOS) or 
Ctrl (Windows) while dragging copies stills to the destination album, leaving a 
copy of the original in the source album.



199Saving Grades for Other Projects

3 Click the PowerGrade 1 album to view its contents. A copy of the Bleach bypass still 
will now appear in the PowerGrade 1 album of all projects you create in the same 
project library.

The Gallery panel also has additional features in its expanded version.

4 In the upper-right corner of the gallery, click the Gallery View button.

A separate window opens, displaying the full contents of the gallery.

The Stills panel in the upper left features a collection of DaVinci Resolve looks and 
provides access to stills from other projects and project libraries. The Group Stills 
panel in the upper left displays the contents of the selected project’s gallery.

The bottom of the window shows the current project’s gallery, and to the left of it is the 
Project Memories panel in which you can designate frequently used stills to a separate 
panel and assign shortcuts to them.

TIP To save a still as a memory, drag it from the gallery onto one of the 
memory slots. You can use DaVinci Resolve > Keyboard Customization to assign 
keyboard shortcuts to the memories. When saving memories, use numbers 
that correspond to the letter of the memory as expressed numerically. For 
example, memory B will have the shortcut Option-2 (macOS) or Alt-2 (Windows).
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5 In the lower half of the full Gallery window, select the PowerGrade 1 album.

6 In the DaVinci Resolve Looks list at the top, select the Skin album and drag the 
Diffused still into the PowerGrade 1 album in the Project Stills window below.

You’ve now added one of the preset stills to the gallery and will be able to apply it to 
a clip in the timeline. Because you added it to a PowerGrade album, this still will be 
accessible to all other projects you create in the current project library.

7 Close the Gallery View window.

8 Select clip 07 in Airplanes – 01 HQ Timeline.

9 Open the Base grades album and apply the 1.7.1. Balance still to the clip.

10 Open the PowerGrade 1 album and append the Diffused still to the clip.
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TIP You can double-click a PowerGrade still to append the grade to a selected 
clip on the timeline. Middle-clicking will apply the grade, just like with regular 
album stills.

Outside of using project libraries and PowerGrade albums, you can also share grades 
across different workstations by exporting them from the gallery.

11 In the gallery, open the Clip 04 grades album and right-click the 
1.4.1. Cross process still.

12 In the contextual menu, choose Export.

The still’s visual and grading information is exported and contained in two files. The 
DPX file is a high-quality image format used for comparison and review. The DRX file 
contains the node tree and grading data. You need both files to migrate stills with 
grade information.

NOTE Selecting Export with Display LUT will export the DPX and DRX files in a 
format that is supported by monitoring devices. You can upload these files to 
camera viewers or monitor displays.

13 Indicate a location on your workstation, create a new subfolder for the two files, and 
click Export.
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14 Open a file browser on your computer and locate the two files.

You can share the DPX file as you would any regular image across applications that 
support the format. The DRX file is a DaVinci Resolve exchange file used to carry 
the grading data of a shot and can only be used together with the DPX image file. 
To import a still grade into DaVinci Resolve, both files must be in the same folder or 
directory.

Let’s import a grade that was created for one of the clips on the timeline.

15 Return to the color page, and in the gallery, open the PowerGrade 1 album.

16 Right-click in the Gallery panel and choose Import.

17 In the file browser, locate the BMD 18 CC – Project 02 folder and navigate to 
Other > Stills.

18 Select Punchy film.dpx and click Import.

Note that you only need to import the single DPX file. The DRX file is bound to the DPX 
file, and its grading data will be included upon import.

19 Apply the Punchy film still grade to clip 09 (HAWAIIAN_LANDING.mov) in 
the timeline.
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Here are some additional stills options that colorists employ for organizational and 
practical purposes:

 — Right-click in the viewer and choose Grab All Stills. Doing so will generate a still for 
each clip in the timeline (either from the first or middle frame) and place them in the 
gallery. Colorists use this option to keep track of their grade process over time (day 1 
album, day 2 album, and so on) or to separate the stills based on passes (balance pass 
album, match pass album, secondary pass album, and so on).

 — Right-click in the gallery and choose One Still Per Scene. This choice will restrict 
the number of stills you generate from any given clip to a single still. This option is 
popular among colorists who frequently grab stills of their clips while grading and do 
not want their galleries to become cluttered with thumbnails.

TIP You can create an ungraded (but fully labeled) node pipeline and save it as a 
still to use as a template for future grades.

Copying Timeline Grades 
Using ColorTrace
ColorTrace is a feature in DaVinci Resolve that enables the transfer of grading information 
across timelines. It is a much faster and more organized method of copying mass grade 
data than using stills.

One scenario in which you may use ColorTrace is when multiple project types use the same 
source materials (film, trailer, teaser, behind-the-scenes, and so on). Another scenario is 
when an editor creates changes in a timeline that a colorist has already begun grading. In 
both cases, manually transferring the grades would be a major task: a still would need to 
be generated for each clip and then carefully reapplied to each corresponding clip on the 
new timeline. The workflow would be slow and would have a high potential for error as the 
overworked colorist would have to generate, organize, and retrack dozens (if not hundreds 
or thousands) of stills in the gallery.

ColorTrace bypasses all that by presenting two timelines side-by-side and helping the colorist 
identify where their common media are located. The colorist needs only to accept (or reject) 
that the media is correctly matched, and the grading data is transferred instantaneously.

1 Enter the edit page, and in the media pool, open the Timelines bin.

2 Choose File > Import > Timeline.
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3 Navigate to the Project 02 – Age of Airplanes Trailer folder, open the XML subfolder, 
and select Airplanes – 02 Color Trace.xml. Click Open to import it.

4 In the Load XML window, deselect the option to “Automatically import source clips into 
the media pool” and click OK.

A pop-up window will prompt you to indicate the bins where the timeline’s media 
are contained.

5 Click the disclosure arrows to expand the bin structure and deselect the LQ 
Transcodes bin to ensure that the media is linked only to the high-quality versions of 
the clips. Click OK.

NOTE AERIAL_SFO.mov will appear offline on the timeline because you 
had previously only used the LQ version of this clip. To fix this, go to the 
media page. In the Media Storage library, navigate to BMD 18 CC - Project 
02 > HQ Transcodes and drag the HQ version of AERIAL_SFO.mov into the 
media pool’s HQ Transcodes bin. Remember to set the clip’s Input Color 
Space to Blackmagic Design Film Gen 1 to ensure that it is correctly color 
managed. Then change the clip color to orange to match the rest of the HQ 
timeline media.

The Airplanes - 02 Color Trace edit will appear in the Timeline panel of the edit page. 
The orange color of the clips indicates that they are the high-quality media from the 
HQ Transcodes bin.
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6 Enter the color page to check the grade status of the clips.

None of the grades applied to the Airplanes – 01 HQ Timeline are visible in this 
newly imported timeline. Each clip has a blank Node Editor with only the default 
ungraded node 01.

7 Return to the edit page.

8 In the media pool, right-click the Airplane – 02 Color Trace timeline and choose 
Timelines > ColorTrace > ColorTrace from Timeline.

NOTE The ColorTrace option will only be visible in the contextual menu if the 
timeline you are right-clicking is the active timeline in the edit page.

9 In the ColorTrace Setup’s Project List window, expand the project library folder and 
locate Airplanes – 01 HQ Timeline.
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Effects and Definitions
The Effects and Definitions panel under the Project List enables you to define a set 
of naming conventions for clips whose names have changed between timelines. 

A common example where this may happen is in VFX workflows. Assume that the 
original filenames of two timeline clips were car.mov and sky.mov. Both clips 
were sent to the VFX department for some compositing work. The VFX department 
returns the finished composites under the names car_vfx.mov and sky_vfx.mov, 
and they are inserted into a new version of the timeline. When ColorTrace is used 
to transfer the grading data from the original timeline, the two VFX clips are not 
recognized because of their new filenames. By entering *_vfx in the Effects and 
Definitions panel, DaVinci Resolve can exempt the suffix when associating media 
between timelines.

10 Select the HQ Timeline and click Continue to proceed to the ColorTrace interface.

At the top of the interface, you’ll find tabs for switching between the Automatic and 
Manual modes of the feature.

Automatic attempts to locate the same clips used in both timelines based on source 
name, timecode, and other metadata, regardless of any change in position or trim.

Manual allows you to identify and match clips yourself. Using this method, you can 
assign grades when the original filenames or metadata were changed between edits.

The bottom of the interface provides additional information and control over the copy 
parameters. To the left is a table that compares the metadata of the source and target 
clips, which is useful when comparing the file paths of two clips to ensure that they 
are derived from the same take. To the right is a list of criteria that will be included or 
bypassed during the grade transfer.



207Copying Timeline Grades Using ColorTrace

The clips in the Target Timeline have colored outlines that indicate the grade match 
status of the clips:

 — Green—An exact match was found.

 — Blue—Multiple potential matches were found.

 — Red—No match was found.

You will need to review the Target Timeline to ensure that the matches are accurate 
and any conflicts are resolved.

TIP Select Hide Matching Clips at the bottom of the interface to remove all 
clips that are already matched in the timeline. Doing so will allow you to focus 
on the clips with multiple or no matches.

11 Clip 01 on the Target Timeline has a blue outline. Select it to see which clips are 
proposed as possible options in the Matching Source Clips list above it.

Clip 01 clearly corresponds to the clip numbered as 09 in the Matching Source Clips 
window. You can verify this by looking at the table at the bottom of the ColorTrace 
interface and checking the Name property of the source and target clips.

12 Double-click clip 09 to confirm the match. Both clips’ outlines will turn magenta to 
confirm the selection.

13 Clip 02 also has a blue outline. Select it and double-click the corresponding clip 08 
above to confirm the correct match.
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14 Clips 03, 08 and 09 have red outlines and offer no options in the Matching Source Clips 
list. You will address these clips manually after confirming the automatic matches.

NOTE You can choose Set As New Shot to identify clips with no links to the 
original timeline. They will appear ungraded after the ColorTrace is performed.

15 At the bottom of the window, click Copy Grade to transfer the grade data between the 
green and magenta clips.

16 To resolve the red clips, click the Manual tab at the top of the window.

17 In the Target Timeline, select clip 03.

The source timeline does not feature this clip. However, it is extremely similar to clip 02, 
which features a wider shot from the same camera.

18 In the source timeline, select clip 02 and click Paste to confirm the grade transfer.

The final clips (08 and 09) have no corresponding grades in the source clips timeline 
and can be left as they are.

19 Click Done to exit the ColorTrace interface.

20 Enter the color page to verify that all the clips that were graded in the 01 HQ Timeline 
were successfully copied to the 02 Color Trace timeline.

NOTE Keying and tracking data is preserved when copying grades using 
ColorTrace. Check clip 06 in the 02 Color Trace timeline to verify that the 
qualifier selection and window track successfully traveled to this new instance 
of the interview clip.



209Copying Grades Using the Timelines Album

Just as migrating timelines requires conforming, the ColorTrace function also calls for some 
manual review to ensure that all grades have transferred correctly. Regardless, ColorTrace 
still substantially reduces your workload by managing most of the color migration process.

Copying Grades Using 
the Timelines Album
One of the quickest ways to transfer a grade between clips in different timelines is by using 
the Timelines album in the gallery.

In the previous exercise, one clip in the Airplanes – 02 Color Trace timeline remained 
ungraded because its counterpart in the 01 HQ Timeline was also ungraded. In this 
exercise, you will perform a quick grade on the remaining clip and transfer it to the original 
timeline using the Timelines album.

1 In the Airplanes – 02 Color Trace timeline, select clip 08.

2 In the Curves palette, ungang the channels and adjust the R and B curves to give the 
nighttime footage a deep blue tone with orange highlights.

3 In the Primaries palette, use the master wheels to establish a dynamic contrast 
between the dark foreground and well-lit horizon. Increase the midtone detail to 
sharpen the light sources in the city.

Before After

4 Use the pop-up menu above the viewer to return to the Airplanes – 01 HQ Timeline.

5 In the gallery’s Still Albums side panel, click the Timelines album.
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6 Use the pop-up menu at the top to switch the gallery to the Airplanes – 02 Color 
Trace stills.

The gallery now displays the current state of all the clips in the 02 Color Trace timeline. 
Note that even the ungraded credits clip is included. This behavior helps you keep 
track of both graded and ungraded clips in various timelines.

7 In the Airplanes – 01 HQ Timeline, select clip 10.

8 In the gallery, middle-click clip 08 to transfer the graded night sky look.

The exercises in this lesson presented a broader list of options for grade setup and 
duplication. When copying grade data, it’s important to consider your needs on a project-
by-project basis. In most cases, a combination of one or more of these copying methods 
is ideal; in other cases, a mix of methods could be less efficient than employing a more 
broad-based solution such as ColorTrace or remote versions.

Self-Guided Exercise
Complete the following exercises in the Airplanes – 01 HQ Timeline to test your 
understanding of the tools and workflows covered in this lesson.

Clip 01—Match this darker interview shot to the one in clip 05. Begin by disabling the 
Blue Look and Skin Tone mixer nodes in clip 05 and then apply a venetian blind wipe in 
the viewer to accurately assess and match the walls and subject skin tone in clip 01. Then, 
use any of the methods covered in these lessons to transfer the remainder of the node 
tree after the Match node. Ensure that the face window is tracked to the unique head 
movements in clip 01.
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Clip 07—Create a remote grade link between clip 07 in the 01 HQ Timeline and clip 07 in 
the 02 Color Trace timeline. Begin by reading the documentation about remote grading 
at the end of the “Working with Local Versions” exercise. In the 01 HQ Timeline, right-click 
clip 07, and under Remote Versions, choose Version 1 > Load. Apply the Base grades album 
balance node and then create a new serial node and develop a new bright and warm look 
for the shot. Open the 02 Color Trace timeline and load remote grade Version 1 on clip 07. 
The new look you created should automatically appear on the clip.

When you’ve completed these lessons, you can open Project 02 – Age of Airplanes  
Trailer COMPLETED.drp to compare your work with Airplanes - 03 HQ Timeline 
COMPLETED and Airplanes – 04 Color Trace COMPLETED. If the media appears offline, 
click the red Relink Media button in the upper-left corner of the media pool and specify 
the location of the Project 02 media on your workstation.

Lesson Review
1 How do you create a new local version of a grade?

2 Which shortcut resets a clip’s entire grade?

3 How can you access stills saved in other projects and project libraries?

4 How do you copy just one node from the node tree of a still in the gallery?

5 True or false? You can create keyboard shortcuts for your favorite grades and stills.
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Answers
1 Right-click and choose Local Versions > Create New Version or press Command-Y 

(macOS) or Ctrl-Y (Windows).

2 Command-Home (macOS) or Ctrl-Home (Windows) resets a clip’s entire grade.

3 To access the galleries of other project and project libraries, click the Gallery View 
button to launch the expanded gallery.

4 To access the node tree of any still in the gallery (or any clip in the timeline), right-click 
the thumbnail and choose Display Node Graph. Then drag the necessary node into the 
Node Editor of the active clip.

5 True. You can create keyboard shortcuts for grades in the form of Project Memories.



Part III

Optimizing the 
Grading Workflow
Lessons

 — Using Groups 

 — Adjusting Image Properties

 — Setting Up Raw Projects

 — Delivering Projects

Welcome to Part III of The Colorist Guide to DaVinci Resolve 18. This section covers more 
advanced node-based grading workflows and DaVinci Resolve processes that manipulate 
and render image data. As usual, the emphasis will be on image-processing efficiency as 
you adopt group grading workflows, adjust image properties, set up raw materials, and 
deliver the final project.

Project File Location
You will find the content for this section in the folder BMD 18 CC - Project 03. 
Continue to follow the instructions at the start of every lesson to find the 
necessary folder, project, and timeline. If you have not downloaded the 
third set of content files, return to the “Getting Started” section in this book for 
more information.
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Time
This lesson takes approximately 
130 minutes to complete.

Goals
Preparing Media Using 
Scene Cut Detection 216

Creating a Group 227

Applying Base Grades at 
the Pre-Clip Group Level 230

Making Clip-Specific Adjustments 
at the Clip Group Level 234

Automatically Tracking 
Objects and People 240

Creating a Unifying Look Using 
the Post-Clip Group Level 254

Applying Timeline-Level 
Grades and Effects 262

Self-Guided Exercises 267

Lesson Review 269

Lesson 7

Using Groups 

In this lesson, you will focus on an 
organizational feature of the color 
page that enables clip grouping based 
on shared visual criteria.

Although generating and organizing 
groups is incredibly simple, the 
benefits they provide in terms of 
time-saving and future-proofing can 
lead to much more efficient workflows 
and advanced grading techniques. In 
addition to applying group-wide color 
management and grades via the Node 
Editor, the grouping feature allows 
timeline filtering based on group name 
and the activation of a split screen to 
compare clips in the same group.
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Preparing Media Using 
Scene Cut Detection
The first video project in this section is a single, self-contained video file. Placing the video 
directly onto a timeline in DaVinci Resolve 18 would result in it being treated as a single 
clip, and all grading changes on the color page would affect it uniformly. To avoid this, 
you can place cuts throughout the timeline to separate the individual shots and allow 
for content-specific grading. Unfortunately, doing this manually can be extremely time 
consuming.

Fortunately, the Scene Cut Detection feature in DaVinci Resolve performs the heavy lifting 
for you. It can analyze edited video files prior to import to divide their content into subclips 
and facilitate clip-by-clip grading.

1 Open DaVinci Resolve 18.

2 In the Project Manager, click the New Project button and enter the name Project 03 - 
The Long Workday Commercial.

3 Enter the media page.

4 Right-click in the bin list next to the media pool and choose New Bin. 

5 Label the new bin Video and select it as the destination for the media you are about 
to import.

6 In the media storage browser, locate the BMD 18 CC - Project 03 folder.

7 In the folder, right-click the Project 03 - The Long Workday SCD.mov file and choose 
Scene Cut Detection.

Left Viewer 
Previous Frame

Center Viewer 
Current Frame

Right Viewer 
Next Frame

Scene Detect graph Cut List
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You will use this interface to run the edit analysis and import the resulting subclips. At 
the top of the window, three viewers display the current frame (middle), the previous 
frame (left), and the next frame (right). Below the viewers, the Scene Detect graph 
displays the location of the video’s cut points after the analysis. To the right, the Cut 
List identifies the cuts and their timecodes.

8 In the lower-left corner of the window, click Auto Scene Detect.

As the analysis runs, the assumed edit points are marked with green lines in the Scene 
Detect graph, and their timecodes are recorded in the Cut List.

TIP The height of the vertical green cut lines indicates DaVinci Resolve’s level of 
confidence that a cut has been correctly identified in that location. Cuts that fall 
under the horizontal magenta confidence line are omitted from the cut list and 
appear gray on the graph.

When a video has many jump cuts and whip pans, the Scene Cut Detection tool 
might place many cuts beneath this confidence line. To include less-confident 
cuts in the final Cut List, drag down the magenta line until the edit lines 
turn green.
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9 To review the edits, scrub through the timeline by dragging the orange playhead or 
click inside the Cut List and press the Up and Down Arrow keys to navigate and verify 
the identified cut points.

TIP You can also press P (previous) and N (next) to jump between cut points.

A correctly identified cut will display a unique image in the left viewer, followed by two 
similar images in the center and right viewers.

10 Navigate through the edits in the Cut List until you reach scene 12.

Although DaVinci Resolve detected a cut here, this is actually part of the same take. 
The false detection happened because of a headlight lens flare that created enough 
of a visual change in the frame to make DaVinci Resolve identify it as the start of 
a new shot.

11 With the cut already selected, in the lower left of the Scene Cut Detection window, click 
Delete to remove it.

12 Press the Down Arrow key to continue navigating through the Cut List and ensure that 
all the remaining cuts are correctly identified.

Toward the end of the timeline, you’ll find a large cluster of cut points. Dissolves 
and transitions are prone to misidentification and might be marked as a series of 
rapid cuts.

13 Drag the playhead to the left of this cluster and press I to create an In point in the 
Scene Detect graph.

TIP Drag the scroll bar under the Scene Detect graph to zoom in, if necessary.
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14 Drag the playhead to the right of the cut cluster and press O to place an Out point.

15 Under the right viewer, click the scissors icon to delete this batch of false cut points.

16 Ensure that no other cut points from the transition area remain. If any are still present, 
drag the playhead over it and press Delete.

17 Press the Left and Right Arrow keys to move through the video frame-by-frame and 
identify the exact cut point between the last clip and the solid white color matte at the 
end of the timeline.

18 Click Add to add the edit to the Cut List. 

A green line appears under your playhead to indicate an edit point. A new item also 
appears on the Cut List with the frame number (2352) and start timecode (01:01:38:00) 
of the cut point.

You have now reviewed all the cut points on this timeline. At this point, you should 
have 26 scenes in your Cut List.

19 In the lower-right corner, click Add Cuts to Media Pool.

TIP When working on longer films, or with edits featuring jump cuts, reviewing 
scene cut detection can become a time-consuming (and fatiguing) process. You 
may choose to break up the task into several sessions, saving your progress 
as you go.

You can save a scene cut in progress by accessing the options menu in the 
upper right of the window and choosing Save SceneCut. In the same options 
menu, you can also open a previously saved scene cut (.sc) file.
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NOTE When importing media, if a dialog appears informing you that your clips’ 
frame rates don’t match the project’s frame rates, click Change to adjust the 
project frame rate to accommodate the media.

20 Click X in the upper-left corner to close the Scene Cut Detection interface.

The commercial will now appear in your media pool as a series of clips in the Video bin.

Before you can start grading, you will first need to place this media in a timeline. To 
ensure that the clips populate the timeline in the correct order, you will organize your 
media pool by clip timecode.

21 Switch to List view by clicking the List View button in the upper right of the media pool.

22 Click the Start TC column title to sort the clips by their start timecodes.

The clips are now ready to be placed into a timeline.

TIP Clicking any column title will sort the contents of a bin by that criterion. 
Clicking the column title again will toggle the order from ascending 
to descending.

23 Switch the media pool back to thumbnail view.

24 Enter the edit page.

25 Select all the media in the Video bin by clicking one clip and pressing Command-A 
(macOS) or Ctrl-A (Windows).

26 Right-click any of the selected clips and choose Create New Timeline Using 
Selected Clips.
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27 Name the new timeline Project 03 - The Long Workday and click Create.

A new timeline appears on the edit page, populated with the 27 selected clips in the 
media pool.

28 In the media pool, create a Timelines bin and place the timeline into it.

TIP In DaVinci Resolve Studio, scene cut detection can still be performed 
on media after it has already been imported and added to a timeline. Click 
to select a clip on a timeline, or use In and Out points to indicate a range of 
clip(s), and then choose Timeline > Detect Scene Cuts. The resulting cuts can 
be edited via the rolling trim tool or deleted using the Delete (Backspace) key. 
Additionally, you can apply dissolves between clips, if necessary.

You would ordinarily use this method of flattened video migration when working with 
remote clients that don’t have access to servers or fast internet connections. Additionally, 
this workflow is often necessary when working on older projects in which the original 
media no longer exists and only the master export file is available. In both cases, it’s crucial 
to use the highest-quality codec and file format possible and to avoid overlaid text, effects, 
or transitions that cannot be disabled in the flattened video file.
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Setting Up Color Management 
in the DaVinci Wide Gamut
As in the previous project, you will use color management to remap the color space/gamut 
and gamma of the clips in the timeline prior to grading. In this exercise, you will set up your 
first HDR-ready wide-gamut project and look at the expanded custom color management 
settings to gain a better understanding of how the dynamic range of an image is processed.

1 Enter the color page.

2 Press the Up and Down Arrow keys to travel along the timeline and review the clips in 
the Project 03 - The Long Workday timeline.

The footage appears flat and desaturated, which is indicative of a log gamma curve. 
In Lesson 4, you saw that a log starting point meant you had access to a wide dynamic 
range, which could be unpacked with the help of primary grading tools or with color 
management. 

3 Open the Project Settings and navigate to the Color Management tab.

4 Set Color Science to DaVinci YRGB Color Managed.

5 Deselect “Automatic color management.”

6 Set the Color processing mode to HDR DaVinci Wide Gamut Intermediate.

This setting is optimal for outputting a project to the majority of current deliverable 
standards. You can further customize it to correctly map the source media to the 
Timeline and Output color spaces.

7 Change the Color processing mode to Custom. All the DaVinci Wide Gamut settings 
are unpacked to a modifiable list of parameters.
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What Is DaVinci Wide Gamut?
The DaVinci Wide Gamut and Intermediate gamma allow for an internal color 
space that encompasses the maximum value of image data that any given camera 
can capture. The color gamut is greater than BT. 2020 (UHD/HDR), ARRI Wide 
Gamut, and ACES AP-1, which means visual data is not compressed or lost, no 
matter where it originates from.

DaVinci Wide Gamut’s primary color values are set up to produce extremely 
accurate results, even when mapping color spaces from multiple camera sources. 
This results in perceptually consistent grading behavior among the color page’s 
palettes. In the Project Settings, the DaVinci Wide Gamut is accompanied by the 
Intermediate gamma, which provides suitable internal luminance mapping of high-
precision image data for mastering in both HDR and SDR standards. 

Due to its large color space, the DaVinci WG and Intermediate gamma combination 
is ideal for master projects that can be graded and then remapped to generate a 
variety of deliverables for broadcast, projection, and online streaming.
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8 Set the Input color space to Blackmagic Design 4.6K Film Gen 1. This was the camera 
model, data level, and firmware version used to capture the footage.

The Timeline color space determines the behavior of the color page grading tools. 
When set to DaVinci Wide Gamut (DaVinci WG/Intermediate), grading can be 
performed with greater color amplitude than with other color space standards.

The Timeline working luminance affects how high dynamic range images are treated 
when mapped to the DaVinci Intermediate gamma standard. The custom setting, HDR 
4000, will map the signals of wide dynamic range images to be viewable on an SDR 
monitor while gently rolling off highlights to prevent clipping or bunching at the top of 
the waveform.

The Output color space can remain Rec.709 Gamma 2.4, which is ideal for computer 
monitors in a controlled lighting environment. 

9 Click Save to exit the Project Settings.

The clips appear unchanged because their individual input color spaces are set to 
Rec.709. This is because video and graphic media always adopts the timeline color 
space of a project upon import. You must change the input color space of the video 
clips to reflect the current project settings.

10 Press Command-A (macOS) or Ctrl-A (Windows) to select all clips on the timeline.

11 Right-click any clip and choose Input Color Space > Project - Blackmagic Design 4.6K 
Film Gen 1 at the top of the contextual menu. Setting the input color space to Project 
ensures that any future changes to the input color space in the Project Settings will 
immediately affect the clips on the timeline.
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The appearance of the clips changes dramatically. Colors appear naturally saturated, 
and contrast is raised.

12 Select clip 01 on the Project 03 – The Long Workday timeline.

Gamma has been raised (0.15) for better visibility.

The clip appears much darker, noisier, and more saturated than the rest of the footage 
because this clip was captured on a different camera from the rest of the media. The 
project-wide color management utilizes an input color space that does not correspond 
to this clip’s source gamut, so its colors are incorrectly mapped and distorted.

13 Right-click clip 01 and choose Input Color Space > Blackmagic Design 4K Film Gen 1.

Gamma has been raised (0.15) for better visibility.
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Doing so corrects the mapping operation to use the input color space of the camera 
used to capture this clip. Although the image still appears very dark, the saturation 
is no longer distorted because of improper mapping. In situations when you are 
uncertain of a clip’s origin, it’s best to set the Input Color Space to Bypass.

14 Right-click any clip and choose Update All Thumbnails to refresh the images used to 
represent the clips in the thumbnail timeline.

NOTE When media is imported into a new, non-color managed project, it will 
adopt Rec.709 (Scene) as its scene-referred input color space. Although this is 
suitable for conventional playback and uploading, it is still highly recommended 
that you change the timeline color space for all projects to Rec.709 Gamma 2.4, 
even when not color managing. If you do so, remember to change the input 
color space of all media and graphics in the media pool to Rec.709 Gamma 2.4 
too. This will ensure a smoother grading workflow, should you decide to 
employ color management or color transform effects at a later stage.

Enabling Smart Caching
Caching is a process in which a clip is rendered while it is still in the timeline so you can 
play it back in real time when reviewing it. It’s similar to exporting, except the rendered clip 
is automatically viewable as part of the timeline media.

Some of the tools you will use in the upcoming exercises will be processor intensive and 
might impact playback speed. You will enable Smart caching to render certain clips as you 
work on them.

 — Choose Playback > Render Cache > Smart.

By using the Smart Cache option, you are leaving it up to DaVinci Resolve to determine 
which media or nodes are computationally intensive enough to require caching.

You’ll learn about caching in much more detail in Lesson 8.
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Creating a Group
When incorporating groups to a grading workflow, your first task is to choose a grouping 
strategy for your timeline. Depending on the project, you can base groups on locations, 
scenes, color schemes, shot size, or any criteria of your choice.

In the commercial project in this lesson, you will create groups to differentiate between 
scenes based on their locations and times of day.

1 Select clip 06 and Shift-click clip 13 to select the eight consecutive garage clips in 
the timeline. Ignore for now that clip 13 is a highway clip.

2 Right-click any of the highlighted clips and choose Add into Current Group.

A green link symbol appears in the lower-right corner of the clips to indicate their 
group status. These clips will now react uniformly when you start utilizing the group-
level Node Editor in later exercises.

3 Right-click any of the grouped clips and choose Groups > Group 1 > Rename.

4 Enter the group name Garage. 

Upon closer inspection, it appears that clip 13, the highway shot, does not belong in 
this scene and should not be included in this group.

5 Right-click clip 13 and choose Remove from Group. 

You can also use groups for filtering purposes.

6 In the timeline, Command-click (macOS) or Ctrl-click (Windows) clips 02 and 13.

7 Right-click one of them and choose Add into a New Group.

8 Enter the group name Highway.
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The link symbols on the Garage group disappear and are now visible only in the 
Highway group clips. From now on, the green link symbols will appear only when a 
grouped clip is selected.

The two Highway clips are relatively far apart on the timeline, so matching them 
could be tedious if you had to constantly navigate up and down the timeline to 
compare them.

9 In the interface toolbar, choose Clips > Grouped > Highway.

The filter hides all clips except the two highway clips, which now appear side by side. 
You can quickly compare and match them using the Up and Down Arrow keys.

10 Select Clips > All Clips to remove the timeline filter.

You’ll need to create one more group to prepare for the exercises in this lesson.

11 Scroll down the timeline, select clips 19 to 24, and add them to a new group 
called Home. 

12 Note that the final clips 25 and 26 were shot outdoors, meaning their lighting 
conditions are slightly different from the indoor sequence. It is advisable to grade clips 
with different light sources separately.
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Adopting Groups in a Classic 
Color Grading Workflow
With your clips sorted into groups, you can now choose the modes in which their grading 
will be targeted—from individual adjustments to group-wide changes. Doing so will result 
in a faster workflow in which you’ll no longer need to duplicate and reapply grades to 
individual clips. Reducing this duplication of effort will also lessen the chance that mistakes 
will creep into your workflow. Instead of readjusting specific nodes on multiple clips or 
keeping track of dozens of stills, you’ll be able tweak a group grade to amend all a scene’s 
clips at once.

The following figure shows how the classic color grading workflow, previously expressed 
as a node tree structure in Lesson 1, can be translated into group-based node structures.

C.S. Transform refers to Color Space Transform in the Effects panel

The following is a list of available grading modes in the Node Editor and their relationships 
to the traditional grading workflow:

 — Group pre-clip permits you to apply preparatory grading adjustments such as gamut 
mapping, color chart auto-correction, or Color Space Transform (the Resolve FX 
equivalent of using color management in the Project Settings). At this stage, you can 
also normalize footage with common luminance ranges and address obvious tint or 
temperature issues in the dailies.

 — Clip mode enables you to address the individual needs of each clip in a group, 
including normalization, balancing, matching, and secondary grade adjustments.
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 — Group post-clip is best utilized for creative scene grading. By this stage, your clips 
should be matched and their individual secondary requirements met. This will ensure 
the uniform application of the creative grades and will require only minimal tweaking 
on a clip-by-clip level.

 — Timeline will affect every clip on the active timeline of your project. Color correction 
and creative grading is not recommended at this stage, but you could use this mode 
to implement artificial grain and film effects, apply vignettes to short-form projects, or 
remap the color space of a timeline using Color Space Transform.

This breakdown suggests the order in which to address and process visual data, but you 
should not see it as a strict order of grading operations. As with any standard grading 
workflow, it’s entirely acceptable (and expected) to jump between group levels to make 
adjustments throughout the grading process. Note that the output of earlier group modes 
is the direct input of later modes (for example, the pre-clip output leads to the clip input). 
When considering node order, think of the group modes as being one long pipeline, whose 
signal impact was explored in Lesson 5.

Applying Base Grades at 
the Pre-Clip Group Level
In the pre-clip group level, you can make adjustments that will uniformly affect the clip-
level RGB input signals of all the clips in a group. 

Keep in mind that all the clips in a group are affected by these changes, so you must avoid 
overfocusing on achieving a perfectly neutral appearance in any single shot. Instead, use 
this level to set up a sequence with the help of broad color management tools, like LUTs, 
color charts, Gamut Mapping, or Color Space Transform effects.

Using a Color Chart to Balance a Group
One method for normalizing the tonal range and balance of a sequence of clips is to use 
the calibration charts that were captured at the start of the scene shoot. Calibration charts 
allow for automated color correction that gives you a much more accurate output than 
regular auto-balancing because of their reliable luminance reflection and meticulously 
designed color swatches.
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1 Change the Clips timeline filter to display only the clips in the Home group.

When using a color checker, a new shot of the chart should be captured at the start of 
every new scene, light change, or location during filming.

2 In the dropdown menu at the top of the Node Editor, switch to Group Pre-Clip mode. 

In this mode, all adjustments you make will apply to the whole group.

3 In the Home group timeline, select clip 01.

4 Label node 01 as Color Match.

5 In the left palettes of the color page, open the Color Match palette.
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6 In the viewer’s onscreen controls dropdown menu, choose Color Chart.

7 Drag the corners of the color chart interface to the corners of the color checker chart 
in the image. Ensure that the small squares in the middle of the color chart outline are 
filled with the colors they are meant to be analyzing. Any interference with the black 
chart borders or the man’s fingers will affect the quality of this analysis.

8 At the top of the Color Match palette, verify that X-Rite ColorChecker Classic - Legacy 
is chosen. This selection is based on the type and version of the chart captured 
in the shot.

9 Set the Source Gamma to DaVinci Intermediate.



233Applying Base Grades at the Pre-Clip Group Level

If color management is not enabled, Source Gamma must be set to the encoded 
gamma (or EOTF) of the original image. This allows Color Match to map the tonal 
encoding of the image to the timeline gamma and accurately calibrate the image 
color values. 

If color management is enabled, Source Gamma must match the timeline color space 
of the project. This is because color management maps the video signal’s input color 
space to the timeline color space prior to node 01 of the pre-clip node pipeline, so the 
Source Gamma will be the starting point of the clip in the Node Editor, and not the 
clip’s actual encoded gamma. 

10 Set the Target Gamma to DaVinci Intermediate. 

It may feel counterintuitive to use the same setting for both source and target, but it 
makes sense when you consider that the Color Match palette is not currently being 
used for the purpose of remapping between two gamma standards. In this case, 
you’re only interested in calibrating the colors based on the source lighting.

11 Set the Target Color Space to DaVinci Wide Gamut to keep the result consistent with 
the Timeline color space.

12 At the bottom of the Color Match palette, click Match. You will see a shift in color and 
luminance, as the parades are raised and balanced according to the chart.

TIP The values that appear under the color boxes in the Color Match palette 
indicate the percentage that a value needed to be adjusted to match the color 
patch sample in the image. A change of less than 10% is ideal, implying a clean 
starting point and a distortion-free adjustment.

13 Navigate down the timeline to verify that the rest of the clips in the Home group are 
also affected by this calibration. As these were captured in the same location, under 
similar lighting conditions, the automated color balance benefits them equally.

You’ve created a better starting point for all the clips in the scene while retaining the 
full gamma range and color quality to perform individual balancing, matching, and 
creative grading down the line.

TIP If you intend to use conversion LUTs in a project, the LUTs should be 
applied at the pre-clip group stage.
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Making Clip-Specific Adjustments 
at the Clip Group Level
By default, the standard Node Editor applies grade changes on a clip-by-clip basis. It’s 
the ideal way to color correct, match footage, and make secondary amendments. When 
working with groups, you continue to have access to the Node Editor in Clip mode.

Matching Shots at the Clip Group Level
Before you can apply a creative grade to a group of clips, it’s important to ensure that all 
those clips match in terms of tint, temperature, and luminance level distribution.

1 Filter the timeline to show only the Garage group clips.

2 Switch the Node Editor to Clip mode.

3 Select clip 01. At first glance, the shot appears to be substantially brighter than the 
other clips in the scene.

4 Drag the viewer playhead to the end of clip 1.
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After the man enters the garage, the shot appears to be exposed similarly to others in 
the sequence and will not require aggressive matching.

5 By default, thumbnail images in the timeline represent the first frame of a clip. Drag 
within the thumbnail of a clip to change the frame represented in the thumbnail.

When comparing and balancing clips, remember that the first frame is not always the 
most reliable choice for matching, and you should always play through the entire clip 
before making a grading decision. In this case, you can leave clip 01 as it is.

6 Select clip 04. This shot is definitely darker than the rest of the sequence.

7 Right-click clip 05 and choose Wipe Timeline Clip to enable the Wipe mode in 
the viewer.
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8 Open the Sizing palette in Reference Sizing mode and pan and zoom clip 05 to see the 
man more clearly in the wide shot.

9 Press Option-F (macOS) or Alt-F (Windows) to expand the viewer and get a better view 
of the differences between the clips.

10 Open the waveform scope (in RGB mode with Colorize enabled) to view a graphic 
representation of the chromatic differences between the clips. Just as in the viewer, the 
waveform is split along the wipe line.

11 Label node 01 in clip 04 as Match.

12 Drag the Gain master wheel right to brighten the highlights of the image. Aim to match 
the waveform highlight spikes that represent the light sources reflected on the garage 
floor of the reference image.

13 Drag the Lift master wheel right slightly to brighten the shadows. Keep an eye on the 
man’s suit to ensure a good match in the viewer and waveforms.

14 Finally, drag the Gamma master wheel right to match the overall waveform distribution 
in lower midtones. Use the green channel of the RGB waveform as a match reference.

While the tonal distribution of the image looks accurate, there is now a strong green 
cast throughout the image. This color imbalance can be addressed more accurately 
using the color bars.

15 Switch the Primaries palette mode to color bars.

16 Drag down the green Lift bar to neutralize the suit and garage shadows.

17 Drag the red Gamma and Gain bars down to address the resulting red tint.



237Making Clip-Specific Adjustments at the Clip Group Level

The Waveforms Don’t Match; 
Are the Clips Really Color Matched?
When matching clips using waveforms, your goal is not to make the waveforms 
look identical. Rather, it is to use the reference waveform as a guide to inform the 
overall spread of the luminance data, the heights of the lightest parts of the image, 
and the depths of the shadows.

In this example, clip 04 will always have a waveform concentrated at the bottom of 
the graph because it features a mid-close-up of the man and his dark suit.

In clip 05, the suit occupies a very small part of the shot and appears in the 
waveform as a small dip to the shadows—the depths of which are now matched. 
Likewise, the lights in both waveforms follow a similar trajectory.

Lastly, the overall waveform in clip 04 is spread out to a similar distance to clip 
05. Bypass the grade in clip 04 to compare how compressed the waveform 
used to look.
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18 Press Option-F (macOS) or Alt-F (Windows) to exit the Enhanced viewer mode but leave 
the Wipe mode on.

19 Reset the Reference Sizing mode of the Sizing palette and drag the wipe line to the 
center of the viewer.

20 Select clip 07.

The clip colors are already a good match for the rest of the timeline, but the shot is 
too bright overall, which will affect the quality of the post-clip grade.

21 Label node 01 as Match.

22 Drag the Offset master wheel left to darken the shadows to the same level as the 
reference clip. A good area to watch as you adjust the image luminance is the garage 
ceiling, which should match in all shots.

Intermediary Matching Between Clips
At times, you’ll want to grade shots to show a gradual change in color or temperature 
between clips. Doing so is not strictly a color match, but rather an intermediary grade 
designed to transition between clips with different looks without jarring a viewer’s 
perception of the scene.
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In this exercise, two clips captured at sunrise are intercut with media captured later in the 
day. You will match the daylight clip between them, and then grade the preceding clip to 
suggest a natural change in sunlight from the first half of the timeline to the second.

1 Remove the timeline filter to show all clips.

2 Shift-click clips 22 to 25 to select them.

3 In the viewer, enable Split Screen mode.

4 In the dropdown menu in the upper right of the viewer, choose Selected Clips.

5 Press Option-F (macOS) or Alt-F (Windows) to expand the viewer.

6 In the split-screen viewer, ensure that clip 24 (lower left) is selected.

7 Open the Node Editor and label node 01 as Match.

8 Drag the Gain wheel toward yellow until the color of the sky matches the skies in the 
surrounding clips.

9 Reduce the contrast in the adjustment controls until the window frames and furniture 
have the same flat shadows as the surrounding sunrise clips.

10 Copy the Match node grade from clip 24 and paste it into the first node of clip 22 
(upper left).

To ensure a smooth transition between clips 21 and 23, you’ll want to reduce the 
severity of the grade in clip 22.
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11 Open the Key palette and change the Key Output Gain to 0.600. The grade intensity 
is nearly halved, and the original colors of the image now show through for a smooth 
transition between the first and second halves of the scene.

12 Press Option-F (macOS) or Alt-F (Windows) to exit the Enhanced viewer mode.

13 Exit the split-screen viewer.

Automatically Tracking 
Objects and People
The Magic Mask is a DaVinci Neural Engine-powered selection tool that can identify and 
track hundreds of objects, as well as human figures and physical features, based on 
user-applied strokes in the viewer. Additional track, stroke, and matte finesse controls 
allow for the refinement of selections to achieve an optimal result. As with previous 
secondary grading tools, the resulting masks can then be graded using the standard 
primary palettes.

NOTE The following exercises require DaVinci Resolve Studio to complete.
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Tracking an Object
The default Object Mask mode intuitively detects and tracks moving objects within a 
shot. Tested on thousands of objects, from vehicles, buildings, and skylines, to animals, 
hair, and flames, it boasts an extraordinary recognition rate. You can use the Object Mask 
to emphasize products in commercials, perform sky replacement, enhance production 
design, or apply any number of creative applications that even we haven’t thought of yet!

1 Select clip 15.

2 Label node 01 as Balance and use the Primaries palette to brighten the image and 
remove the magenta tint from the highlights.

3 Create a second node and label it Track.

4 In the central palettes, open the Magic Mask palette.

Toolbar

Stroke List

Adjustment Controls

Matte Finesse
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The Magic Mask palette is made up of three areas:

 — Toolbar features the selection mode, tracking controls, stroke tools, 
and mask overlay.

 — Stroke List catalogs the strokes you draw and displays their individual 
timeline tracks.

 — Adjustment Controls and Matte Finesse in the sidebar are used to refine the 
resulting mask. Most of the matte finesse controls operate similarly to those in 
the qualifier palette.

5 In the viewer, click and drag to create a selection of the car. When using Object Masks, 
use long strokes that include a good range of the object surface.

Stroke 1 is registered in the Stroke List of the Magic Mask palette.

6 Click Toggle Mask Overlay in the upper-right corner.

The initial mask analysis appears in the viewer, allowing you to review your selection. 
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NOTE If the stroke is not visible in the viewer, ensure that the Magic Mask 
palette is active, and the onscreen control in the lower-left corner of the viewer 
is set to qualifier.

7 In the Magic Mask toolbar, click Track Forward.

A successful track is indicated by a blue line in the Stroke 1 timeline. 

8 Click Toggle Mask Overlay again to remove the red highlight from the viewer.

9 To remove the blue stroke from the viewer, click the onscreen controls dropdown 
menu and choose Off.

TIP A quick method for removing the Magic Mask onscreen overlays is to open 
a different tool in the central palettes, such as the Curves or Color Warper.

With the selection complete and the overlays hidden, you can resume the 
grading process.

10 In the Primaries palette, increase the Contrast (1.100) and drag the Pivot left (0.100) to 
brighten the car and emphasize its reflective body.

11 Increase the Midtone Detail (50.00) to sharpen the headlights, rims, and light 
reflections.

Before After
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With a simple stroke selection, you were able to isolate the car and emphasize it against 
its environment with a contrast grade. Notice how the Object Mask tracked its motion 
even with the dramatic fluctuations in light. The Magic Mask palette goes beyond chroma 
and luma keying when identifying a selection and can follow objects through dynamic 
environments, strong shadows, and changes in light sources.

Tracking a Person
The Person Mask mode can identify the full figure of a person with one establishing stroke 
in the viewer. After reviewing the preliminary selection overlay, you can refine the matte 
before tracking the person’s movement throughout the shot. In this exercise, you will track 
a person with the intention of grading the environment around them.

1 Select clip 25.

2 Label node 01 as Track.

3 In the upper right of the Magic Mask palette, change the mode to Person Mask.

4 On the left of the palette toolbar, set the Person Mask mode to Person.

5 In the viewer, click and drag to create a short stroke on the back of the man’s head. 
For Person Masks, short strokes are better, since they are less likely to drift off 
when tracking.
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A new Person category and stroke item appear in the Stroke List of the Magic 
Mask palette.

6 Click Toggle Mask Overlay to review the selection.

7 If satisfied, click Track Forward. 

Otherwise, click the bin icon in the stroke list to delete the stroke and then create and 
track a new stroke in the viewer.

8 The Magic Mask adjustment controls in the sidebar feature a Quality parameter that 
determines the accuracy of the mask analysis. In cases where a garbage matte or 
rough approximation will do, Faster will provide a quick result at the expense of quality. 
When precision is crucial, Better is the preferred option, but comes at the expense of 
processing time and computational power. 

Click Better and drag the timeline playhead to review the improved result. The Better 
setting is highly advisable for completing final looks prior to project delivery, when 
real-time playback is not vital.

9 Change the Quality parameter setting back to Faster to get smoother playback while 
completing this exercise.

10 Another adjustment control unique to the Magic Mask is Smart Refine. This tool allows 
you to expand or contract the mask based on the internal image analysis. This means 
Smart Refine will prioritize preservation of areas that it is certain are part of a person, 
while discarding mask artifacts and areas in which it has less confidence.

Drag Smart Refine (60.0) until you are satisfied with the mask selection in the viewer.

11 The Mode dropdown menu allows you to change how the mask is modified by the 
Radius parameter beneath. To uniformly contract the mask, leave the Mode set to 
Shrink and drag the Radius parameter (5.0) to eliminate any remaining selection 
around the man.  

12 In the matte finesse controls, drag the Blur Radius (20.0) to soften the edge 
of the mask.

To grade the scene around the man, you will first need to invert the selection.
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13 Click Invert Mask on the right side of the Magic Mask toolbar.

14 Click Toggle Mask Overlay again to remove the red highlight from the viewer.

With the selection complete, you can resume the grading process.

15 In the Primaries palette, increase the Midtone Detail (100.00) to sharpen the details on 
the beach and enhance the ripples in the water.

16 Use the Offset master wheel to brighten the background and drag the Offset wheel 
toward orange to emphasize the warm sunrise.

17 Use Contrast and Pivot to create a dynamic look with emphasized shadows 
and highlights.

Before After

As you can see, the Magic Mask is incredibly intelligent when it comes to reading the 
motion of the human body. In this case, the Magic Mask was able to recognize a man as he 
walked into the shot, revealing his legs and arm. In clips with multiple people, you can use 
additional strokes to mask and track each person.

NOTE Although the Magic Mask produces incredibly satisfying results, note that it 
is ultimately a color grading tool, not a compositing tool. The intention behind the 
Magic Mask is to provide a secondary grading selection far quicker than manual 
tracing/rotoscoping and with far more accuracy than the default Power Window 
shapes. Its results are designed to produce optimal results when used with the 
primary grading palettes on the color page.
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Masking Physical Features
The Magic Mask’s Features mode allows you to mask individual physical properties like 
faces, limbs, and articles of clothing. Like the Person mode, it exhibits a great deal of 
intuition and has been tested on a wide variety of video samples ranging from top hats 
and skirts to sandals and suits of armor. In the following exercises, you will track specific 
features while also correcting strokes that have drifted from their reference point.

1 Select clip 06.

2 Label node 01 as Face.

3 Open the Magic Mask palette.

4 Play clip 06 to review it. 

Due to the dark environment and rapidly changing light in the garage, the man’s face 
is underlit. You will use the Magic Mask to track and brighten his face.

5 Drag the viewer playhead to the last frame of the clip. Tracking from a forward face 
angle will produce a more accurate result than the profile at the start of the clip.

6 Change the Magic Mask palette mode to Person Mask.

7 On the left of the palette toolbar, ensure that the Person Mask mode is set to Features.

8 In the Features pop-up menu, select Face.
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9 In the viewer, drag a stroke over the man’s left eye.

10 Click Toggle Mask Overlay to review the Face selection.

The selection has successfully captured his face, ear, and hairline. The Face feature 
classifies only the area above the chin as the face. To capture his neck, you’ll need to 
introduce a second mask. 

11 In the Features pop-up menu, select Torso (Exposed Skin).

12 In the viewer, drag a stoke in the middle of his neck.

With the features selected successfully, you can proceed with the track.
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13 In the Magic Mask toolbar, click Track Reverse.

As the track runs, the man turns his head, and the left eye stroke drifts away. This can 
sometimes occur when you track a person in motion and the reference point changes 
or becomes obscured. You’ll need to fix this corrupted track.

14 Starting from the last frame (the starting point of the track), drag the playhead 
backward until you find the last usable frame of the track. This will be the frame just 
before he turns his head and the stroke gets lost.

15 In the viewer, select the eye stroke with your mouse and reposition it to his right eye.

16 In the Magic Mask toolbar, click Track Reverse again. This action will continue the track 
from the new stroke position and overwrite the bad track data.
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17 Drag the playhead to review the completed mask overlay track. Notice that when 
the stroke position was changed, it is seen in the viewer as a static change from one 
keyframe to the next.

18 Use the Magic Mask sidebar to fine-tune the overlay and drag the Blur Radius (30.0) 
to soften the edge of the mask.

19 Click Toggle Mask Overlay to hide the mask in the viewer.

20 In the viewer, set the onscreen controls to Off to hide the blue stroke lines.

21 To brighten the man’s face, drag the Gamma master wheel (0.02) to the right.

The Magic Mask strokes are designed to be dragged within the viewer to optimize their 
tracking position. Each stroke change is treated as a static keyframe, meaning there is 
no dynamic animation or distortion from one stroke position to the next. Strokes can be 
moved as many times as needed to provide the Magic Mask with optimal tracking data, 
including moving (and analyzing) the strokes one frame at a time.

Fixing Difficult Tracks
Despite its great accuracy and intuition, the Magic Mask is actually designed for working 
with difficult-to-track data. It’s possible to isolate specific stokes when tracking, track 
one frame at a time, and introduce subtractive stokes to eliminate unwanted areas from 
the final mask. This exercise will require you to use a combination of these techniques to 
produce a clean result.

1 Select clip 09.

This clip has been successfully matched to the rest of the Garage sequence, but 
there is still a green dominance in the darker elements on the man—specifically, 
his hair and suit.

2 Create a new node and label it Masks.

3 Open the Magic Mask palette and set the mode to Person Mask.

4 In the upper left of the Magic Mask palette, ensure that the Person Mask mode is set 
to Features.

5 In the Features pop-up menu, select Hair.

6 Drag the playhead past the second half of the clip, when the man’s head is turned, for 
an optimal starting point for the track.

7 In the viewer, drag a stroke horizontally across the man’s hair.
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8 Click Toggle Mask Overlay to review the selection.

9 In the toolbar, click Track Forward and Reverse.

10 If the stroke goes offscreen toward the end of the clip, drag the playhead to the last 
usable frame and readjust the stroke’s position.

11 Click Track One Frame Forward.

Continue readjusting the stroke position and tracking one frame at a time until the hair 
track is complete. 

Next, you will select the man’s suit. Continue working in the same Masks node.

12 Drag the playhead to the center of the clip for a clearer view of the suit.

13 In the Features pop-up menu, select Clothing (Top).

14 In the viewer, drag a short stroke that includes both the man’s suit and shirt for a more 
accurate analysis.

You’ll want to track this new stroke separately to avoid overwriting the successful track 
data on the Hair stroke.
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15 In the palette options, choose Track Selected Stroke Only.

16 Select Stroke 1 in the Clothing (Top) category of the stroke list.

17 In the Magic Mask toolbar, click Track Forward and Reverse.

After tracking is completed, it’s possible that you will see some artifacting in the mask 
next to the man’s neck. This can be resolved using subtractive strokes.

18 Drag the playhead until you see a frame with a distorted mask.

19 Ensure that the Features pop-up menu is still set to Clothing (Top).

20 In the toolbar, select the subtractive stroke tool.

21 In the viewer, draw a stroke on the mask overlay that is spilling outside the man. 

Subtractive strokes appear red in the viewer.
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22 Select the red Stroke 2 in the stroke list. 

23 Click Track Forward and Reverse.

24 In the matte finesse sidebar, shrink the mask Radius (3) and drag the Blur Radius (20.0) 
to contract and soften the edge of the mask.

25 Click Toggle Mask Overlay to hide the mask and set the onscreen controls to Off to 
hide the blue stroke lines.

26 Use the Primaries palette to slightly darken the shadows with the Lift master wheel 
and gently raise the blue Lift bar to match the color of the suit to the one in the 
preceding clip.

TIP Another unique parameter in the Magic Mask’s adjustment controls is 
Consistency, which is designed to reduce mask jitter. Jitter is most likely to occur 
in masks that feature rapid movement or a high volume of edge detail, such as 
loose clothes blowing in the wind or curly hair. Increase Consistency to analyze 
the surrounding frames of a mask and produce a more static average of the 
selection on any given frame.

Masking the motion of a person manually can take hours or days. Traditionally, this involves 
breaking up the human figure into a dozen dedicated windows and then animating them 
to match the person’s movement. The Magic Mask produces accurate travelling mattes 
instantly, allowing you to focus more of your time on the color grading process.
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Creating a Unifying Look Using 
the Post-Clip Group Level
When you achieve color consistency and address the individual secondary needs of the 
clips within your groups, you’re ready to move on to the final post-clip group level in which 
you will design and apply creative grades on a scene-by-scene basis. At this stage, other 
members of the creative process, such as the director and director of photography (DOP), 
usually get involved to discuss the aesthetic needs of the film. 

Applying a Post-Clip Grade with 
an External Reference
In this exercise, you will work with a reference image that a client has shared with you. You 
will import it into the gallery and treat it as a still for visual comparison.

1 Filter the timeline to show only the Garage group clips.

2 Switch the Node Editor to Group Post-Clip mode.

3 Select clip 07. This is the key shot you will use to grade the rest of the group.

4 To import an external reference image, right-click in the Gallery and choose Import.

5 In your file browser, navigate to the BMD 18 CC - Project 03 folder and open the 
References subfolder.

If you don’t see any images in the folder, ensure that your browser window is set to 
identify all files as opposed to just the default .dpx format files.

6 Select the FK_Bridge_Reference.png image and click Import.
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7 Double-click the still to wipe it in the viewer.

Clients often use visual references from photographs, art, or even existing films or TV 
shows to communicate their desired looks for a project. In this case, the highly stylized 
reference image points toward a high-contrast, saturated scene with neutral shadows 
and cool midtones.

First, let’s match the contrast and cold look of the reference shot.

8 Label node 01 as Dark Blue.

9 In the Curves palette, drag the master curve black point across the bottom of the 
graph until the shadow under the car is almost pitch black.

10 Shape the master curve into a gentle S-curve to add contrast to the midtones, while 
bringing some intensity into the lights within the image.
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You may notice the shadows clipping slightly in the waveform and parade scopes. 
Recall the message about breaking rules in Lesson 5. It applies even more so for 
creative grading. When designing a look, it’s perfectly acceptable to make more 
aggressive grading adjustments, as your primary focus is no longer the preservation 
of the video signal, but rather the creation of a look you find aesthetically pleasing.

11 Drag the Gamma wheel toward cyan-blue to create a strong, cool tone that matches 
the reference image.

You can address the oversaturated blue headlight reflections on the floor using the 
Lum vs Sat curve.

12 In the Curves palette, open the Lum vs Sat HSL curve.

13 Click the white swatch under the curve grid to generate an anchor next to the 
rightmost point of the saturation graph. The area between the two points represents 
the most saturated areas of the frame. 

14 Drag down the rightmost point until the reflections are not overly saturated. You’ll 
notice that the area immediately around the reflections is not affected as strongly.

15 Drag the white swatch anchor point left to expand the region you’re targeting. If 
necessary, click the right side of the curve to create a new adjustment point and drag 
it down until the edges of the reflection are no longer saturated. Keep an eye on the 
other colors in the image to ensure that you are not desaturating any prominent 
elements such as the red columns or the hood of the car.
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The overall temperature and tonal range of the scene is complete. You can now place a 
second node to enhance the garage’s red columns and pipes.

It’s not common to create secondary grades in post-clip group node graphs, but when 
the scenes have a consistent color scheme, it can work.

Previously, you saw that you could get a better secondary grade result if you used the 
original RGB signal of a clip instead of a heavily graded and contrasted one, like the 
Dark Blue node. However, in this instance, the graded node is helping to contrast the 
red pipes against the originally warm scene. Making a secondary selection based on 
the cool grade will produce a cleaner red selection with minimal impact on the walls 
and actor’s skin tone.

16 Create a new serial corrector node, and label it Red Pipes.

17 In the HSL curves, open the Hue vs Sat HSL curve.

18 Click the red swatch at the bottom of the palette and increase the Sat by 50%. Doing 
so enhances the reds in the image but also makes them a little distracting because of 
their unnatural brightness.
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19 Open the Hue vs Lum HSL curve, click the red swatch, and reduce the Lum by 50%. 
This darkens the red colors and matches them more closely to their environment.

TIP To bypass the entire node tree within a specific level grade, press Option-D 
(macOS) or Alt-D (Windows). Doing so will leave your other node levels intact so 
you can assess the changes you’ve made within the current clip level.

Adjusting Clips After a Post-Clip Grade
Occasionally, a post-clip grade will emphasize or reveal inconsistencies in a sequence of 
clips, which can result in mismatched grades. In such cases, you’ll need to return to Clip 
mode in the Node Editor to make further adjustments.

In this exercise, you will return to the Clip mode to apply an effect to the key shot and then 
fix a discrepancy that was revealed in one of the shots on the timeline.

1 With clip 07 still selected, return the Node Editor to Clip mode. You will apply an effect 
to the final clip to make the headlights more dramatic.

2 Create a second node and label it Headlights.
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3 Open the Effects panel.

4 Find the Resolve FX Light category and drag the Aperture Diffraction effect onto the 
Headlights node.

The result is an optical effect that mimics the diffraction of light. The settings in the 
Effects panel allow you to refine the pattern, intensity, and color of the effect.

5 Under Aperture Controls, change the Iris Shape to Square.

TIP In the Output category of the Aperture Diffraction settings, change Select 
Output to Diffraction Patterns Alone to get a clearer view of the light patterns 
as you adjust the settings. Change the output back to Final Composite to see 
the result combined with the original image.

6 Under Compositing Controls, increase the Brightness to 0.600.

7 Increase the Colorize value to 0.200 and use the swatch underneath to change the 
color to purple.
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8 To reduce the effect intensity, expand the Global Blend parameter at the bottom of the 
settings and set Blend to 0.700.

This simple effect dramatizes the final shot of the sequence as the car drives away. A 
variety of light-based plug-ins in the Effects panel can similarly help you stylize your 
shots and make features “pop” in subtle or exaggerated ways.

Next, you will check the remainder of the garage sequence to ensure that all 
shots match.

9 Navigate the timeline and check the clips for consistency.

You can see that the upper midtones in clip 06 are substantially bluer when compared 
to the environments in clips 05 and 07. Clip 06 is also darker, making it difficult to see 
the man’s face.

10 Select clip 06. 
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11 Right-click clip 07 and select Wipe Timeline Clip.

12 Ensure that the Node Editor is still in Clip mode.

13 Label node 01 as Match.

14 Switch the Primaries palette to Log Wheels mode and drag the Shadow master wheel 
right to brighten the shadows of the image, revealing more data in the background 
and in the man’s face.

15 Drag the Shadow wheel control point toward orange.

The overall blue dominance of the shot is reduced, and the man’s face is more 
clearly visible.
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16 Disable Wipe mode in the viewer.

The convenience of the group grading workflow is that no single stage or node is 
permanent. It’s easy to jump between the different group modes and tweak them as 
required, all while seeing the final output in the viewer.

Applying Timeline-Level 
Grades and Effects
The Timeline level is available in the Node Editor whether or not you use group workflows. 
As the name implies, adjustments made at this level affect every timeline clip uniformly. 
This functionality can sometimes be useful for image property applications such as color 
space transforming, gamut mapping, adding a vignette, or inserting film grain/analog 
video effects. It is not as strongly advised for grading purposes but could be effective for 
short video projects with consistent base colors.

In this exercise, you will apply an analog video look to your entire project, followed by the 
data burn-in details that will make it easier to keep track of timecodes and clip names 
during the feedback stage of post-production.

Apply an Analog Video Look 
to an Entire Timeline
Artificial film grain and analog video artifacts are occasionally added to digital media for 
a variety of reasons. In some cases, the film needs to look outdated as a component of 
the storyline (such as flashbacks, home movies, found footage, and so on). Film grain and 
damage can also add realism to shots with artificially imposed elements or CGI graphics by 
making them appear to have been captured on tape or celluloid film. Finally, film grain and 
damage can also be an aesthetic choice.

NOTE This exercise requires DaVinci Resolve Studio to complete.

1 Turn off the timeline filter to show all clips.

2 Switch the Node Editor to Timeline mode.

By default, the Node Editor appears without a node 01, which acts as a useful 
reminder that this stage of the grading workflow is optional and can cause significant 
repercussions in the appearance of the entire timeline.
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3 Press Option-S (macOS) or Alt-S (Windows) to create a new serial node that will already 
be connected to the RGB input and node tree outputs.

The blue outline around the node is another visual reminder that you are not in any of 
the standard grading node levels.

4 Label node 01 as VHS.

5 Open the Effects panel.

6 Find the Resolve FX Texture category and drag the Analog Damage effect 
onto node 01.

7 Press Shift-F to expand the viewer and improve access to the Analog Damage 
settings panel.

The top of the panel features a preset pop-up menu with a collection of common 
analog looks—B&W and color television transmission signals through the decades, 
VHS, and so on. Beneath, individual parameter controls enable you to adjust a wide 
variety of damage components such as vignetting, noise, scan lines, chromatic 
aberration, jitter, screen curvature and many others.

8 Set the preset to Old VHS.
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9 To remove the visible frame on the left, open the Scan category. Adjust the 
H-Shift to 0.050.

10 To remove the horizontal black lines running throughout the sequence as it plays, 
reset V-Hold to 0.000.

Before After

11 Click Play to review the result. All the clips on the timeline are affected by the VHS look. 

12 Press Shift-F to exit the full-screen viewer.

13 Before moving on to the next exercise, bypass the VHS node. The Analog Damage 
effect is processor-intensive, so it’s a good idea to disable it until you are ready to 
export the project.

TIP The Film Grain effect in the Resolve FX Texture category can similarly be 
applied to achieve the look of celluloid film on digital footage. It comes with 
a variety of film stock presets (8 mm, 16 mm, 35 mm) as well as a collection 
of grain parameters for optimal customization on a timeline or clip-by-clip 
basis. In the Advanced Controls, you can enable “Animate on Every Refresh” 
to force the grain to move as you grade, giving you an even more accurate 
representation of the final look as you work on a clip.

Adding Data Burn-In to the 
Viewer and Final Video
Another common feature applied on a timeline basis is data burn-in, which overlays a 
timecode, clip data, or any number of designated text metadata over the viewer. It works 
independently from the Node Editor, and you can use it in-program for editorial purposes, 
as well as for the final delivery of a video.
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1 Choose Workspace > Data Burn-In.

The left side of the Data Burn-In window features a list of metadata that you can 
superimpose over the video. The right side of the interface changes according to the 
selected option and allows you to adjust the placement of text, font, color, and so on.

The Project and Clip buttons at the top of the Data Burn-In window allow you to apply 
data across the length of a timeline or on a single instance of a clip. This option can be 
helpful when leaving comments or feedback—for example, when communicating with 
the audio or VFX department about the requirements of specific shots.

2 Select Record Timecode to display the timeline’s timecode on the video.

3 Select Source Clip Name to display the name of each clip as it plays in the video. Note 
that in this case, because all the clips are sourced from a single flattened video file, 
they will all have the same source clip name.

4 Select Custom Text1, and in the Custom Output Text field, type PLEASE DO NOT  
DISTRIBUTE.

5 In the Data Burn-In options, deselect Gang Render Text Styles. This will enable you to 
modify the individual appearances of the data burn-in fields.

In this case, you will use the Custom Text field to act as a form of distribution 
protection for your video.
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6 Remove the black box behind the text by reducing the Custom Text Background 
Opacity to 0.

7 Change the Font to Open Sans.

8 Increase the Text Size (140) to fill the viewer.

9 Reduce the Text Opacity (0.20). 

10 Reposition the text to the center of the viewer using the Position Y parameter.

TIP To apply a watermark over a video, use one of the Logo options in the 
Data Burn-In interface. You can import a custom image/logo file and adjust its 
opacity using the Transform controls on the right.

11 Close the Data Burn-In window.

Data burn-ins can be extremely useful for inserting quick and accurate communications 
between departments and clients. Instead of describing clips visually, exact clip source 
names can be used in feedback. Likewise, the precise timecodes ensure that your 
collaborators are not using the general timecodes of their video players (which usually 
lack frame data). Frequently used data burn-in layouts can be saved as presets in the Data 
Burn-In options menu.
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NOTE The Data Burn-In window includes fields such as Reel Name, Shot, Take, and 
many others that display the information entered into those respective fields in the 
Metadata panel of the media page.

In the Custom Text fields, type % to access an even wider range of 
metadata options.

By combining the knowledge you gained in previous exercises with the group-driven 
workflow of this lesson, you can design more efficient project workflows with clearly 
allocated purposes for each group level and node.

Self-Guided Exercises
Complete the following self-guided exercises in the Project 03 - The Long Workday timeline 
to gain more experience with groups, primary and secondary grading, and creative grade 
construction. Note that these exercises are designed foremost for group grading practice 
and not necessarily to produce a single cohesive color narrative.

Home Group
 — Create a post-clip group grade on the Home group. Import the GC_Island_Reference.png  

image from the BMD 18 CC - Project 03 > References subfolder into the gallery as a 
reference. Aim to create a light, warm look with a bit of contrast. Use HSL curves to 
emphasize the blue color of the sky and water outside the windows.

 — In clip 02 of the Home group, use the Magic Mask to track the man, while excluding his 
coat. Invert the mask selection and use Lum vs Sat to desaturate his surroundings. Use 
Smart Refine if edges of color remain visible around him.

Highway Group
 — Balance clip 02 of the Highway group by reducing the red in the shadows and then 

brighten the overall shot. Match clip 01 to clip 02, paying particular attention to the 
color of the road in both shots.

 — Add the Lens Reflections effect to clip 01 and change the reflection preset to Bokeh. 
Adjust the reflecting elements until you have a string of faint, out-of-focus, white 
bokehs at the bottom of the screen. Then append this node to clip 02.
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Office Group
 — Add clips 03–05 to a new group called Office.

 — Match the lightness of clip 03 to the other clips in the Office group.

 — In clip 02, use the Magic Mask to track the man’s face and hands, and then use 
adjustment controls to add contrast and detail to the man’s skin.

 — Create a post-clip group grade on the Office group. Begin by normalizing the lightness 
in the room by spreading the waveform upward. Then create a Look node in which 
you add cyan to the lower midtones while maintaining neutral shadows. Return to Clip 
mode in the Node Editor to tweak any inconsistencies revealed in the group grade.

Morning Group
 — Add clips 16–18 to a new group called Morning.

 — Perform contrast and color matching on the clips the Morning group using clip 02 as 
the key shot. 

 — In clip 01, use the Object Mask to select the sea and increase the contrast, pivot, and 
midtone detail to make the ripples in the water more pronounced.

 — Create a post-clip group grade in the Morning group. Use the Color Warper to gently 
tint the mountains red and turn the atmosphere yellow. Return to Clip mode in the 
Node Editor to tweak any inconsistencies revealed in the group grade.

When you’ve completed these exercises, open the Project 03 - The Long Workday  
Commercial COMPLETED.drp and review Lesson 07 Timeline COMPLETED to compare 
your work with this “solved” timeline. If the media appears offline, click the red Relink 
Media button in the upper-left corner of the media pool and specify the location of the 
Project 03 media on your workstation.
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Lesson Review
1 True or false? A clip can belong to more than one group.

2 Which group level is ideal for performing shot matching?

3 True or false? Placing clips into groups allows you to bypass the normalizing/balancing 
stages of the grading workflow.

4 Which Magic Mask feature can be used to mask a pair of gym shorts?

5 How is data burn-in enabled?
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Answers
1 False. A clip can have only one pre-clip and post-clip Node Editor mode. Adding a clip 

to a group will remove it from any previous group it was in. 

2 Clip mode is ideal for performing shot matching.

3 False. If the clips in a group do not match each other, their differences will remain even 
when a group grade is applied.

4 Gym shorts will be best tracked using Person Mask set to Features mode, with Clothing 
(Bottom) selected in the pop-up menu.

5 Choose Workspace > Data Burn-In.
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Understanding Timeline 
Resolutions and Sizing 
Palette Modes
In the following set of exercises, you will address the variety of ways in which you can 
impact the frame of your project in DaVinci Resolve 18. Specifically, you will change the 
project resolution, reframe individual shots, and sample portions of an image at the 
node level.

Changing Timeline Resolutions
In this exercise, you will change the project resolution to evaluate how doing so impacts 
the image quality and secondary grades of the clips in your timeline. 

1 Select clip 05 on the Project 03 - The Long Workday timeline.

2 Create a new node called Vignette.

3 In the Window palette, apply the Vignette preset from lesson 3. Reposition and resize 
it to focus on the man at the window.
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4 Drag the Gamma master wheel left to darken the edges of the frame and then drag 
the color wheel control point toward blue/cyan to give the room a cool atmosphere.

5 Open the Project Settings and choose the Master Settings tab.

6 Change the Timeline resolution to 3840 x 2160 Ultra HD, which is a standardized 4K 
resolution with the same aspect ratio (1.77:1) as 1920 x 1080 HD.

TIP When rescaling media to a higher resolution (for example, converting 
720p content to a 1080p timeline or 1080p to a 4K timeline), you can activate 
a high-quality upscaling feature called Super Scale. To do so, right-click a lower-
resolution clip in the media pool and choose Clip Attributes. In the Video tab, in 
the Super Scale pop-up menu, choose 2x (or higher) to double the resolution. 
Doing so will substantially improve the method by which the image is upscaled 
in higher-resolution projects, although it is a processor-intensive operation that 
may compromise real-time playback.
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7 Click Save to exit the Project Settings.

8 If the video appears zoomed in, press Shift-Z to fit the video frame to the viewer panel.

1920 x 1080 3840 x 2160

Compare the difference between the two resolutions. Note that the clip’s frame 
and positioning in the viewer has not changed. Additionally, the vignette window is 
rescaled to the new resolution while maintaining the placement in relation to the 
media clip. The only evidence of change is the new anchor handle length in the center 
of the Power Window.

This behavior is one of the most invaluable features of DaVinci Resolve when grading 
and applying effects. The program is resolution independent, which allows you to 
change the frame size and aspect ratio of a project without affecting the positions 
of clips, images, secondary grades, effects, and generators created on the cut, edit, 
Fusion, or color pages.

9 Open the Project Settings and reset the Timeline resolution to 1920 x 1080 HD.

10 Delete the Vignette node.

4K to 1080p to 4K Workflow
Switching the timeline resolution is an effective method for optimizing workstation 
performance during editing. It ensures that clips are rendered and played in 
real time without lag and without altering the quality of the final film. A common 
workflow for 4K footage is to set the timeline to 2K or 1920 x 1080 during the 
editing process, and then reset it to 4K prior to rendering. 

Be aware that the grading potential, as well as the accuracy, of key-dependent 
secondary grading tools (such as the qualifier) is reduced at a lower image 
resolution. Therefore, you are advised to change the timeline to the full media 
resolution before grading.
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Reframing Individual Clips
The Sizing palette becomes an increasingly versatile tool when you take advantage of 
its sizing modes. These modes allow you to switch the sizing focus from clips to entire 
timelines or to individual nodes. In this exercise, you will rescale and reposition clips on 
an individual and timeline basis.

1 Select clip 15.

To ensure good playback during this exercise, you will temporarily disable the 
processor-intensive Track node.

2 Select the Track node (node 02) and press Command-D (macOS) or Ctrl-D (Windows) 
to disable it.

The Balance node features much lighter primary grading adjustments and can be left 
as it is for the reframing exercises.

3 Enter the Sizing palette and set the Zoom value to 1.500 to scale up the image.

4 Select clip 12.

Notice that clip 12 was not affected by the reframing of clip 15. In fact, every clip in the 
timeline has remained unchanged because clip 15 was changed at the clip level (Input 
Sizing) in the Sizing palette.

5 Return to clip 15 and reset the Sizing palette.

6 In the upper right of the Sizing palette, choose Output Sizing.

7 Set the Zoom value to 1.500 again.

8 Click the other clips in the timeline to verify that they were altered by the 
change in scale.

Sometimes, rescaling makes sense on a timeline-wide basis, such as when 
appropriating media to a different resolution. However, reframing tends to be much 
more specific to the visual content of each shot.

Let’s reframe shots 12 and 15 based on content.

9 Change the Sizing palette mode back to Input Sizing.

10 In clip 15, change Pan to 45.00 and Tilt to 50.00.
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11 In clip 12, change Pan to -70.00 and Tilt to 150.00.

12 Switch between the clips to verify that they have retained their Output Sizing zoom but 
have adopted different pan and tilt values.

NOTE Output sizing is also commonly used to adapt footage with a different 
aspect ratio to a new standard—for example 4K DCI will appear to have 
horizontal blanking (black bars) in a 4K UHD timeline. Output sizing can be used 
to quickly fill the frame of the video.

These changes made use of two modes (Input and Output) of the Sizing palette. 
Previously, you rescaled and reframed a wiped still using the Reference Sizing mode.

The full list of sizing modes and their impact on the image is as follows:

 — Edit Sizing reflects the transform changes applied to a clip in the Inspector of the 
edit page.

 — Input Sizing applies transform changes to a clip in the color page. It targets clips 
on the same level as Edit Sizing but isolates the function to the color page.

 — Output Sizing applies to the entire timeline.

 — Node Sizing applies to the selected node in the Node Editor.

 — Reference Sizing applies to the reference movie or still that is active in the viewer’s 
wipe mode.

TIP To apply blanking to your timeline, click Timeline > Output Blanking and 
choose an aspect ratio. This method permits you to change the project aspect 
ratio while preserving the original video resolution of the timeline.
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Custom Resolutions and Aspect Ratios
Under the Timeline resolution presets of the Project Settings, you may enter a 
custom resolution that will result in a non-standard video resolution at the aspect 
ratio of your choosing. Be aware that changing the aspect ratio or resolution to a 
non-industry standard could mean that the rendered video may not be playable 
on some projectors or video players. When outputting to equipment that only 
recognizes standard video formats, it’s safer to use a common (preset) resolution 
and apply custom blanking to change the aspect ratio. In either case, the custom 
blanking will appear as black bars during playback.

Sampling Visual Data with Node Sizing
The ability to change an image’s sizing data at the node level allows for some interesting 
creative (and practical) applications. You could clone an image to display multiple versions 
of itself within the viewer or fix continuity errors by sampling portions of the image for 
cover-up work.

In the following exercise, you will use node sizing to produce a dynamic layered look 
in a shot.

1 Reset the Input and Output sizing data from the previous exercise.

2 Select clip 15.

3 In the Node Editor’s Clip mode, create a new serial node called Backplate.

4 Press Option-L (macOS) or Alt-L (Windows) to create a layer mixer and label the new 
node Crop.

5 Open the Window palette.

6 Activate a linear window and reposition the corners to frame the front half of the car.
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7 Change all the Softness values to 0.00 to give the window a sharp edge.

8 Open the Sizing palette and set it to Node Sizing mode. From now on, all changes to 
the Sizing palette will affect only the Crop node.

9 Change the Zoom to 2.0 to scale up the linear window and its contents. 

The backplate remains unchanged.

10 Pan the window (375.000) until you can no longer see the backplate to the right of 
the viewer.

11 Tilt the window upward (300.000) to see more of the road in the scaled-up node.

12 Select the Backplate node.

13 In the Sizing palette, pan the image left (-300.000) to place the car in the left half 
of the viewer.

14 Select the Crop node again to begin grading the car close-up.
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15 Drag the Offset wheel toward blue to give the shot a cool metallic look.

16 Drag the Lift wheel toward red to slightly offset the blue in the shadows.

17 Drag the Gain master wheel right to brighten the highlights.

18 Play the clip to view the two versions of the footage simultaneously.

In layer-based compositing systems, this effect would be possible only by creating a 
second video track, duplicating the clip over itself, and applying a crop tool. Due to its 
less efficient method of reusing video data, layer-based compositing tends to be more 
processor-intensive. Nodes provide a much cleaner approach to the duplication and 
resampling of RGB signals.

Creating Cover-Ups with 
the Patch Replacer Effect
You can also use node sizing for more practical compositing solutions, such as sampling a 
portion of the video to cover up an undesirable artifact. This type of painting or cover-up 
work is often used to fix continuity errors, conceal visible booms, and improve set design.

In this exercise, you will use the more sophisticated Patch Replacer effect to quickly 
perform cover-up work and automatically adjust the grade of the sampled area to match 
the destination.

NOTE DaVinci Resolve Studio is required to complete the following exercise.
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1 Select clip 05.

This is a visually interesting shot with good set design and a great choice of 
location. However, one minor element is distracting from the luxurious office: the 
wall thermostat. Your aim is to remove the thermostat by covering it with a sample 
of the wall.

2 Create a new serial node and label it Coverup.

3 Open the Effects panel.

4 From the Resolve FX Revival category, drag the Patch Replacer effect onto the 
Coverup node.

Two oval outlines appear in the viewer. The left oval represents the source patch, which 
is actively sampling the portion of the video under it. The right oval is the target patch, 
which is receiving visual data from the source and actively grading it to match its 
surroundings.

5 Drag the target patch over the wall and resize it to outline the thermostat and 
its shadow.

6 Drag the source patch over an empty area of the wall near the target.
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7 If necessary, zoom in inside the viewer to refine the placements.

TIP To navigate inside the viewer after zooming in, hold down your middle 
mouse button and drag. If you do not have a middle mouse button, you can 
Ctrl-scroll (macOS) or Command-scroll (Windows) and Shift-Command-scroll 
(macOS) or Shift-Ctrl-scroll (Windows) to move vertically and horizontally in 
the viewer.

8 In the Patch Replacer Settings, select Keep Original Detail to assess the position of 
the thermostat behind the target window. Ensure that the circle outline completely 
encompasses the thermostat and its shadow.

9 Press Shift-Z to fit the video frame to the viewer panel.

The cover-up is successful, but only on the first frame of the clip. As soon as you play 
the video, the thermostat moves with the camera while the target patch remains 
static. To complete the composite, you will need to track the effect to the motion of 
the camera.

10 Drag the playhead to the first frame of the clip.

11 Open the Tracker palette and in the upper-right corner set the mode to FX. 

To perform motion tracking, you will need to specify a tracking point. Ideally, you 
want to define the element you are covering up or a trackable area that is on the 
same plane as that element. In the case of this clip, the original thermostat is an ideal 
tracking point.
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12 In the lower-left corner of the Tracker palette, click the Add Tracker Point button.

Blue crosshairs appear in the center of the frame. These crosshairs indicate the area 
of the image that will be analyzed for tracking.

13 Drag the crosshairs over the thermostat on the wall.

The crosshairs turn red when the default position is altered.

14 In the Tracker palette, click the Track Forward button to perform the track analysis.

15 After tracking is completed, deselect Keep Original Detail to bring back the target 
patch cover-up.

16 If necessary, turn off the viewer onscreen controls to hide the tracking point and 
patch outlines.
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17 Play the clip to check the accuracy of the cover-up. Make further adjustments to the 
size and placement of the source and target patches, if necessary.

The result is a clean cover-up of the wall that is ready for further editing and grading.

TIP You can also perform this type of cover-up effect using node sizing. With a 
backplate node in place, create a layer node and use a Power Window to sample 
a clean portion of the video. In the Sizing palette, move the layer node over the 
portion of the image you want to cover up. In the case of moving camera shots, 
begin the workflow by tracking the video with the standard window tracker before 
moving the Power Window over the sample area.

Node-based cover-ups are frequently employed to address the aesthetic needs of a scene 
or to resolve issues that were not noticed during the shoot (for example, removal of visible 
set equipment). These workflows tend to work best on footage with limited movement and 
good sample areas.

TIP Another tool that you can use for cover-up work is the Object Removal effect 
(also in the Resolve FX Revival category). Whereas the Patch Replacer samples data 
from the current video frame, Object Removal uses the data from surrounding 
frames to cover up a moving object. To remove an object, first draw a Power 
Window around it and track it through the shot. Then, drag the Object Removal 
effect onto that node. Click Scene Analysis in the settings and wait. If the object 
you’re removing is in motion, but the camera is locked, enable Assume No Motion. 
If enough visual data is available, the object will be successfully removed.

Using Keyframes 
to Animate Grades 
To understand keyframing, you need only to grasp the concept that you need just two 
keyframes to create animation. And those keyframes need to communicate just two things 
to the program: their points in time and their values. By placing the keyframes at different 
points in the timeline, you indicate the length of time through which the change occurs, 
and by giving those keyframes individual values, you specify the nature of the change.
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Animating Position Values with 
Dynamic Keyframes
Dynamic keyframes uniformly adjust parameter values across frames, creating the effect 
of smooth, consistent change over time. In this exercise, you will animate the transform 
values and color grade of a clip to imitate a camera move and sunrise effect.

1 Select clip 01.

This video was captured late in the evening and appears very dark. Before you can 
begin grading it creatively, you should expand its luminance range to take advantage 
of the available colors and contrast. You will use a similar process to the mountain 
range exercise in Lesson 1, where you combined color and log wheels to target and 
expand a dark range of an image.

2 Label node 01 as Normal.

3 Drag the Gamma master wheel right (0.25) to increase the waveform spread, and then 
drag the Shadow master wheel right (0.20) to further brighten the dark foreground. 
These steps reveal some substantial digital noise, which will be addressed after the 
grade is completed.

The clip is a locked establishing shot. Even though it was captured in real-time, it has a 
time lapse feel to it. In the next few exercises, you will use animation to imitate the fast 
passage of time.

Your first goal is to create a pan-and-zoom motion starting from the original wide shot 
and ending on a close-up of the city skyline.
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4 To the right of the palettes in the color page, open the Keyframes Editor.

The palette currently features two animation categories: the individual controls for 
node 01 (Corrector 1) and the Sizing values of the overall clip.

5 Create a new serial node and label it Sunrise. Corrector 2 appears in the 
Keyframes sidebar.

Each new node you create will receive its own corrector header and controls in the 
Keyframes Editor.

6 Click the disclosure arrow next to Sizing to expand the category controls.

7 Click the diamond-shaped keyframe symbol next to Input Sizing to activate animation 
in that parameter. 

From now on, any changes you make to the clip will be logged as dynamic keyframes.

8 While on the first frame of the clip, right-click the circular keyframe next to Input Sizing 
and choose Change to Dynamic Keyframe to convert the default static keyframe to a 
dynamic one.

The circular keyframe becomes diamond shaped.

9 Drag the playhead to the end of the clip duration in the Keyframes timeline.
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10 With the Sizing palette in Input Sizing mode, change the Zoom to 1.500, the Pan to 
-400.000, and the Tilt to -200.000.

Two new dynamic keyframes are automatically added to the Keyframes timeline—
one for the Input Sizing parameter, and one for the general Sizing header in which it 
is contained. Additionally, two dimmed triangles indicate that a dynamic animation has 
been generated.

11 Play the clip to watch the animation in action. The shot begins with a wide view of the 
city and then zooms in on the skyline in the distance.

TIP If you click the Loop button in the viewer playback controls, the playhead 
will play the same clip over and over instead of continuing to the next clip.

Changing Color Values Over Time 
with Dynamic Keyframes
Next, to animate the color values of the clip, you’ll target the node’s corrector controls.

1 Drag the playhead to the first frame of clip 01.

TIP Press the [ (left bracket) and ] (right bracket) keys to navigate between 
keyframes in the Keyframes palette. This shortcut can save you time when 
comparing the different stages of an animation.

2 Select node 02 (Sunrise).

3 In the Keyframes palette, expand Corrector 2.

4 Click the keyframe symbol next to Color Corrector to activate keyframing.

To imitate the look of the sun rising, you will first need to create a pre-dawn look.
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5 Drag the Gamma master wheel left to darken the midtone ranges of the image, 
and then drag the Gamma color wheel toward blue to imitate a cool night color 
temperature.

6 Reduce saturation to 35.00 to imitate the limited perception of color in 
dark environments.

7 Drag the playhead to the last frame of the clip.

TIP You can click the Expand button in the upper-right corner of the Keyframes 
Editor to increase the interface size. Doing so will move all other palettes to the 
left of the color page, giving you more room to focus on keyframing.

You will now create the post-sunrise look in the same node.

8 Return the Saturation to 50.0 to bring back the original colors to the scene.

9 In the Primaries palette, click the reset arrow in the upper right of the Gamma wheel to 
remove the dark blue look.

10 Increase the Contrast (1.300) to create a silhouette effect on the skyline.
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11 Drag the Gain color wheel toward yellow to warm up the image.

12 Increase the Highlights (50.00) in the adjustment controls to brighten the sunlight on 
the horizon.

TIP The Highlights and Shadows parameters in the adjustment controls 
feature unique tonal ranges that are designed for better retrieval of detail 
from the highlights and shadows of an image. To study their impact, add a 
compounded grayscale generator at the end of the timeline and drag these 
ranges to identify their range and overlap.

13 Play the clip to see the colors animate over time.

A common reason for keyframing color grades is to address color temperature 
fluctuation. Shoots in which the camera operator might maneuver from indoor 
to outdoor locations (documentaries, wedding videography, and so on) benefit greatly 
from these types of animated grade workflows.

TIP Resolve FX can also be keyframed. When an effect is added directly to a 
pipeline, it will appear under its own name in the Keyframes palette sidebar. 
When an effect is dragged onto a regular corrector node, it will appear in the 
list under the respective corrector header.
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Applying Dynamic Attributes
The animation in this exercise was created successfully, but the zooming motion appears 
a little artificial because of the linear nature of the animation. In this exercise, you will 
simulate a more realistic camera zoom by altering the animation speed and style using 
dynamic attributes.

1 Drag the playhead to the first frame of clip 01.

2 Right-click the first keyframe in the Input Sizing parameter.

3 Choose Change Dynamic Attributes.

The dynamic attributes interface controls animation behavior from the frame directly 
under the playhead to the next frame.
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4 Set the Start Dissolve value to 2. The almost-horizontal shape of the line at the start 
indicates that the animation will be slow and gradual before it accelerates and finishes 
in a linear fashion.

5 Click OK to confirm the change.

6 Play the clip and note the slow start to the animation. This small change makes the 
simulated zooming effect more realistic, as if a camera operator was slowly rotating 
the lens zoom and then sped it up toward the end.

Keyframe animation can take some getting used to, but in time, and with consistent 
practice, generating keyframes and animating changes can become a common part of 
your grading workflow.

Using Static Keyframes
When creating a new keyframe in the editor, the alternative to dynamic keyframes 
are static keyframes. Static keyframes don’t animate the change between values; 
instead, they abruptly change the value when the playhead reaches them.

You can combine static and dynamic keyframes within a single animation, such 
as when a change needs to be gradual but then abruptly appear/disappear at the 
start or end of the animation—for example, a lightbulb that turns on abruptly and 
then gradually increases in brightness and temperature over time.
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Applying Noise Reduction
DaVinci Resolve’s noise reduction feature runs on a powerful video engine that can 
distinguish noise from environmental data by performing a temporal analysis of the 
video frames. This feature allows for a strong reduction of noise while preserving a 
high level of detail in the subjects of an image. Applying the additional spatial method 
of noise reduction further cleans up the image by analyzing and removing repeating 
noise patterns.

NOTE DaVinci Resolve Studio is required to complete the following exercise.

1 Continue to work on clip 01 in the Project 03 - The Long Workday timeline.

2 Drag the playhead to the last frame of the clip to work on the scene at its brightest.

Because of the low-light conditions in which this footage was captured, the 
brightening of the gamma has revealed digital noise in the shadows and midtones.

3 For a better view of the noise detail in the image, increase the viewer Zoom (between 
100%–150%).

4 Create a new serial node after Sunrise (node 03) and label it Denoise.
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5 Open the Motion Effects palette.

This palette is divided into three control areas:

 — Temporal NR analyzes the video across several frames to detect moving subjects 
and backgrounds. It excludes moving elements from the most aggressive noise 
reduction processing to prevent unwanted blurring of vital information.

 — Spatial NR softens high-frequency noise while retaining the data in levels of high 
detail. This tool is extremely effective for reducing fine-grain noise that Temporal 
NR missed.

 — Motion Blur is not a noise-reduction tool but uses the same analytical engine 
as Temporal NR to produce its results. This tool helps make action shots more 
dynamic by adding artificial motion blur to moving subjects.

6 Under Temporal NR, you will first need to choose the number of frames that will be 
averaged to separate the subject detail from the noise. For this shot, which features no 
camera movement or moving subjects, an analysis of 2 frames is sufficient.

The higher the number, the more accurate the analysis will be, but at the expense of 
extra processing time. However, a higher analysis rate could also produce artifacts in 
shots with overlapping moving subjects.

7 The Mo. Est. Type (Motion Estimation Type) setting enables you to indicate the method 
used to detect motion in the image. A setting of Faster prioritizes speed of output over 
quality, whereas Better produces a finer result at the expense of extra processing 
time. When there is no movement in a shot, choose None to exclude motion analysis 
from the result and apply noise reduction to the entire image.

For clip 01, choose Better. This will prevent the ripples in the water from being too 
aggressively denoised and will take into account the Input Sizing animation.

8 Motion Range allows you to indicate the speed at which the subjects are moving to 
exclude areas with motion blur from the noise reduction effect.

Clip 01 has almost no motion, so Small is a good choice.
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9 The Temporal Threshold controls how aggressively noise reduction is applied to 
luma and chroma levels. By default, these options are linked, but if the image has 
monochromatic noise (or vice versa), it’s advisable to unlink the two parameters and 
target the luma/chroma noise directly.

This setting will activate noise reduction in the image, so you can begin by entering 
any number and then dragging left or right to increase or decrease the effect.

Enter 15.0 as the starting Threshold.

10 To see how much the Temporal NR is affecting the image, you can use the Highlight 
tool to assess the pixel difference.

In the viewer, enable Highlight mode.

11 In the upper right of the viewer, click the A/B icon to activate the Difference mode.

The patterns you see in the viewer show the amount of noise that has been removed 
from the original image.

12 When you start to recognize the dark outlines of objects in the noise pattern, it is an 
indication that the noise reduction has become so aggressive that it is now removing 
legitimate visual information.

Drag the Threshold left (5.0) until only noise remains.

Good noise reduction Overly aggressive noise reduction

13 The Motion value acts as a pivot for the point at which moving objects are excluded 
from noise reduction. A lower value excludes larger areas of the image, whereas a 
higher value assumes less motion and targets more of the image.

Very little motion occurs in the image, so a high Motion value of 60.0 is appropriate.

14 The Blend value allows you to blend the original image back into the noise-reduced 
version. This adjustment can be helpful when noise reduction gets too aggressive, and 
areas of the image take on a plastic appearance.

Leave Blend unchanged for this clip.
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15 Disable the Highlight view and toggle the Grade Bypass to compare the image before 
and after Temporal NR.

The noise reduction is substantial. However, you still have room for improvement by 
reducing the more generic noise patterns in the image.

NOTE Temporal NR avoids aggressive noise reduction in moving elements 
by analyzing the content of a scene. For this reason, it is optimal when applied 
to locked shots. In a shot with quick pans or handheld camera motion, every 
element will be moving, which partially defeats the purpose of the Temporal 
NR analysis.

16 Under Spatial NR, set the reduction mode to Better.

As with Motion Estimation Type, this setting is responsible for determining the speed/
quality of the final output; although, in this case, Faster, Better, and Enhanced all refer 
to different analysis algorithms. 

17 The Radius value indicates the area of the image that is analyzed to determine the 
noise type within the frame. 

To begin, set the Radius to Small. When reviewing the final result, switch between 
Radius sizes to check whether the Spatial NR is substantially improved. With most 
noise types, Small is sufficient.

18 As with the Temporal NR, the Luma and Chroma Threshold settings determine the 
intensity of the noise reduction.

Change the Luma and Chroma Threshold settings to 40.0 to see a further reduction in 
the remaining image noise.

Before noise reduction After noise reduction
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19 Press Command-D (macOS) or Ctrl-D (Windows) to bypass the Denoise node and 
compare the image before and after noise reduction. Pay particular attention to the 
preservation of the fine detail in the image—like the Ferris wheel spokes and the 
windows in the buildings of the skyline.

TIP Noise Reduction is available in the Effects Library under the Resolve FX 
Revival category and features all the same settings. You can use it to apply 
noise reduction to clips directly in the edit or cut page timelines.

Before moving on, it would be worthwhile to check whether changing the location of 
the Denoise node could improve the noise reduction.

20 Select the Denoise node and press E to extract it from the pipeline.

21 Drag the Denoise node to the link between the RGB input and node 01 (Normal). 
Doing so will perform noise reduction on the original RGB signal before any grading or 
animation takes place.

In this instance, the change softens the impact of the noise reduction and produces a 
better visual output.

22 Disable the Denoise node before moving to the next exercise.

It’s always advisable to use a dedicated node for noise reduction. After the noise is 
reduced to a satisfactory level, you can opt to disable the Denoise node to reduce the 
amount of processing and caching that takes place while you proceed with the rest of the 
grading process. Bear in mind, however, that a substantially noise-reduced signal might 
have an observable impact on subsequent nodes, especially chroma- and luma-key based 
ones like the qualifier. In such cases, it is recommended to keep the Denoise node active to 
get a more accurate representation of your final look. 

Where Should You Place the Noise Reduction Node?
Applying NR at the start of the node tree is advisable because it analyzes and 
affects the original RGB data to reduce noise. However, this placement may 
potentially impact the precision of key-based selection tools (HSL curves or 
qualifier, for example) or introduce artifacting too early in the node pipeline.

Applying noise reduction at the end of the node tree can bypass these issues (if 
they are present) but can also result in a slightly less detailed image. When unsure, 
experiment with the placement of the NR node in the Node Editor until you find 
the optimal position.
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Optimizing Performance 
with Render Cache
Almost anyone who has done graphic-intensive work on a computer will be familiar with 
the frustration of experiencing lag when the workstation is incapable of processing the 
data in real time.

DaVinci Resolve offers a variety of methods for improving workstation performance. 
For example, by reducing the playback resolution, generating Proxy Media, or using 
transcoded media workflows, you can change the size of the footage to ensure faster 
playback during editing and grading.

Another powerful method for increasing playback speed is allowing DaVinci Resolve to 
render your footage while the application is otherwise inactive. You can then play the 
cached media without the need to render effects-heavy clips in real time. The caching 
mechanism in DaVinci Resolve is made up of three independent stages that prompt 
a render based on various criteria. This allows DaVinci Resolve to monitor each clip 
and timeline and only cache renders when they meet one or more of the cache level 
requirements. In order, these levels are: 

 — Fusion Output Caching

 — Node Caching 

 — Color Output Caching (optional)

 — Sequence Caching

Enabling Smart Cache
Caching in DaVinci Resolve can occur on the timeline, clip, or even on the node level. 
Additionally, cache rendering can occur automatically, if meeting the criteria determined by 
the Smart Cache feature, or manually, as determined by the user. You will experience most 
of these cache levels in the next few exercises.

1 Enter the edit page.

2 If you have not done so in Lesson 7, enable caching by choosing Playback > Render 
Cache > Smart.

The first level at which caching takes place is known as Fusion Output Caching, 
previously known as source caching. Its name refers to the position in the video 
signal’s order of operations that prompts the cache. After media is imported and 
added to a timeline, its signal flows from the edit page to the Fusion page and is then 
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routed back to the edit page at the end of the Fusion pipeline, prompting this first 
caching stage. When in Smart Cache mode, Fusion Output Caches are generated 
for processor-intensive video media codecs such as H.265/HEVC and most raw 
camera formats. 

The Project 03 - The Long Workday timeline uses media compressed in an 
intermediary codec (DNxHR) that is already optimized for editing; therefore, the 
program is able to play it in real time without triggering Fusion Output Cache. You’ll 
have a chance to observe this level of caching in Lesson 9, where you will be working 
with raw media.

Generating a Node Cache
Node caching occurs in the Node Editor of the color page after the application of grades 
and effects. Like with Fusion Output Caching, when Smart Cache is enabled, rendering 
occurs only when DaVinci Resolve deems the node processes to be intensive.

1 Enter the color page.

2 In the interface toolbar, ensure that the Timeline button is enabled. This will display the 
Mini timeline, in which you can observe the video tracks and cache processes.

3 Select clip 01 in the Thumbnail timeline.

4 The Denoise node was disabled in the previous exercise. Click the Denoise node name 
to enable it.

The timecode above the clip thumbnail turns red to indicate that it is in the process 
of caching. In the Node Editor, the Denoise node name and number turn red for the 
same reason.

The cache line in the Mini timeline will eventually turn blue as caching is completed.

5 In the Motion Effects palette, raise the Spatial Threshold by 1 point (41.0).
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This prompts a re-cache of the entire node. With caching enabled, the smallest change 
to any cache-qualifying element will always prompt a re-cache, as the program needs 
to produce a new rendered version of the video with the new effect parameters.

NOTE If the node fails to render and turn blue, it’s possible that the project 
does not have a cache location. To fix this, enter the Project Settings, and in the 
Master Settings, scroll down to the Working Folders. Ensure that the Cache files 
location is set up and has write access.

You will now observe how changes to the node pipeline impact cached nodes.

6 Create a serial node after the Sunrise node and label it BW (node 04).

7 In the adjustment controls, drag the Sat value to 0.

Your image retains its sunrise animation, although it is now black and white. The BW 
node does not turn red and will not require node caching because the standard 
color grading tools in the color page are usually not intensive enough to disrupt 
clip playback.

Adding the BW node has also not forced a re-cache of the Denoise node because 
the noise reduction tool is not affected by changes made down the pipeline. If you 
follow the path of the RGB signal, it is denoised before it is desaturated, so the same 
denoised version of the cached render can continue to be used.

8 Click the Denoise node and press E to extract it.

9 Drag the node over the connection line at the end of the pipeline to place it after 
the BW node.

The Denoise node turns red as it re-caches the new RGB signal.
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10 After the Denoise node turns blue, click the BW node and adjust the Contrast in 
either direction.

This time, the change prompts the Denoise node to turn red and begin re-caching. 
This is because the BW change affected the RGB input of the Denoise node, which 
must perform a new render using the modified RGB signal.

Observing Sequence Caching
After the Fusion Output and Node Caches, a Sequence Cache is prompted in the edit page 
when additional effects such as transitions, titles, or generators are applied to clips in 
the timeline.

1 Enter the edit page.

2 Open the Effects Library panel.

3 In the Titles folder under Toolbox, locate the Text title generator.

4 Drag the title generator onto video track 2 and extend its length to cover the first five 
clips of the timeline.

5 In the upper right of the edit page, open the Inspector palette.

6 Click inside the text box under the Rich Text header and enter the project name 
The Long Workday.



300 Lesson 8 Adjusting Image Properties

A red line appears over the timeline to indicate that a render cache is being generated 
for all the media under the title tool.

7 Enter the color page.

Note that the sequence cache for the title generator is still visible in the Mini timeline. 
If you don’t want to see or cache edit page effects during your grading work, you can 
opt to disable them. 

8 Click V2 on the Mini timeline to hide the project name text and stop its sequence 
cache render.

Utilizing User Cache Modes
As you’ve seen, the decision to render clips and nodes on every level of the workflow is 
made by DaVinci Resolve’s background processes. This allows you to continue focusing on 
your project while Smart Cache detects when and if rendering is necessary.

However, at times, you might want to control which clips or nodes are rendered. For 
that, you can enable User Cache, which will not perform any media rendering until you 
specifically tell it to do so.

1 Choose Playback > Render Cache > User.

The blue highlights on clip 01 and the Denoise node disappear. From now on, all 
render caching will occur only on your command.
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Some colorists prefer to work in this mode when they don’t want background caching 
running through a whole project. One reason might be because they’re using raw 
media and want to cache only the clips they are actively working on instead of the 
entire timeline.

2 Select clip 01.

3 Right-click the Denoise node and choose Node Cache > On. Once again, caching is 
enabled, and the node name turns blue.

TIP When working on a larger project, you could use the Clips filter to 
isolate clips with noise reduction and manually cache them to avoid enabling 
Smart Cache.

In addition to selecting individual nodes in User Cache mode, you can manually render 
a clip’s entire node tree.

4 Select clip 05.

5 Right-click clip 05 and choose Render Cache Color Output.

The clip’s timecode turns red in the timeline while the nodes remain white. In this 
scenario, the entire node pipeline is cached, which results in even faster playback 
when compared to rendering individual nodes. However, it also means that making 
changes to any of the nodes in the pipeline will require the entire clip to be re-cached.

6 In the Node Editor, add a new serial node called Magenta Look.

7 Drag the Offset color wheel toward magenta to add color to the clip.

Although the process of adding color to a clip is not processor intensive, the clip’s 
timecode immediately turns red in the timeline because a new cache must be 
generated for the entire node pipeline.
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Configuring Cache Quality
When you play media in the viewers of the edit and color pages, you can see the playback 
frame rate in the GPU status indicator in the upper left of the viewer.

A green light indicates that the media is playing in real time. A red light indicates lag, 
with the numerical value displaying the actual playback frame rate. Caching should 
result in the GPU status indicator always displaying a green light during playback. If it 
does not, you should consider lowering the Timeline Proxy Resolution in the Playback 
menu or reducing the quality of the cache.

1 Open Project Settings and click the Master Settings tab.

2 Scroll down until you see the Optimized Media and Render Cache section.

The Render cache format field allows you to set up the quality and format of your 
cached data.

Lowering the cache quality will reduce your cache file size and prevent your hard drive 
from filling up too quickly. However, this setting will also lower the visual quality of the 
rendered media in your viewer. You should avoid reducing cache quality if precision of 
color, luminance, and key data is important.

Inversely, raising the cache quality will result in a faithful reproduction of your image 
data, at the expense of very large render files.

3 Set the Render cache format to one of the full quantization formats (444 or 4444).

Beneath the Render cache format menu are a few checkbox options.

You can specify the amount of time that needs to pass before background caching 
begins in Smart Cache mode. By default, the interval is 5 seconds, but you can increase 
the duration if you prefer to tweak your settings at a leisurely pace when grading.
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Additionally, you can enable automated transition and composite rendering when in 
User mode, which will mimic the behavior of Smart Cache mode.

4 Select “Automatically cache transitions in user mode.”

5 Click Save to exit the Project Settings.

Clearing a Cache
Although caching is triggered on multiple levels, only one cached file is ever active for 
each clip or transition. For example, if you apply noise reduction to a clip and then place 
text over it on the edit page, the active cache will be a rendered video with noise reduction 
and baked-in text. However, any further changes will prompt a new cache, which will 
replace the previous iteration on the timeline. The renders of the all the previous iterations 
will continue to be stored on your disc drive until you choose to clear your cache. You’ll 
want to clear your cache periodically to make room for more cache renders or to delete 
unnecessary materials from older projects.

1 Choose Playback > Delete Render Cache > Unused.

A prompt will ask you to confirm that you want to delete the unused cache.

2 Click Delete. The media in the timeline remains rendered, while all previous cached 
versions of the clips are removed from your drive.

Other options for deleting the render cache allow you to delete all cached media or 
selected clips on the timeline. It’s important to remember that no actual media is 
affected by clearing a cache, and even if you accidentally delete cached data that is 
currently being used in your project, it will be regenerated when it is next needed.

TIP Occasionally, you might come across a graphic anomaly in which the viewer in 
the color page is outputting visual data that does not match the changes you made 
to a clip. For example, a Media Offline message appears when you are certain the 
media is connected. Clearing the render cache will remove the program’s memory 
of the clip render and force it to re-render the clip correctly.
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NOTE By default, the Cache files location of the Working Folders is assigned to the 
topmost media storage location (Preferences > System) of your project library. To 
optimize playback, you might want to redirect the cache location to a drive other 
than the one that contains the DaVinci Resolve application and your project files.

Proxies and offline media are vital for a clean editing workflow, but their use is discouraged 
for the grading process because they often do not offer as accurate a representation of 
the image colors (or qualifier selections). Using Smart Cache with a high-quality render 
format will allow you to work faster and with more accuracy, making it the recommended 
optimization method.

Self-Guided Exercises
Complete the following exercises in the unfiltered Project 03 - The Long Workday timeline 
to test your understanding of the tools and workflows covered in this lesson.

Clip 02—Read the tip at the end of the “Creating Cover-Ups with the Patch Replacer Effect” 
exercise, and then use node sizing to cover up the speed limit signs at the top of the frame. 
For an added challenge, see how you can cover up these speed signs by drawing a Power 
Window directly over them, enabling Key Lock in the node sizing palette, and then panning 
the image.

Clip 08—Use dynamic and static keyframes to flicker the lights in the garage.

Clip 15—Create a node before the Balance node and apply noise reduction.

When you’ve completed these exercises, open the 
Project 03 - The Long Workday Commercial COMPLETED.drp and review Lesson 08 
Timeline COMPLETED to compare your work with this “solved” timeline. If the media 
appears offline, click the red Relink Media button in the upper-left corner of the media pool 
and specify the location of the Project 03 media on your workstation.
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Lesson Review
1 True or false? If you change the timeline resolution of a project, you will need to go 

over your secondary grade nodes and manually resize all the Power Windows to fit the 
new resolution.

2 Where can you animate the sizing and color properties of a clip?

3 What are dynamic keyframes?

4 True or false? Noise reduction should be applied only to node 01 of any clip.

5 Would adding a vignette to a clip cause Smart Cache to render the clip?
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Answers
1 False. DaVinci Resolve is resolution independent, so all secondary tools automatically 

resize to fit a new project resolution and aspect ratio.

2 You can animate the sizing and color properties of a clip in the Keyframes palette.

3 Dynamic keyframes are keyframes that gradually change a value between two 
points in time.

4 False. Noise reduction can be applied to any node in the pipeline, based on 
effectiveness.

5 No. Primary and secondary grading tools are not considered processor intensive 
enough to prompt a Smart Cache render. However, if the clip was set to Render Cache 
Color Output, any change, including a vignette, would trigger a re-cache.
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Lesson 9

Setting Up 
Raw Projects

Raw media refers to a variety of 
still and video image formats in 
which visual data is captured as an 
unprocessed digital signal. In its initial 
state, raw media does not have any 
visual properties. It is only through a 
processing method called debayering 
that you are able to assign a color 
space/gamut and gamma to the video 
signal to view it on a monitor. Raw 
media has far greater grading potential 
due to its wide dynamic range and 
uncompressed approach to pixel data.

In this lesson, you will work with 
Blackmagic RAW (.braw) clips. 
Blackmagic RAW offers the same 
grading latitude as other raw 
standards with the additional 
benefit of GPU-acceleration and 
partial debayering, which results in 
dramatically smaller file sizes and 
faster playback. 
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Adjusting Raw Settings 
at the Project Level
The color management exercises you completed in Lesson 4 demonstrated how you can 
configure a project’s color space/gamut and gamma to set up the starting point of a grade. 
Debayering raw footage works on a similar premise, although it’s a far more essential part 
of the grading process. Without it, the raw media could not be displayed in the viewer.

Raw format sensors are defined by their ability to record the radiometric properties of 
light. Rather than representing as a set of pixels with hard color data, raw formats record 
the light intensity of a scene within the geometry of the sensor’s individual photoreceptive 
elements, or photo sites. 

Each photo site has a filter that allows the capture of only one channel of color (with green 
captured at double the frequency of red and blue). Together, the filtered signals make up 
the Bayer filter mosaic that contains all the data necessary to recreate a digital image.

For this reason, raw files are sometimes referred to as digital negatives: visual information 
that contains a wide dynamic range of light that remains unviewable until it is processed. 
Debayering (also known as demosaicing) allows you to appoint values to the radiometric 
signals and produce a visible image in a designated color gamut and resolution.

In this lesson, you will work with Blackmagic RAW media. This raw format is unique in that 
it undergoes partial debayering in the camera hardware, which results in much smaller 
file sizes and its storage as a single video clip (as opposed to image sequences). This 
format allows for much faster playback, media management, and file transfer compared to 
traditional raw formats. 

Determining Whether Clips Are Raw
You can generally recognize the raw video file formats supported by 
DaVinci Resolve 18 by their file extensions (.ari, .braw, .cin, .dng, .crm, .rmf, .nef, 
.r3d, .vrw, and others). Additionally, you can check the codec and file type of any 
clip in the Metadata panel or the clip attributes of the contextual menu.

Another quick way to verify whether footage is raw (and supported by 
DaVinci Resolve 18) is to place it on a timeline and open the Camera Raw palette in 
the color page. If a selected clip is in a raw format, the palette becomes active and 
displays options for the Decode Quality and Decode Using fields. If the clip is not 
raw, the Camera Raw palette remains dimmed and inactive.
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NOTE The exercises in this lesson build on the tools and skills you learned in the 
previous sections of the book. If you skipped ahead to this lesson, you may need to 
review Lessons 1, 3, and 5 to gain a better understanding of primary and secondary 
grading and the Node Editor pipeline.

1 Open DaVinci Resolve 18.

2 Create a new project and name it Blackmagic RAW Project.

3 In the media page, create two bins in the media pool: Media and Timelines.

4 In the media storage browser, locate the BMD 18 CC - Project 03 folder and enter the 
Blackmagic RAW subfolder.

5 Open the Media folder and drag the four .braw clips into the Media bin.

NOTE When importing media, if a dialog appears informing you that your clips’ 
frame rates don’t match the project’s frame rates, click Change to adjust the 
project frame rate to accommodate the media.

6 Enter the edit page.

7 Set the media pool to List View and make sure the clips are sorted alphabetically in the 
Clip Name column. 

8 Select the four Blackmagic RAW clips. Right-click one of them and choose Create New 
Timeline Using Selected Clips.

9 Name the timeline Blackmagic RAW Timeline and place it in the Timelines bin.

10 Choose Playback > Render Cache > Smart. 
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The Fusion Output Caching process will begin immediately on the Blackmagic RAW 
clips. Unlike the media you’ve used in the previous lessons, raw formats are not 
intermediary and need constant debayering and caching.

Reviewing the clips in the timeline viewer, you will see that two of the clips have 
black bars at the top and bottom of the image. This is known as letterboxing and 
occurs when clips have a different aspect ratio to the timeline viewer. By default, 
DaVinci Resolve will scale media with mismatched resolutions in a way that preserves 
maximum video data. However, if you want all the clips to have the same framing, you 
can change your scaling options in the Project Settings. 

11 Open Project Settings and click the Image Scaling tab.

12 In the Input Scaling category, set “Mismatched resolution files” to “Scale full frame 
with crop”.

Before

After
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All imported media will now be scaled to fill the viewer frame. This happens at the 
expense of some cropping on the edges of the clips, but this data can still be retrieved 
using the Input sizing palette.

Next, you will set up the project color management.

13 In the Project Settings window, click the Color Management tab.

14 Set the Color Science to DaVinci YRGB Color Managed.

15 Deselect “Automatic color management.”

16 Set the Color processing mode to HDR DaVinci Wide Gamut Intermediate. This gamut 
is optimal for working with raw media, as it exceeds all current display standards.

17 Leave the Output color space as Rec.709 Gamma 2.4.

Finally, you will review the raw project settings.

18 In the Project Settings window, click the Camera RAW tab.

These parameters affect how raw footage is debayered on a project-wide basis.

19 Set RAW Profile to Blackmagic RAW to access the parameters for the clips in 
your timeline.

The Decode Quality is set to Full Res. (full resolution) by default, which means the 
raw media is debayered at its full format resolution (4K, in the case of the media in 
this project) and resized to the timeline resolution specified in the Master Settings. 
Changing the quality to Half or Quarter will substantially reduce the amount of 
processing required to play the footage (at the expense of the visual quality within the 
viewer/monitor) but is a viable option for slower systems.
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20 Leave the Decode Quality at Full Res. to continue debayering at the 1920 x 1080 HD 
resolution.

The Decode Using field allows you to specify how the color gamut of the raw signal 
is debayered. By default, it is set to Camera Metadata, which is the color standard 
set by the camera operator when capturing the media. Changing it to Blackmagic 
RAW Default will prompt it to use any associated sidecar files that contain additional 
information such as ISO, white balance, color temperature, contrast, and many others. 
Setting the decode method to Project will reveal the fully customizable project and 
camera metadata settings at the bottom of the window.

NOTE  A sidecar file contains descriptive metadata that can be associated 
with Blackmagic RAW media for look management in-camera and during 
post-production. You can generate a sidecar file to back up or share debayer 
settings and to preview rushes in the Blackmagic RAW player. As a rule, sidecar 
metadata files always take precedence over the embedded metadata in a .braw 
file. However, if the sidecar is deleted or moved, the decoding of the .braw file 
will fall back on the embedded metadata.

21 Leave Decode Using set to Camera Metadata (default) and click Save to exit the 
Project Settings.

22 Review the timeline to verify that the letterboxing has been removed and color 
management is enabled.

NOTE DaVinci Resolve automatically detects all supported raw formats. When 
color managing, you do not need to indicate the input color space of raw 
media, as it will be mapped automatically to your project’s working color space. 
Changes to the Camera RAW Project Settings will have an immediate effect on 
raw clips in the media pool and timeline, even when working with multiple raw 
profiles. Non-raw clips will not be affected.
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Different Methods of Setting Up Raw Projects
There is no single correct approach to the treatment of media prior to the start of the 
grading process. In the first part of this book, you began working on media without any 
special treatment. In Part 2, you enabled color management to automatically map log-
encoded source clips to the Rec.709 color space. In the final part, you took advantage 
of DaVinci Wide Gamut to both remap and future-proof a grading project. The 
following are some other common approaches when starting a new grading project in 
DaVinci Resolve, in particular when working with raw media:

Camera RAW Project Settings and palette—DaVinci Resolve automatically detects 
all supported raw media formats and debayers them accordingly. Additional controls in 
the Project Settings and Camera Raw palette allow you to tweak debayer parameters 
throughout a project or on each individual clip.

Lookup Tables (LUTs)—LUTs are digital files that transform color and tone pixel data 
from one state to another. Unlike other color management systems, LUTs assign 
specific RGB values during conversion, giving you identical results across applications. 
However, due to the finite number of values they can represent, parts of the raw 
signal are approximated during conversion, which can be limiting to the final grade. 
This makes them popular for dailies workflows, in which the integrity of the final video 
signal is not paramount. 

Color Space Transform (CST) and Gamut Mapping (GM) Resolve FX —Effects panel 
tools can be used to map the color and tonal data of clips or groups (on a pre-clip or 
post-clip Node Editor level). CST is often used to remap scenes with unique mapping 
requirements or placed at the end of the Timeline Node Editor pipeline to change the 
deliverable standard of a project when not using RCM. 

Resolve Color Management (RCM)—DaVinci Resolve’s internal mapping system 
allows you to indicate the color standard of your source media, set up a working 
timeline color space, and then change the output based on deliverable needs. 
Additional default parameters analyze and remap clip tonal data to produce optimal 
visual results and consistent grading behavior in the color page. 

Academy Color Encoding System (ACES)—ACES is a display-independent working 
color space being adopted as an industry standard in major production houses and 
streaming services. ACES can be enabled in the Color Management settings and 
operates similarly to RCM. Like DaVinci WG, its working gamut far exceeds current 
monitoring standards, which makes it ideal for producing masters, archives, and 
deliverables. Due to its focus on standardization, ACES parameter setup and delivery 
tends to be more rigid, aiming to produce an exact color space conversion rather than 
the visually focused RCM approach.

The decision to use one color approach over another can be based on several factors: 
source media, delivery format, monitoring setup, LUT access, and personal preference. 
In this lesson, you will continue to work with Resolve color management, with 
additional consideration given to the treatment of the raw signal on the color page via 
the Camera Raw palette.
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Adjusting Raw Settings 
at the Clip Level
You will often want to address the individual needs of clips when setting up raw media. 
Using the Camera Raw palette in the color page allows you to make adjustments on a clip-
by-clip basis. 

1 Enter the color page.

2 Select clip 01 (C001).

3 In the left palettes of the color page, open the Camera Raw palette.

4 Set Decode Using to Clip. Doing so will disassociate it from the Project Settings and 
allow you to work on the clip independently.

The Camera Raw palette gives you access to a variety of color, exposure, and gamma 
adjustments that will affect how the image is debayered on the timeline. In terms of 
the signal pipeline, debayering occurs before the video signal enters the RGB input of 
the Node Editor.

5 Color Science refers to the version of the color science in the camera at the time the 
footage was captured. Leave Color Science set to Gen 4 for all the clips in this timeline.

6 Change the ISO to 200.

Although the image has already been captured, you can still adjust the sensor 
sensitivity to better accommodate the starting point of your grade to the luminance in 
the scene. This feature is unique to raw media workflows.

7 Change the ISO back to 100.

8 Select the Highlight Recovery checkbox.
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Highlight Recovery will debayer highlight sensor data that is usually clipped in the 
standard decoding matrix. In raw clips with extreme waveform peaks, this option will 
often reveal additional visual data in the highlights.

Without Highlight Recovery With Highlight Recovery

9 Temperature is another property of light that can be adjusted during the debayer 
stage. Drag the Color Temp slider right (6000) to warm up the image.

10 To reset the Color Temp to the original setting used during filming, click the White 
Balance dropdown menu on the left and choose As Shot.

When working on a raw timeline, you will often want to customize multiple raw clips in 
a sequence. Two buttons at the bottom of the Camera Raw palette allow you to copy 
palette data: Use Settings and Use Changes.

 — Use Settings will apply all the Camera Raw settings from a selected clip to all 
highlighted clips on the timeline. This option is best used when working with media 
from the same source, with identical gamut and exposure needs.

 — Use Changes will ripple only the altered parameters, preserving the selected clips’ 
individual settings. This is ideal when working with visually diverse media that has 
unique ISO and Color Temp requirements.

11 With clip 01 still selected, Shift-click clip 04 to highlight all the clips in the timeline.

12 Click Use Changes in the Camera Raw palette. Because the only available parameters 
in clips 2–4 are the decode settings, all three clips will switch from Project to Clip 
decoding, while keeping all other clip settings unchanged.

TIP When saving stills from clips with manually adjusted Camera Raw settings, 
you can specify that you do not want their camera raw settings included in 
the still grade data. To enforce this, right-click in the gallery and choose Copy 
Grade: Preserve Camera Raw settings.
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13 Select clip 02 (C003).

The clip is a little dark but is otherwise in a good starting position for balancing and 
color grading. All its visual needs can be addressed using the standard primary 
grading tools. Leave the ISO at 800 and leave Highlight Recovery unselected. 

14 Select clip 03 (D007).

Reviewing the scopes will tell you that there is a substantial amount of highlight data 
crushed at the top of the waveform graph. It will be difficult to target that area of the 
signal while grading, so you need to take steps to spread the waveform downward.

15 Set the ISO to 200. This will darken the clip without damaging the shadows, and 
expand the highlights, making them easier to access.

Another method of adjusting signal brightness is to use the Exposure parameter 
in the central column of the Camera Raw palette. Decimal values will allow you 
to adjust exposure in smaller amounts than the whole values featured in the ISO 
dropdown menu. 

16 Lower the Exposure parameter (-0.80) to further reduce brightness and leave room for 
the highlights to be raised at the top of the waveform.

17 Select Highlight Recovery to reveal additional data outside the window.

18 Select clip 04 (E004).

This clip features a dark environment with unique lighting conditions. Although it 
might be tempting to address the shadows using the Camera Raw controls, dragging 
the Exposure value quickly reveals that it would not be possible to do so without 
severely distorting the image. This clip is already at its ideal starting point, and you can 
further optimize it using the primary grading tools.

With the clips successfully set up, you can proceed to grading in the Node Editor 
as usual. 

NOTE  The Color Space and Gamma parameters in the Camera Raw palette are 
disabled when working in a color managed project. This allows for consistent 
color output when changing between deliverable formats in the Project 
Settings. If you wish to assign unique output color spaces to your raw clips and 
adjust the Gamma Controls to the right of the Camera Raw palette, you will 
need to work in a display-referred environment with no color management.
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The Camera Raw palette is best used for addressing the unique exposure needs of raw 
media prior to grading. It is highly advisable to avoid balancing, correcting, or creating 
looks at this stage, because the Camera Raw palette leaves no evidence of such changes 
in the Node Editor. The standard grading tools in the color page impact raw media just 
as effectively and are far easier to keep track of in the node tree, which is important for 
minimizing instances of destructive grading.

Grading High Dynamic 
Range Media
One of the unique challenges of color grading high dynamic range (HDR) footage is 
targeting the wide tonal latitude of the available data. In a previous lesson, an overexposed 
sky had to be selected using secondary grading methods in order to make a luminance 
adjustment. Instances of such targeted tonal adjustment are much more frequent when 
shooting HDR and would ordinarily require extensive secondary grading to achieve a 
clean look. 

The High Dynamic Range (HDR) palette is a primary grading tool featuring color wheels 
mapped to customizable tonal ranges that can be used to grade the entire dynamic range 
of a raw image within a single interface.

Targeting Individual Tonal Ranges
As established, a major benefit of the HDR palette is its advanced tonal range control. 
Instead of relying on just three wheels to determine the placement of the highlights, 
midtones, and shadows, you can construct dynamic looks by adjusting each tonal step of 
the image independently. The gentle rolloff between the tonal ranges ensures that grades 
appear smooth and natural.

In this lesson, you will color grade a raw clip to gain an understanding of the HDR palette’s 
unique global and tonal range parameters.

1 Select clip 01 (C001).

2 Label node 01 as HDR Balance.
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3 In the left palettes, open the High Dynamic Range (HDR) palette, which is located next 
to the Primaries palette.

At first glance, this palette appears very similar to the Primaries color wheels. In fact, 
much of the operation remains the same—the control point in the center of the wheels 
is used to add color to a tonal range, while controls underneath determine exposure 
and saturation. 

One of the first major differences is the number of wheels you control. A row of 
buttons under the palette header allows you to navigate between the different tonal 
zone wheels. This action is called banking.

You can click the arrows on either side to bank wheels or click on the wheel icons 
themselves to jump one or more wheels at a time.

Another major difference is in the way the global wheel impacts the image. Whereas 
the Primaries offset wheel affects the image uniformly, the global wheel pinches the 
black and white points of the signal, rolling the shadows and highlights in order to 
compress, but never clip, either extreme of the waveform. As a result, adjustments 
to the exposure and saturation of a video signal have less effect in the shadows and 
highlights, which produces more natural-looking changes.

TIP The High Dynamic Range palette is designed for optimal performance with 
Resolve color management enabled. When RCM is enabled, the HDR palette 
adopts Color Space Aware behavior, meaning it automatically maps its own 
operational color space to the source image, producing perceptually uniform 
results while maintaining careful control of image saturation. However, you can 
still use the HDR palette without RCM enabled on both SDR and HDR media.

The Temp and Tint sliders on either side of the global color wheel are also uniquely 
mapped. They are designed to travel the image across the Planckian locus line, which 
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represents the temperature path of natural light in the CIE graph. This results in more 
natural temperature change in the image.

Although you will be familiar with the adjustment controls across the bottom of the 
palette, most of them exhibit behaviors unique to the HDR palette:

 — Temp and Tint are numeric representations of the global wheel sliders and can be 
used when you need more accuracy or to reset the values. 

 — Contrast and Pivot keep saturation perceptually constant when adjusted. This is 
advantageous for HDR grading, where high contrast can lead to oversaturation in 
the highlights.

 — Black Offset determines the minimum value of the video signal (i.e., the darkest 
shadow), while gently compressing the data above it. 

4 Begin the grading process by reviewing the waveform scope. 
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Overall, the trace looks good; there is no obvious clipping in the highlights or shadows. 
Much of the midtone data representing the foreground appears bunched near the 
bottom of the graph, resulting in flat, dark shadows. The top of the waveform appears 
compressed along a narrow range, limiting the detail you can see in the clouds. 
You will address both of these issues using the HDR palette.

5 The global wheel is a good starting point for establishing the overall exposure of a 
clip. Raise the Global Exp (0.60) parameter until the foreground portion of the trace 
reaches the middle of the scope graph.

6 To establish the overall image saturation, drag Sat (1.50) under the global wheel. 
Note that due to the unique global luminance mapping, saturation is not increased as 
aggressively in the foreground shadows or in the clouds.

With the global values set, you can move on to the individual tonal zones. The six 
default zone wheels are split into two categories: dark zones and light zones.

The graph above represents the order of the default zones in the palette and their 
respective tonal ranges. The closer to the edges you travel, the more dedicated the 
tonal zones become.

The Shadow and Light wheels have the broadest impact and overlap each other by a 
factor of two stops. They each have narrower tonal ranges within them that allow you 
to create contrast in the dark and light zones.

You will address the dark zones first.
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7 Bank the HDR palette wheels until you see the three dark tonal range color wheels: 
Black, Dark, and Shadow.

8 Drag the Dark wheel Exp (-0.20) to accentuate the shadows in the foreground bushes. 
This range is narrow enough not to impact most of the foreground midtones.

9 To enhance the foreground saturation, increase Sat (1.20) in the wider Shadow zone.

Next, you will work on the light zones to reveal the details in the sky.

10 Bank the HDR palette wheels until you see the three Light zone color wheels: Light, 
Highlight, and Specular.

To create room for expansion in the highlights, you must lower the top section of 
the waveform.

11 Drag the Highlight Exp (-1.60) left until the top of the waveform falls mostly along the 
third horizontal line from the top.

You now have room to expand the very top of the highlights.

12 Drag the Specular Exp (1.70) right to lift the top of the waveform trace, revealing fine 
cloud detail.

The default tonal range graph seen after step 6 shows that the Highlight and Specular 
zones both overlap the broad Light tonal range. This means you can use the Light zone 
to make broader exposure changes, while maintaining the established contrast in the 
narrower zones.

13 Drag the Light Exp (-0.70) left to darken the sky, while keeping the cloud detail intact. 
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14 Drag the Light color wheel control point slightly toward blue to add more color 
to the sky.

TIP In the HDR palette options menu, you can change the numeric 
representation of the control point position under the Exp parameter. 
Display X and Y allows you to adjust the control point horizontally and vertically. 
Display Angle and Strength will move the control point in a circular motion to 
determine hue and on a radius to determine saturation. These controls can be 
useful when you need to make very fine adjustments using the numeric fields 
instead of the color wheel control point.

Several options allow you to review and modify how the tonal zones affect the image. 

15 Click and hold the symbol next to the Light zone name to review which areas of the 
image are being impacted.

This quick preview allows you to check the tonal range impact and determine whether 
it needs adjustment.

In this case, the Light zone is affecting too much of the foreground and should 
be reduced.
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16 For a permanent view of the tonal zone selection, click the Highlight button in the 
upper left of the viewer. Highlight mode will display the selection of the tonal zone you 
are actively working on, leaving you free to make range and falloff adjustments.

NOTE When using the viewer’s Highlight mode with other tools, such as the 
qualifier, Power Windows, or Color Warper, ensure that the HDR palette is not 
active in the left palettes to avoid seeing a tonal zone selection instead.

Every zone color wheel is surrounded by two sliders: Min/Max Range and Falloff. The 
Min/Max Range slider determines the zone limit, while the Falloff gently fades the 
selection to avoid artifacting.

17 Drag the Light zone range slider up to 0.00. The selection in the viewer contracts to 
show mainly the sky.

18 Click the Highlight button to disable preview of the Light zone range.

With the majority of the tone adjustment work done, you can tweak some final 
adjustments.

19 Increase contrast (1.040) and pivot (2.000) to accentuate the details in the scene while 
keeping the saturation uniform.
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20 Increase midtone detail (20.00) to further sharpen the clouds and foreground data.

Before After

Let’s review the HDR Zone panel to better understand how the tonal zones were 
distributed across this image.

21 In the HDR palette header, click the Zones Graph button.

The Zones Graph is an additional panel in the HDR palette that allows you to further 
customize the tonal zones.

On the left is a sidebar featuring the names of the zones, which you can click to 
highlight their range indicator on the graph. Drag the indicator by the handle to 
change the minimum or maximum range of a zone. The range will impact the entire 
section in the direction of the handle arrow, with a falloff transition, which is indicated 
by the soft red line. You can also use the sliders beneath to adjust and reset the range 
and falloff values. These parameters are mapped to the sliders on either side of the 
zone color wheels in the Controls panel.
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Behind the graph is a histogram of the frame in the viewer. This histogram can be 
helpful for determining where range indicators should be placed and how soft the 
falloff should be. Note that if a histogram signal ends before the start of a range 
indicator, that zone will have no impact on the image when adjusted in the HDR 
palette. In this instance, there’s nothing to the left of the Black zone, meaning that 
changes to the Black zone color wheel, exposure, and saturation will have no impact 
on the image.

TIP From left to right, the HDR palette Zones Graph sidebar features additional 
controls that allow you to disable the impact of that particular zone, switch 
zones between light and dark, hide the zone indicator in the graph, or delete a 
zone (for custom zones only).

Correcting Scenes with 
a Wide Dynamic Range
Scenes captured with HDR sometimes feature a dramatic shift in exposure over different 
areas of the same frame—common examples include windows in an interior scene or 
when shooting someone against a light source. With standard correction tools, you would 
need to use a combination of secondary grading techniques to get an optimal result. 
The HDR grading palette allows you to address a range of exposure levels using just one 
primary tool.

1 In the HDR palette header, return to the Controls panel (color wheels).

2 Select clip 03 (D007).
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In a previous exercise, you changed how this scene was debayered in the Camera Raw 
palette to better distribute the signal for grading. The resulting image features a dark 
interior with bright windows. Your first priority will be to restore the interior, which is 
predominantly where the audience will be looking.

3 Label node 01 as HDR balance. 

4 Establish the overall scene brightness by raising the Global Exp (2.40). Aim to place the 
majority of the waveform trace just below the midtone range of the scope graph.

When you finish adjusting the global wheel at the start of a grading process, you 
have the option of banking it together with the other wheels so that your palette can 
represent four unique tonal zones at once.

5 Click the options menu in the upper-right corner and select Bank Global with 
Color Wheels. If needed, you can still access the global wheel by banking to the 
rightmost wheels.

Before continuing, you will review how the HDR palette tonal ranges are distributed 
across this image. 

6 To open the Zones panel without hiding the HDR color wheels, click the Expand button 
in the HDR palette header.

This action opens the Zones graph in the central palettes of the color page, allowing 
you to grade and modify the tonal ranges simultaneously.

TIP If you cannot see a histogram projected in the Zones graph, adjust one of 
the HDR palette parameters or move the playhead slightly in the viewer. This 
will force the histogram to be cached.
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Overall, the tonal range layout and distribution appears appropriate for the scene’s 
histogram, which is evenly spread through the graph. Because the window and the 
light spill in the room compose a smaller portion of the image than the interior, you will 
likely need to adjust the Light range at some point. However, it’s too early to determine 
how the Light zone should be defined, so you’ll return to make adjustments later.

TIP You can create a custom zone in the HDR palette by clicking Create New 
Zone at the bottom of the Zones panel sidebar. Like the preset zones, a custom 
zone can be defined as either light or dark and will appear as a color wheel with 
unique range and falloff parameters in the Controls panel.

7 Increase the Dark Exp (0.60) to brighten the shop interior.

Next, you will use the light zones to fix the overexposed window.

8 Lower the Light Exp (-5.50) until the waveform’s peak is between the top two lines in 
the scopes. 

9 Gently increase the Specular Exp (0.20) to restore some of the exterior highlights, 
creating contrast.

This fixes the issue of the overexposed window, although there is now elevated 
saturation in the red and orange objects outside. 

10 Reduce the Highlight Sat (0.60) to target the bright elements outside the shop.

With the Light zone being the broadest light tone range, you can adjust the Min Range 
to produce optimal distribution of the light spill inside the shop.

11 Select the Light range in the Zones panel sidebar and drag the Min Range value (-0.70) 
under the graph until the light spill in the shop appears more pronounced.

12 To remove any artifacting on the walls and floor, raise the Light range Falloff 
parameter (0.90) until the daylight spills smoothly across the shop surfaces.

TIP You can save a custom zone layout by opening the HDR palette options 
menu and selecting Save as New Preset. Zone presets can be helpful if 
you regularly process footage from the same camera with similar lighting 
compositions (such as interviews or set shoots).

Now make some final adjustments to complete the scene balance.
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13 Increase the Midtone Detail (50.00) to sharpen the details in the shop interior.

14 Reduce the Temp (-1500) and Tint (-5.00) to balance the color cast on the walls.

With the normalization and balancing complete, you can proceed to apply a creative 
grade as usual. 

15 Create a second node, and label it Look.

16 Use the Curves palette to create a warm look with cool shadows. You can accomplish 
this by drawing a reverse S-curve in the B channel and a standard S-curve in the R 
channel. To brighten the image, isolate the Y curve and drag upward from the middle. 

Before

After
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When outputting to an SDR standard, grading raw media is almost no different from 
grading non-raw media. The wide dynamic range demands increased attention and 
handling, but the creative primary and secondary workflows remain mostly the same.

When outputting to an HDR standard, special care must be given to the distribution 
of the waveform. Although there is some variety in industry approaches and 
individual colorist preferences, it’s generally considered a good idea not to overwhelm 
your audience with superbright elements. Aim to place the majority of midtone 
environments in the 100-nit range, allowing for some fluctuation to emphasize 
shadows and upper midtone detail. Reserve the areas above the 100-nit line for light 
sources and surfaces hit by direct sunlight.

Mapping the HDR Palette to Color Panels
The HDR palette is designed to be mapped to the DaVinci Resolve Advanced and 
Mini panels, even when incorporating custom tonal zones and presets.

Advanced panel: Press SHIFT + AUTO COLOR. All HDR palette controls will be 
mapped to the center panel soft buttons and rotaries, while the zones will be 
mapped to the trackballs and rings. Press the < and > soft keys to navigate all 
available zones.

Mini panel: Press USER and then press the HDR soft key above the left display. All 
HDR palette controls will be mapped to the soft keys and knobs, while the zones 
are mapped to the trackballs and rings. Press the PREV ZONE and NEXT ZONE soft 
keys to navigate all available zones.
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Setting Up a Render Cache 
for Raw Media Projects
In Lesson 8, you set up your project render cache to a full-quantization (444 or 4444), 
12-bit depth codec, but the exercise did not go into detail about the effect this had on the 
grading process. In this exercise, you will change the render cache quality to observe its 
impact on the image in the viewer and gain an understanding of why the render cache 
format really matters when working with raw video.

1 Select clip 01 (C001).

2 Open Project Settings and click the Master Settings tab.

3 Scroll down to the Optimized Media and Render Cache section and set the Render 
cache format to a lower-quality codec such as ProRes 422 Proxy (macOS) or DNxHR 
LB (Windows).

4 Click Save to close the Project Settings.

5 If caching is not enabled in your project, choose Playback > Render Cache > Smart. 
Wait until clip 01 is re-cached.

6 If you do not see a change in the viewer, drag the playhead slightly to refresh the 
active frame in the viewer.

Caching the raw video in a lower-quality format produces a distorted image with 
pronounced banding in the sky.
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Instead of a smooth blue gradient, the sky now appears to be made up of blue, 
purple, and gray stripes. This is the result of using a render cache format that can only 
represent a limited amount of luminance and color values. The impact is so severe that 
it is even visible in the waveform.

As well as being a poor representation of your grade, a low-quality render cache 
format can also interfere with your ability to accurately make qualifier selections or 
view the result of analytical tools, such as noise reduction or the Magic Mask. If you 
use a slightly higher-quality render cache format, you might experience significantly 
reduced artifacting in the viewer, but the image grading potential will still be 
compromised.

7 Open Project Settings and click the Master settings tab.

8 Set the Render cache format to one of the full-quantization (444 or 4444) or 
HDR formats.

9 Click Save to close the Project Settings.

TIP 12-bit depth codecs (such as DNxHR 444 and ProRes 4444) are HDR compliant 
and can be used for cinema and UHD 4K delivery.

Because of its high quality, you can use a 12-bit render cache in the final export 
of a project. When preparing the Render Settings in the deliver page, expand the 
Advanced Settings and select “Use render cached images.”
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When setting a render cache format, remember that it affects only what you see in the 
viewer. If you were to render a clip from the deliver page while caching in a low-quality 
codec, the exported image would not have banded gradients or clipped highlights. This 
makes it particularly important to set up a high-quality cache when grading HDR and high 
bit depth footage. If you don’t, your final project could end up looking very different from 
what you saw in the viewer.

The intermediary codecs available in the Master Settings are all relatively high quality for 
editing and review work, but as you can see from this exercise, not all of them are suitable 
for grading media with a high dynamic range. Because of their lower bit depths, most 
codecs are incapable of displaying the full scope of your grading work and could seriously 
impede the quality of your qualifier selections and highlight details.

Self-Guided Exercises
Complete the following self-guided exercises in the Blackmagic RAW Timeline to get more 
practice using the HDR grading palette.

Clip 02 (C003)—Use the HDR palette to produce a well-lit image with warm, saturated skin 
tones. Increase the chromatic contrast in the sky by saturating the orange clouds against 
the blue sky. In a new node, use the Color Warper to change the models’ shirts to green/
cyan. Use a window to isolate the shirt selection if necessary.

Clip 04 (E004)—Use the HDR palette to illuminate the cable car against the dark 
background. In a new node, make the car stand out by turning the interior a cool blue. Use 
a Power Window and qualifier if necessary. Create a final node to denoise the clip and find 
the optimal placement for it in the pipeline.

When you’ve completed these exercises, open the Blackmagic RAW Project  
COMPLETED.drp and review Blackmagic RAW COMPLETED to compare your work with 
this “solved” timeline. If the media appears offline, click the red Relink Media button in the 
upper-left corner of the media pool and specify the location of the Project 03 Blackmagic 
RAW media on your workstation.
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Lesson Review
1 When adjusting project-wide raw debayer settings, where do you indicate the 

camera format?

2 True or false? You can change ISO and white balance of raw media at any time.

3 What does banking accomplish in the HDR palette?

4 Which tonal range is wider, Shadow or Highlight?

5 True or false? Caching should always be disabled when grading.
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Answers
1 Trick question! DaVinci Resolve automatically detects the camera format of imported 

raw media. To access the appropriate raw settings, open the Camera RAW project 
settings and select the RAW profile you wish to adjust. 

2 True. Because of the high dynamic range of raw media, it’s possible to adjust the 
ISO and white balance of any clip in the Camera Raw palette at any stage of the 
grading process.

3 Banking refers to the process of navigating between the tonal zone wheels in the 
HDR palette.

4 In the default preset layout, the Shadow wheel has a wider tonal range than the 
Highlight. However, both of these zones can be modified as needed. 

5 False. When using a lower-quality render cache format, you might want to disable it 
when reviewing your final grade before delivery but enabling cache rendering during 
grading will help substantially with real-time playback. If using a higher-quality render 
cache format, it’s acceptable to leave caching on at all times, and even include the 
cached files in the final project render.



Multi-User Collaboration on the Blackmagic Cloud
Every project in this training manual was launched using a unique method—
restoring a DaVinci Resolve archive, conforming an XML timeline, cutting a self-
contained video file with scene cut detection, and importing a DaVinci Resolve 
project file. These projects were purposefully designed to demonstrate the variety 
of ways that colorists launch timelines for grading. One option we have yet to 
explore is the use of a collaborative workflow on the Blackmagic Cloud.

The collaborative workflow allows multiple users to  
log in to a DaVinci Resolve project simultaneously. 
With the help of clip and bin locking, collaborators 
can edit, composite, mix, and grade a film project at 
the same time.

A key requirement for collaboration is that all user 
workstations must have access to the same project 
file on a shared project library server. Blackmagic Cloud project libraries are 
hosted on secure online servers, allowing DaVinci Resolve users to connect and 
collaborate on the same project from any location in the world. Click the Cloud 
button in the header of the Project Manager to begin creating libraries and 
projects in the Blackmagic Cloud. 

If you don’t want your workstation on a network with internet access, you can opt to 
use the included DaVinci Resolve Project Server app to create, manage, back up, and 
share project libraries with any other workstation on a local area network (LAN).

The Blackmagic Cloud and DaVinci Resolve Project  
Server grant multiple-user access to DaVinci Resolve 
projects, but collaborators still need to have access to 
the same media to see the contents of these projects. 
One way to ensure that everyone can see the same 
media is by sharing a copy of the project assets with 
every collaborator on hard drives or RAIDs. A more 
manageable and cost-effective method is by hosting 
the media on a shared server or third-party cloud 
system. Blackmagic Design offers several network 
storage solutions—the Blackmagic Cloud Pod acts as 
a hub to which any USB storage device can be 
connected to turn it into high-speed network storage, 
and the Blackmagic Cloud Store devices provide the 
same function, as well as internal storage options 
that range between 8 TB to 320 TB.

Blackmagic Cloud Store



This page intentionally left blank.



Time
This lesson takes approximately 
60 minutes to complete.

Goals
Using Lightbox to Check 
Timelines Prior to Delivery 338

Understanding the 
Render Workflow and Presets 342

Creating Custom Renders 
and Saving Presets 348

Configuring a Timeline for 
Digital Cinema 350

Exploring Advanced 
Render Settings 356

Lesson Review 363

Lesson 10

Delivering Projects

When you’re ready to export a 
project—whether at the end of a 
workflow, at an intermediate point, or 
when generating dailies—its render 
settings are configured in the deliver 
page of DaVinci Resolve.

In this lesson, you will review existing 
presets, prepare a project for delivery, 
output for digital cinema, and set up 
your own custom renders.
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Using Lightbox to Check 
Timelines Prior to Delivery
The Lightbox feature of the color page gives you an alternative, expanded representation 
of the timeline. It provides a general overview of clips in the edit rather than the default 
viewer-focused layout of the color page. It is particularly powerful when combined with 
filters and can be used to quickly assess the grade status of timeline clips.

1 Launch DaVinci Resolve 18.

2 Import and open Project 03 - The Long Workday Commercial COMPLETED.drp. 
If necessary, relink the media by clicking the red Relink Media button in the upper-left 
corner of the media pool and specifying the location of the Project 03 media on your 
workstation.

3 Enable caching by choosing Playback > Render Cache > Smart.

4 In the Project Settings, set the Render cache format to one of the full quantization 
formats (444 or 4444).

5 Enter the color page.

6 Use the dropdown menu at the top of the viewer to open Lesson 10 Timeline.

7 In the upper right of the color page, click the Lightbox button.

The Lightbox is a full-screen representation of your project timeline from left to right, 
top to bottom. A ruler to the right of the window indicates the timecode of the clips 
and turns into a scrollbar when a timeline has more clips than can be displayed in a 
single panel. 
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This expanded overview of the timeline’s thumbnails can be helpful for colorists who 
find the Thumbnail timeline in the color page too restrictive. With a single glance at the 
Lightbox, you can determine which clips are graded and which aren’t.

8 Click the Information button in the upper-left corner of the Lightbox panel to 
display clip numbers, timecodes, video track numbers, codecs, source names, and 
version information.

9 Next to the Information button, click the Clip Filter button to expand the 
filtering options.

10 In the clip filter list, click Ungraded clips.

The Lightbox panel is reduced to just five clips. The first two clips clearly belong in the 
Garage group but must have been overlooked during grading.
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11 Select both clips and choose Groups > Garage > Assign to Group.

Most of the grading in the Garage group was carried out in the post-clip stage, so 
the two clips will immediately adopt the look of the rest of the group. They will remain 
in the Lightbox panel until the next time you change the filter, after which their new 
status as graded clips will be acknowledged.

The third and fourth clips in the ungraded filter results have not been touched at all.

12 Select clip 03.

13 In the upper left of the page, click the Color Controls button to open the grading 
palettes in the lower half of the screen.

If you’re working with an external monitor, you will see a full-screen output of the 
selected clip in the Lightbox. This allows you to continue grading and tweaking your 
media in Lightbox mode.

14 Raise the Offset master wheel (35.00) until the bulk of the image’s waveform occupies 
the bottom half of the scopes graph. Lower the Lift master wheel (-0.01) to address the 
raised shadows and establish a deeper contrast.

15 Select clip 04. 

This clip was part of the final exterior sequence after the Home group, which had a 
distinctly warm appearance.

16 In the Primaries palette, raise the Temp (200.0) to maintain a consistent look at the end 
of the timeline.

The last filtered clip is the solid white matte at the end of the sequence, which doesn’t 
require grading.
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17 In the sidebar filter, select Noise Reduction.

When performing noise reduction in Lesson 8, you learned that disabling the Denoise 
node would facilitate faster playback during the remainder of the grading process and 
result in a more efficient workflow.

If you use this method of performance optimization, you must remember to re-enable 
Denoise nodes before outputting a project.

18 Click the Lightbox button in the upper-right corner to close the Lightbox interface.

The Noise Reduction filter is still active in the timeline on the color page. 

19 Click the two clips one-by-one and verify that their Denoise nodes are not disabled.

In Lesson 8, you also disabled the Magic Mask track in Clip 02 for faster playback. 

20 In the color page Clips filter, select Magic Mask.

21 Go through the filtered timeline and verify that all Magic Mask nodes are enabled 
and tracked.

Enable the Track node in clip 02. Re-run the track if necessary.
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22 Select Clips > All Clips to remove the timeline filter.

TIP The Timeline Thumbnail mode is another great option for visually assessing 
the status of clips in the timeline while in the Lightbox panel. Choose View > 
Timeline Thumbnail Mode > Source (C Mode) to switch the order of the clips in 
the timeline from their edit order to the order in which the media was created. 
When working with original camera footage, this will display the order in which the 
footage was recorded. C Mode will place clips that were captured on the same day/
location next to each other, which makes for faster matching, grade copying, and 
visual assessment. When done, remember to set the Timeline Thumbnail Mode 
back to Record (A Mode).

The media has now been checked to verify that all relevant clips are graded, and all their 
nodes are active. When working on your own projects, think about the types of workflows 
you use and what is important to verify before delivering a project.

As well as the standard filters already present in the sidebar, you can also use the Smart 
Filters option at the bottom of the list to design filters based on the metadata of the clips 
in the timeline.

Understanding the 
Render Workflow and Presets
The deliver page is designed to help you quickly set up one or more render jobs. Before 
we dive into the intricacies of individual render parameters, it’s helpful to remember that it 
takes only four steps to export a project from DaVinci Resolve:

A In the Render Settings panel, set up the video output format. These settings include 
the file type, codec, and audio format of the rendered video; its name and location 
on your workstation; and a variety of advanced controls to optimize the render speed 
and file size.

B Define the timeline range you want to export. By default, each job is set to render the 
entire timeline, but you can use In and Out points to define a custom range.

C Click Add to Render Queue to send the job(s) to the Render Queue.

D Select the job(s) in the Render Queue and click the Render button.
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In the following exercise, you will create a render job based on a preset in the Render 
Settings of the deliver page.

1 Enter the deliver page.

At the top of the Render Settings panel, you will find a horizontal list of render presets.

Custom Export opens the full range of render settings in the panel beneath.

ProRes, H.264, and H.265 Masters produce common video files for a variety of 
uses, from high-end exports appropriate for broadcast (ProRes) to compressed HD/
UHD files for client review or online playback (H.264 and H.265). Note that the ProRes 
Master preset is available only on macOS systems.
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YouTube, Vimeo, and Twitter optimize the Render Settings panel based on video 
configurations recommended by user-generated content and social media websites. 
Enter your login details in Preferences > Internet Accounts to upload videos directly to 
your account upon render. 

Dropbox and Replay facilitate faster playback and review, as well as automated 
uploading, when using Dropbox file-hosting services. It is even possible to sync a 
timeline to Dropbox Replay to see collaborators’ comments and annotations directly in 
the DaVinci Resolve viewers.

IMF features a set of SMPTE ST.2067-compliant resolutions and codecs for tapeless 
deliverables to networks. In DaVinci Resolve Studio, this option does not require a 
license and supports multiple media streams for video, audio, and subtitle tracks.

NOTE The Interoperable Mastering Format (IMF) is used for broadcast 
distribution and online streaming services like Disney+, Netflix and 
Sony Pictures.
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Final Cut Pro 7/X, Premiere XML, and AVID AAF accommodate return trips to their 
respective NLE software. This assumes a workflow in which media is edited in a third-
party NLE, migrated to DaVinci Resolve for grading/VFX, and then returned to the 
same NLE for final delivery.

TIP  Another way to roundtrip color grades between applications is to 
export a CDL (color decision list), provided that the receiving software supports 
the format. When generating CDLs, only primary color grades in the first node 
are retained. The Lum Mix of this node must be set to 0 for the color data to 
travel accurately.

Audio Only disables video output and delivers a single audio-only file. You can specify 
the audio file format in the Audio tab of the Render Settings.

Pro Tools renders out three files: a self-contained video for reference, individual 
exports of all audio clips and their channels, and an AAF file for Avid Pro Tools 
migration. This preset accommodates workflows in which the final audio mix is 
mastered by an external audio engineer in Pro Tools.

2 Click the disclosure arrow next to the YouTube preset and choose 2160p to load the 4K 
UHD version of the preset.
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The Render Settings panel changes to display the most relevant values for the selected 
YouTube preset.

To name the video file, you will use the File Name and Location fields under the 
preset list.

3 Click the empty text field next to File Name and enter Workday_YouTube_1.1.

The Location field identifies where the video file will be rendered to. A job cannot be 
sent to the Render Queue without an assigned location.

4 Click the Browse button next to the Location text field.

5 In the File Destination window, navigate to your Desktop, create a new folder called 
Exports, and assign it as the render destination.
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6 In the Timeline panel, ensure that the render range is set to Entire Timeline.

7 With the render settings configured and timeline range defined, click Add to Render 
Queue at the bottom of the Render Settings panel. 

A pop-up dialog asks whether you want to export the project at a higher resolution than 
your timeline. For the purpose of this exercise, you will confirm that this is intentional.

TIP If you’re rendering out a video project at a higher resolution than the 
original footage, it is best practice to upscale the timeline in the Project 
Settings using the Timeline resolution parameter of the Master Settings tab. 
In addition to improving the rendered result, this method will also give you a 
more faithful representation of the final image in the viewer and allow you to 
apply your grades and effects directly to the upscaled clips.  

8 Click Add to close the dialog window.

9 In the Render Queue panel, click the Job 1 title and rename it to YouTube.
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Supporting Multiple Resolution Options 
for User-Generated Content Websites
Video players on user-generated content (UGC) websites such as YouTube or 
Vimeo often offer the option to choose a playback video resolution. A lower 
resolution video allows for smoother playback on a low-bandwidth internet 
connection, whereas a higher resolution will produce a better-quality image.

This change in resolution does not occur in real time within the UGC player. 
Instead, every resolution of every video is generated at the time of the video’s 
upload, which is why there is usually a wait period before an uploaded video goes 
live. When switching between resolution options, the user is actually switching 
between separate renders of the video as generated by the host website.

For this reason, it is advisable to render and upload your video in the highest 
possible quality and leave it up to the UGC website and the end user to determine 
which resolution is best suited for playback.

Creating Custom Renders 
and Saving Presets
Presets are an efficient method of exporting projects quickly with the confidence that the 
settings are appropriate for the intended destination. However, it’s valuable to understand 
how and why certain settings are used and to be able to configure them to meet more 
specific needs, especially when your project deliverables extend beyond the destinations 
targeted in the presets list.

Most post-production professionals, from editors and compositors to audio engineers and 
colorists will configure render settings based on a wide range of factors—for deliverables, 
it will be the industry or technical standards of a broadcast, transmission, or display 
format; for collaborative workflows, it may be the software and hardware specifications of 
the receiving department.

In this exercise, you will set up a render job to deliver dailies to an editor who is working on a PC.

1 At the top of the Render Settings, click the Custom Export button.

2 Under the File Name and Location fields, choose to render Individual Clips. Doing so 
will export every clip in the timeline as its own video file. In the case of dailies, you’ll 
want to place untrimmed clips on the timeline to ensure that the editor receives all the 
media for every take.
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3 Set the Video Format to MXF OP-Atom.

4 Set the Codec to DNxHD and the Type to 1080p 145/120/115 8-bit.

TIP Click the Expand button to the left of the Render Settings button in the 
interface toolbar to expand the panel to the height of the deliver page. Click 
the button again to collapse the Render Settings panel, expanding the timeline 
across the full width of the deliver page.

5 The lessons throughout this training manual did not focus on audio syncing or editing; 
however, in a dailies workflow, it is assumed that the audio from an external recorder 
would have been synced to the video files prior to them being assembled in a master 
timeline. For this export, the option to export audio can remain selected under the 
Audio tab using the high-quality Linear PCM codec.

6 Click the File tab to the right of the Audio tab to configure the naming convention of 
the dailies.

By default, “Filename uses” is set to “Custom name.” When working with dailies, it’s 
highly advisable that you preserve the original filenames (“Source name” in the Render 
Settings). Doing so will enable you to quickly switch between offline and online media, 
as well as maintain consistency between post-production departments.

In this case, you don’t want to use the source name because all the clips came from 
the same video file (Project 3 - The Long Workday SCD.mov) and will overwrite one 
another. Leave “Custom name” selected.

7 Enter the Custom name underneath as Workday Dailies.

8 To prevent them overwriting each other upon export, select “Use unique filenames.”

9 Choose Suffix as the method by which the files will be distinguished from one another.

10 At the top of the panel, click Browse to change the Location file path.
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11 In the Exports folder on the Desktop, create a subfolder called Dailies and select it as 
the location.

When collaborating on a largescale project, or working consistently with the same 
editor, you may want to generate a preset of your settings so you can set up future 
renders more quickly.

12 In the options menu of the Render Settings panel, choose Save as New Preset.

13 Name the preset Dailies for PC.

The custom preset appears on the left of the horizontal menu at the top of the Render 
Settings panel.

14 In the Timeline panel, ensure that the render range is set to Entire Timeline.

15 Click Add to Render Queue.

16 In the Render Queue panel, change the Job 2 title to Dailies.

Configuring a Timeline 
for Digital Cinema
A digital cinema package (DCP) is a collection of media and metadata files used to project 
digital movie files in a theatrical venue. DaVinci Resolve makes it possible to create a digital 
cinema package with its integration of the DCP plug-in. The next few exercises combine 
some practical information about DCPs with the configuration steps necessary to generate 
a DCP in the deliver page.

When creating a DCP, the timeline must be set to one of three 2K resolutions:

 — 2K Native (1.90:1) 2048 × 1080 @ 24, 25, 30, 48, 50, or 60 fps

 — 2K Flat (1.85:1) 1998 × 1080 @ 24, 25, 30, 48, 50, or 60 fps

 — 2K CinemaScope (2.39:1) 2048 × 858 @ 24, 25, 30, 48, 50, or 60 fps

Or one of three 4K resolutions:

 — 4K Native (1.90:1) 4096 × 2160 @ 24, 25, 30, 48, 50, or 60 fps

 — 4K Flat (1.85:1) 3996 × 2160 @ 24, 25, 30, 48, 50, or 60 fps

 — 4K CinemaScope (2.39:1) 4096 × 1716 @ 24, 25, 30, 48, 50, or 60 fps
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1 Continue working in the Lesson 10 Timeline.

The resolution for your DCP will be 2K Flat because it’s the closest resolution option 
when starting from full HD. You’ll need to slightly scale up the project and crop the top 
and bottom of the frame.

Native 1.9:1

Flat 1.85:1

Scope 2.39:1

16 x 9 frame 1.78:1

TIP 4K DCPs use a lower bit rate than 2K DCPs when played on 2K projectors. 
For that reason, when your target projector is 2K, always make a 2K DCP, even if 
your content supports higher resolutions.

2 Open Project Settings.

3 In the Master Settings, set the Timeline resolution to 1998 x 1080 DCI Flat 1.85.

4 Click the Image Scaling tab and set Input Scaling to “Scale full frame with crop.”

5 Click Save to close the Project Settings.
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The project resolution and aspect ratio are now DCP compliant. The timeline frame rate 
is 24 fps, which is also appropriate for DCP delivery. In fact, if you were working on a 
23.976 fps project, DCP would still interpret it as 24 fps and audio playback would be pulled 
up to match.

Rendering a DCP
With the resolution and frame rate appropriately set up, all further output parameters can 
be configured in the Render Settings panel.

The DCP format in DaVinci Resolve 18 Studio features two codec options. The Kakadu-
based JPEG 2000 standard needs no license and delivers unencrypted digital cinema 
packages. The easyDCP format encrypts digital media but requires the purchase of a 
licensing package.

1 In the Render Settings panel, click Custom Export.

2 Near the top of the panel, select Single Clip. Unlike the dailies, you want this timeline to 
be rendered as a single, self-contained video file.

3 In the Video tab, set the Format to DCP.

4 Set the Codec to Kakadu JPEG 2000.

5 Set the Type to 2K DCI Flat.

TIP DCP uses the XYZ color space. The conversion of your project color space 
to XYZ is performed automatically during the creation of the DCP file. In the 
Project Settings, your project color space is determined by the Timeline color 
space, even when DaVinci YRGB color management is not in use.
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The “Use interop packaging” checkbox determines whether you are generating the 
DCP based on the older but more widely supported Interop standard or the more 
current and feature-rich SMPTE standard. One of the benefits of using the SMPTE 
standard is that it supports a wider range of frame rates. The major benefit of using 
the older Interop standard is that it is compatible with more theater projection 
systems, although it is limited to either 24 fps or 48 fps.

6 Ensure that “Use interop packaging” is selected.

7 Leave all other settings as they are.

TIP Unencrypted DCPs can be played back on any DCP player/encoder without 
restriction. The alternative DCP codec option, easyDCP, features an “Encrypt 
package” checkbox for additional file security. This option will set the encoder to 
generate a Digest containing the keys used during file encryption. With the Digest, 
you will be able to play the resulting DCP on your system and generate Key Delivery 
Messages (KDMs) to allow the DCP to be played on other servers.

Naming and Outputting a DCP
DCPs follow a somewhat specific, yet voluntary, Digital Cinema Naming Convention for 
the content title. For each version of a movie you create (such as the English 5.1 version, 
the Spanish 5.1 version, the stereo version, the in-flight version, and so on), a composition 
playlist (CPL) is created containing the appropriate content name. DaVinci Resolve’s DCP 
preset creates this CPL for you and includes a straightforward way to generate a name that 
follows the appropriate naming convention.

1 Continue in the Video tab of the Render Settings.

2 Scroll down and expand the Composition Settings. 

3 Click the Edit button next to the “Composition name” field. 
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This launches the Composition Name Generator window. Here you can enter the 
metadata that will be used to create a content title compatible with DCP servers and 
theater management systems.

4 Enter the Film Title as TheLongWorkday, leave the Content Type as ADV 
(Advertisement), and set the Audio Language to EN (English). 

TIP Separate the words in your project title using initial capitals—not spaces, 
hyphens, or underscores.

The selected metadata is added to the composition name at the top.

5 Click OK to close the window.

The composition name is not to be confused with the package name that contains the 
DCP. The package name is managed in the File tab of the Render Settings panel.
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6 Click the File tab and enter the Custom name as Long Workday DCP test. 

Lastly, you need to select a destination for this DCP.

7 Click the Browse button and select your Desktop as the render location.

When delivering a real film project, you can output the DCP to a hard drive in a Cru 
Dataport DX-115 enclosure that will load directly onto many digital cinema servers and 
is often required by film festivals. More conveniently, you can output to a USB 2 or 
USB 3 hard drive or even a USB stick, if it accommodates the film’s file size. No matter 
which storage device you choose, it must be formatted as a Linux Ext2 or Ext3 drive. 
You can use online resources to find various ways of accomplishing this on macOS and 
Windows workstations.

TIP Some projection servers don’t provide enough power to mount certain 
USB-powered drives. To guarantee playback, use USB drives with an external 
power source.

8 In the Timeline panel, ensure that the render range is set to Entire Timeline.

9 Click Add to Render Queue.

10 If you previously changed your project timeline resolution to 1998 x 1080 DCI Flat 1.85, 
you should not see the pop-up dialog informing you of the higher resolution render. If 
you didn’t change the resolution and see the dialog, click Add to proceed.

11 A second dialog pop-up will inform you of an Invalid Audio Track Count. This is due 
to the DCP job anticipating a 5.1 audio mix, which is common with digital cinema 
deliverables. Your project has a stereo output and will play without issue on most 
projection systems. Click Add Anyway.

12 In the Render Queue, change the Job 3 title to DCP.

When rendering a real film project, you will want to test it after generating the DCP file. 
The only definite way to test your DCP is to rent a theater and run the projection just as 
you would for an audience. That is the only way you can absolutely verify that the color 
conversion (from your Timeline color space to XYZ) worked correctly. DCPs can also be 
tested by importing them back into a new DaVinci Resolve project file and managing the 
color space from DCI X′Y′Z′ to your monitoring standard. It’s a quick way to verify that the 
colors have not been corrupted due to incorrect color conversion, but a computer screen 
will never be able to truly represent how a project will appear when projected.
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Exploring Advanced 
Render Settings
In addition to choosing how your footage is compressed, you have additional control over more 
nuanced aspects of the rendering process. This exercise is designed to familiarize you with 
these settings and empower you to set up your future custom renders with more purpose.

1 In the Project Settings, reset the Timeline resolution to 1920 x 1080 HD and click Save.

2 In the Render Settings panel, select the Vimeo preset at the default 1080p resolution.

Presets are convenient as a quick starting point for renders, but they can be further 
customized if unpacked in the Custom Export controls. In this exercise, you’ll produce 
a video with a lower data rate than the default.

3 At the top of the panel, scroll to the left of the presets list and click the Custom 
Export button.

The panel reverts to its custom layout but has adopted some of the Vimeo 
preset settings.

4 Ensure that the Video Format is QuickTime and the Codec is H.264.

5 For certain codecs, encoder acceleration options will appear under the Codec 
parameter. If you’re using a workstation with an Nvidia NVENC GPU, you will see 
a dropdown menu allowing you to accelerate your Native and GPU encoders. 
Workstations offering QuickSync hardware encoding will display an option to use 
hardware acceleration. 

Select Auto from the dropdown menu or select “Use hardware acceleration if available” 
if you see either of these encoder options.

6 Leave the Resolution at 1920 x 1080 HD and the Frame rate at 24.

7 The Quality parameter in the Render Settings panel specifically refers to the data rate 
of the digital data—that is, the data per second required to transmit the audiovisual 
stream. A higher data rate contains more visual information, which results in better 
motion representation and detail quality, whereas a lower data rate selectively 
discards some data in the interest of generating a smaller file size.

Restrict the Quality setting to 7500 Kb/s. Doing so will reduce the data rate of the file, 
significantly lowering the file size while still maintaining a good level of visual quality.
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TIP As counterintuitive as it seems, the resolution of a video has no impact on 
its file size. Only the data rate determines the file size of a rendered video. If 
you export 720p and 1080p versions of the same video at 8000 Kb/s, they will 
have the same file size, although the 720p will likely look a little crisper, while 
the 1080p video will have more macroblock artifacting because it’s forced to 
use the same amount of data to reproduce the image in a larger frame.

This is not true when using an Automatic Quality setting (such as Best), which 
will configure the data rate based on the resolution of the timeline.

8 The Encoding Profile determines the level of complexity involved with encoding an 
H.264/H.265 file. The listed profiles allow for the selection of higher encoding and 
playback qualities in exchange for computational intensity. They are listed from lowest 
(Base) to highest quality (High 4:4:4), with Auto determining the optimal profile based 
on the timeline’s media resolution and bit depth.

For this render job, set the Encoding Profile to Auto.

9 Key Frames are full-data, intra-coded frames (also known as i-frames) that are inserted 
into a lossy video stream at regular intervals, such as every 30 frames. These i-frames 
are reference points for recreating the temporally compressed p- (predicted) and b- 
(bi-directionally predicted) frames that make up the majority of the moving image in 
a distribution codec (such as H.264). The default Key Frames setting is ideal for most 
project types. If you have very fast-moving imagery and see glitch effects in your 
rendered video, increase the Key Frames frequency.

Set the Key Frames to be grabbed every 24 frames to ensure slightly less distortion 
during the temporal compression and playback of the video.

10 Frame reordering allows for the encoding of b-frames to improve the quality of 
the resulting video file. It can be disabled for faster encoding at the expense of 
visual quality.

Leave Frame reordering enabled. 

11 Depending on your workstation, you might see Entropy Mode listed under the 
Encoding Profile or at the bottom of the video parameters list. A dropdown menu lets 
you choose which algorithm the encoder should use for compression. Auto will choose 
the most appropriate option for your workstation.

In both cases, this mode will also reveal additional controls that allow you to further 
configure how the video is compressed. As a rule, these controls are already optimized 
to produce the best temporal compression results, but they can be modified if you 
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experience some extremely specific artifacting in your rendered video. You can 
confidently leave these controls as they are (for now and likely forever).

12 Click the disclosure arrow to see the Advanced Settings.

13 The “Pixel aspect ratio” allows you to indicate whether the video pixels are Square 
or Cinemascope (rectangular). This option pertains to older workflows in which 
digital footage recorded for analog television (at a rectangular 1.33:1 aspect ratio) 
was converted for computer displays (which had a square 1:1 aspect ratio). If your 
video looks horizontally distorted (too squashed or stretched out), change the pixel 
aspect ratio.

Since you’re working on digitally recorded and encoded media, you can leave the “Pixel 
aspect ratio” as Square.

14 Data Levels specify the data range of an image based on its source. The default Auto 
setting renders the media at the data level appropriate for the selected codec. Video 
refers to YCbCr formats that constrain to pixel data values between 64–940 in a 10-bit 
system in formats using a Rec.709 video standard. Full expands the range to the film 
standard of 4–1023 values utilized in high-end digital film formats. If you find that your 
final video looks substantially darker or lighter than it appears in the viewer of the 
color page, it’s likely that the data levels are incorrectly assigned. This can sometimes 
happen when offline media is transcoded with a different codec from the original 
media. To fix this, make test exports with the Data Levels set to Video and/or Full until 
you find the correct data level.

For this render job, leave the Data Levels on Auto.

15 Color Space and Gamma tags allow you to embed colorimetry metadata into the video 
file that can be read and interpreted by operating systems and applications. These 
tags allow you to overcome the color shift that can occur between the DaVinci Resolve 
viewer and video players/browsers with an internal color profile.
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Leave the tags set to Same as Project. The resulting video file will be tagged with the 
project’s Output color space. When not using RCM, the tags will reflect the Timeline 
color space.

NOTE In Lesson 4, we identified that Macs have a unique internal color 
management utility that affects how videos are displayed in its native 
applications. By enabling DaVinci Resolve to use the Mac Display Color Profile 
in the Preferences, you can get DaVinci Resolve’s viewers to match how the 
footage appears in macOS applications. However, this is only a monitoring 
configuration and does not affect how the footage is rendered out. To export 
clips from a macOS workstation without experiencing a color shift, you will 
also need to include gamma tag metadata in the rendered video. Click the 
dropdown arrow in the Gamma Tag field and choose Rec.709-A. This will map 
your rendered videos to Apple’s internal Rec.709 curve when viewed in its 
applications, while bypassing the tags when displayed in players and browsers 
that do not use internal color management.

16 Set the “Data burn-in” to None to ensure that the viewer’s data burn-in information will 
not appear in the rendered video.

17 Selecting “Bypass re-encode when possible” will render a direct copy of the original 
media file when possible. This option will have no effect if you have graded or 
composited your media or if you’re exporting to a format different from the source. 
An example of when this setting is beneficial could be if you were editing a project 
using ProRes 422 media, with the intention of delivering in ProRes 422. Bypassing re-
encode will deliver such a project at the highest possible quality.

Leave “Bypass re-encode when possible” selected.

18 The following options, “Use optimized media,” “Use proxy media,” and “Use render 
cached images,” allow you to employ previously-generated renders of the footage in 
the export process. It makes sense to select these options when your optimized or 
proxy media and render cache are set to a high or lossless quality such as 444 or HDR.
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The current project is set to render caches at a high-quality 12-bit depth codec, so it 
makes sense to use the cached files in the final render.

Select “Use render cached images.”

19 The “Force sizing to highest quality” and “Force debayer to highest quality” settings 
bypass the quality settings for resizing and debayering in the Project Settings. 
Selecting these is convenient when working on a processor-intensive timeline that 
uses high-quality images or raw footage. You can adjust the Project Settings for lower-
quality visual output during editing but bypass these settings for the highest possible 
quality output upon final render.

Select “Force sizing to highest quality” to ensure that the optimal resize filter is used 
during rendering. 

It’s not necessary to select the debayer option because this project does not contain 
any raw media. 

20 “Enable Flat Pass” allows you to bypass grades as indicated in the version settings of 
clips in the Thumbnail timeline. The default choice is Off, which means all grades will 
remain intact. Choosing “With clip settings” means the render will consider the bypass 
status of each version (as set in the Versions contextual submenu in the color page). 
Choosing Always On will disable all the clip grades in the timeline, thereby providing a 
quick way to export an edited timeline or a set of dailies without a grade.

Set Enable Flat Pass to “With clip settings.”

21 Selecting “Disable sizing and blanking output” removes any transform changes and 
blanking that were applied to the clips in the edit or color pages. Leave it deselected.

22 In the File tab at the top of the panel, set “Filename uses” to “Timeline name.” The File 
Name field will adopt the name of the timeline (Lesson 10 Timeline) as the filename.

23 In the Timeline panel, navigate to the last frame of clip 05 and press O to place an out 
point (01:00:26:09). The dropdown at the top of the panel will show that you will be 
rendering a custom In/Out Range.

24 Click Add to Render Queue.

25 In the Render Queue, change the Job 4 title to Preview 1080p.
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26 In the Render Queue, in the options menu, choose Show All Projects.

You should now see all the jobs that were added to the Render Queue in any project 
associated with the project library you’re using. If you split longer projects into reels, 
or if you’re working on timelines with different frame rates, you might want to create 
all your render jobs first, and then access and render them from a single project 
Render Queue. This way, you won’t have to wait for a project to finish rendering before 
launching the next project.

27 In the options menu, deselect Show All Projects to return to the current project’s 
Render Queue.

Editing Render Jobs
A job can be removed or modified even after it has already been added to the 
Render Queue.

1 Find the DCP job in the Render Queue and click the X in the upper-right corner of the 
job to delete it from the queue.

2 Find the YouTube job and click the pencil icon in the top-right corner to edit it.

The Render Settings panel changes to reflect the YouTube job settings. The presence 
of additional buttons (Cancel, Update Job, and Add New Job) at the bottom of the panel 
indicates that a job is currently being edited.

3 Change the Resolution to 1920 x 1080 HD.

4 Change the Format to QuickTime.
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5 Click Update Job at the bottom of the panel to exit the Edit mode.

The change overwrites the original YouTube job settings.

6 Click the YouTube job in the Render Queue panel. 

7 At the bottom of the panel, click Render 1.

Note that the remaining, unselected jobs do not get rendered. When delivering 
multiple timelines or formats, ensure that you select all necessary jobs in the queue 
before clicking the Render button. When no jobs are selected, the button is set 
to Render All.

TIP The fastest way to export a timeline from DaVinci Resolve is to choose File > 
Quick Export. This export feature is designed to produce light video files for 
immediate viewing or uploading to social media.

Using the correct render settings is vital for delivering technically correct, visually 
optimized video project files. Understanding these settings has even greater benefits; it 
elevates your skillset as a colorist and imbues confidence that your projects are delivered 
at their optimal quality while adhering to industry standards.

Remote Rendering
DaVinci Resolve Studio allows you to offload rendering to another DaVinci Resolve 
workstation. This feature requires that all workstations have a copy of 
DaVinci Resolve 18 Studio installed, a shared Postgres project library, and access 
to all necessary media files using the same filename paths. With one computer 
acting as a render station, all other DaVinci Resolve workstations can continue to 
be used for editing, grading, compositing, and mixing.
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Lesson Review
1 True or false? You can continue to view and grade media in the Lightbox.

2 True or false? The deliver page supports roundtrip workflows with other 
NLE programs.

3 How would ensure that the highest quality debayer settings are used for the final 
render of a raw project?

4 How do you save a custom render preset?

5 True or false? It is possible to continue editing a render job after it has been added to 
the Render Queue.
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Answers
1 True. You can view and grade media in the Lightbox if you enable color controls and 

have an external monitor.

2 True. The presets at the top of the Render Settings panel allow you to select an NLE 
program for a roundtrip delivery of individual video clips and an XML timeline.

3 Select “Force debayer to highest quality” in the Advanced settings for the highest 
debayer quality when exporting a raw project. 

4 In the Render Settings options menu, choose Save as New Preset.

5 True. Clicking the pencil icon in the upper-right corner of a render job allows you to 
continue modifying its settings.

Congratulations!
You have completed The Colorist Guide to DaVinci Resolve 18 and are now ready to 
explore more editing, visual effects, and audio mixing workflows using the additional 
certified books in this series. 

Completing all the lessons in this book has prepared you to become a certified 
DaVinci Resolve color page user. You can take the free online exam by following this link: 
https://bit.ly/3PBqwwo or by visiting the DaVinci Resolve training page and clicking the 
Complete Online Exam button under the Colorist Guide lesson files. When registering, 
please select the BMD training partner country as ONLINE and the BMD training partner 
name as BMD Training Page. 

The exam is made up of 50 multiple choice questions that must be answered within 
a 1-hour limit. A passing score requires 85% accuracy or better. Every user has 
three attempts at the exam, with a 24-hour wait period between attempts. If you 
are unsuccessful after the third attempt, please wait 6 months before contacting 
learning@blackmagicdesign.com to request that a further three attempts be added 
to your account. The exam is open book and open software to encourage you to research 
the questions as you answer them. Upon passing, your certificate will be emailed to you.

We also invite you to become part of the DaVinci Resolve community by joining the web 
forum on the Blackmagic Design website (https://forum.blackmagicdesign.com/). There, 
you can ask further questions about the creative aspects of filmmaking and connect with 
industry editors, colorists, compositors, and audio engineers.

We hope that you have found DaVinci Resolve 18’s professional nonlinear editing and 
world-class color correction tools to be intuitive to learn and a perfect fit for your 
creative workflow!

https://bit.ly/3PBqwwo
mailto:learning@blackmagicdesign.com
https://forum.blackmagicdesign.com/
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Appendix A

Using the DaVinci 
Resolve Panels
Blackmagic Design manufactures a variety of control surfaces for use with 
DaVinci Resolve 18. The DaVinci Resolve panels allow you to make faster, more 
nuanced changes to your images. Instead of being limited to color grading 
one click or drag at a time, you can use the panels to adjust multiple controls 
simultaneously. This is why professional colorists worldwide working on 
commercials, television shows, and feature films prefer using control surfaces 
rather than grading with a mouse and keyboard. It can be the difference between 
taking 5 minutes to taking just 30 seconds to complete a shot. Three control 
panels are available for DaVinci Resolve: Micro, Mini, and Advanced. 

DaVinci Resolve 
Advanced Panel

DaVinci Resolve  
Micro Panel

DaVinci Resolve  
Mini Panel
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DaVinci Resolve Micro Panel
The DaVinci Resolve Micro Panel is a high-quality, portable, low-profile panel that features 
three high-resolution trackballs and 12 precision-machined control knobs for accessing 
essential primary correction tools. Above the center trackball are keys for switching 
between log and offset color correction, as well as a key to display DaVinci Resolve’s full-
screen viewer, which is great for use with laptops. Eighteen dedicated keys on the right 
side of the panel give you access to many commonly used grading features and playback 
controls. The DaVinci Resolve Micro Panel is perfect for anyone who needs a truly portable 
solution. It’s great for use on set to quickly create looks and evaluate color, and it’s ideal 
for grading in broadcast trucks, for education, and for anyone whose work relies mostly on 
the primary color correction tools.
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DaVinci Resolve Mini Panel
The DaVinci Resolve Mini Panel is a compact device packed with a massive number of 
features and controls. You get three professional trackballs along with a variety of buttons 
for switching tools, adding color correctors, and navigating your node tree. In addition to 
every tool and feature available on the Micro Panel, the Mini Panel also includes two 5-inch 
color LCD screens that display menus, controls, and parameter settings for the selected 
tool. Eight soft buttons and eight soft knobs give you direct access to the menus of most 
of the palettes in the color page. The Mini Panel is ideal for users who regularly switch 
between editing and color grading, users who wish to access both primary and secondary 
color correction tools from their panel, and for freelance colorists who need to carry a 
panel with them when moving between facilities. It’s also great for colorists working on 
location shoots, for corporate and event videographers, for houses of worship, and more.
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DaVinci Resolve Advanced Panel 
For the ultimate in speed, power, and control, Blackmagic Design offers the 
DaVinci Resolve Advanced Panel. The Advanced Panel has been designed in collaboration 
with professional colorists to work in total harmony with the software. This large panel 
consists of left, center, and right consoles that give you quick, one-touch access to 
virtually every parameter and control in the color page. The DaVinci Resolve Advanced 
Panel lets colorists instinctively reach out and touch every part of the image, adjusting 
multiple parameters simultaneously with complete responsiveness for a smooth grading 
experience. While the Mini Panel gives you access to nearly all the color correction tools in 
Davinci Resolve, the Advanced Panel gives you even more flexibility with physical buttons 
and knobs to control Memories, Open FX tools, Dolby Vision, and many other speed and 
workflow-based tools that will increase your efficiency even further.
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The Advanced Panel also features a unique T-bar for playing back gallery stills, shuttle 
controls for cycling through frames and speeding through your timeline, as well as a slide-
out keyboard. Used in many of the top color grading facilities around the world, the Davinci 
Resolve Advanced Panel is the ultimate control surface for Davinci Resolve. 

DaVinci Resolve Mini Panel Overview
The Mini Panel is mapped to virtually every tool and parameter in the color page while 
sporting a compact design and an accessible price point. This makes it incredibly popular 
among both professional colorists and industry newcomers. The following overview will 
introduce you to its layout and key functions.
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The lower half of the Mini Panel contains the primary control tools. The largest controls 
on the Mini Panel are the three trackballs and rings that control Lift, Gamma, and Gain. 
Their behavior and layout mirror the color wheels in the Primaries palette, with the 
trackballs controlling hue, while the rings control brightness. When the Lift ring is rotated 
counterclockwise, the image shadows darken. When the Gain trackball is moved toward 
the upper left, the lighter areas of the image become warmer. The Offset soft key maps the 
right trackball to the Offset wheel and the two left trackballs to the temp and tint controls. 
These tools are identical in the Micro Panel.

 

LOOP BYPASS DISABLE

PLAY
STILL

PREV
MEM RESET

GRAB
STILL UNDO REDO

PREV
NODE

NEXT
NODE

PREV
FRAME

NEXT
FRAME

PREV
CLIP

NEXT
CLIP



ALL

RGB
LEVEL

OFFSETLOG VIEWER

CONTRAST PIVOT MID DETAIL COLORBOOST SHADOWS HIGHLIGHTS SATURATION HUE LUM MIXY LIFT Y GAMMA Y GAIN

ALL

RGB
LEVEL

ALL

RGB
LEVEL



369Using the DaVinci Resolve Panels

Above the Lift, Gamma, and Gain controls are the Primary knobs, which are mapped to the 
adjustment controls in the Primaries palette. They control frequently used DaVinci Resolve 
tools such as Contrast, Pivot, Saturation, Color Boost, and Hue. These knobs (as well as 
all knobs on the panel) have 4,098 points per turn and can be pushed to reset the tool 
they control.
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To the right of the Gain trackball are useful playback and shuttle controls to help you 
quickly navigate between clips, nodes, and frames. Some additional playback options 
include Loop, which will repeat the playback of the currently selected clip; Bypass, which 
will temporarily bypass all the nodes/color corrections on the timeline; and Disable, which 
will temporarily disable the selected node of a clip.
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The lip of the Mini Panel consists of palette soft keys; two 5-inch, high-resolution color 
displays; and even more node, keyframing and selection controls. All the palettes found 
in the color page toolbar are mapped to their own buttons on the Mini Panel. The two 
displays—as well as the eight soft buttons and eight soft knobs above and below the 
displays offer advanced control over the active color page palette.
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Index

NUMBERS
4K to 1080p to 4K workflow, 274

A
AAF file type, 131, 345
A/B difference button, 72, 293
ACES (Academy Color 

Encoding System), 313
Advanced Panel, 367

Analog Damage effect, 262–263
animating grades, 283–290
Aperture Diffraction effect, 259
appending grades and nodes, 194–198
archive project file

creating, 5
opening, 4–5

aspect ratios, 276–277, 358
atmosphere, adding, 86–89
Audio Only render preset, 345
AVID AAF render preset, 345

B
backups, 5–7
balancing footage, 19–22
Beauty effect, 112
Bézier curves, 88, 108
Black Offset, HDR palette, 319
Blackmagic Cloud, xiv, 335
blanking, 276–277
Blur palette, 71–73

C
cache, clearing, 303–304
cache quality, 302–303
caching, enabling, 226, 
Camera Raw palette, 308, 311–312
Chroma-Luma grid, Color Warper, 101–105
Cinema Viewer, 192
clips. See also pre-clip grade; post-clip 

grade; raw clips
adjusting after post-clip grade, 258–262
comparing, 46–59
copying grades from, 188
creating versions of, 189–193
reframing, 275–276
resetting, 159

Clips filter, 42–43, 301
color and log wheels, comparing, 23–29
Color Boost, 110
color charts, 230–233
color management, 140, 146–152, 222–226
Color Match palette, 230–233
color monitoring, 151
color page

layout, xv–xix
opening, 5

color space, 146–152. See also 
Rec.709 color space

Color Space Transform (CST) effect, 313
color temperature, 14, 315, 319
Color Warper palette, 95–104
color wheels. See Primaries color wheels
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ColorSync utility, 148
ColorTrace, 203–209
Compound node, creating, 183–184
Conflict Resolution window, 138
conforming, 133–141
contrast and tonal range, 10–19
copying

grades from clips and stills, 188
grades using Timelines album, 209–210
nodes from stills, 196–198
timeline grades using 

ColorTrace, 203–209
cover-ups, 279–283
curves

adjusting luminance, 16–19
balancing colors, 19–22
Mini Panel, 22

Custom Export render preset, 343, 
348, 352, 356

D
data burn-in, 134, 264–267
DaVinci Resolve, downloading, xii
DaVinci Wide Gamut, 222–226
DCP (digital cinema package)

2K and 4K resolution, 350–352
naming and outputting, 353–355
playing back, 353
rendering, 352–353
XYZ color space, 352, 355

debayering (demosaicing), 308
deliver page workflow, 342
delivery

checking timelines prior to, 338–342
render workflow and presets, 342–348

Depth Map effect, 30–33, 66–67
depth of field. See shallow depth of field
depth planes, isolating grades to, 30–33
digital cinema, configuring timelines 

for, 350–352
downloading DaVinci Resolve, xii

DPX and DRX files, 201–202
Dropbox render preset, 344
.drp file extension, 7, 128, 141
dynamic attributes, 289–290
dynamic keyframes. See also keyframes

animating position values, 284–286
changing color values, 286–288

dynamic range, maximizing, 145–149

E
easyDCP format, 352–353
Edit Sizing, Sizing palette, 276
editing render jobs, 361–362
Effects and Definitions panel, 206
Effects Library panel,

Analog Damage, 263
Depth Map, 30
Face Refinement, 105
Noise Reduction, 295
Patch Replacer, 280
opening, 30
Sky Replacement, 89
Tilt-Shift Blur, 66

exam, taking online, 364
exporting 

DPX and DRX files, 201–202
timelines, 362

F
Face Refinement effect, 105–113
Film Grain effect, 264
Final Cut Pro 7/X render preset, 345
flags, using to organize shots, 40–43
frame mode, tracking in, 76–78, 182
frame size, changing, 272–277

G
Gain, Primaries color wheels, xviii
Gain master, 13, 24
gallery, xv, xvi
Gamma, Primaries color wheels, xviii
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Gamma master, 14
Gamut Mapping effect, 313
grades

animating using keyframes, 283–290
appending, 194–198
copying from clips and stills, 188
isolating to depth planes, 30–33
resetting in clips, 159
saving for projects, 198–203

grading workflow, 7–9
groups

balancing with color charts, 230–233
creating, 227–228

H
H.264 render preset, 343
H.265 Masters render preset, 343
HDR (High Dynamic Range) media, 

grading, 317–329
HDR palette

customizing zones in, 327
mapping to color panels, 329
options menu, 326
tonal ranges, 320–327
Zones Graph, 324

Highlight master wheel, 25
Highlight mode, viewer, 64, 80, 165, 

178, 293, 323
Highlight Recovery, Camera RAW 

palette, 314–316
HSL curves

Curve palette, 113–119, 256–258
Qualifier palette, 80, 164–165

hue curves
Mini Panel, 121
naming convention, 114

Hue-Saturation grid, Color 
Warper, 101–105

I
IMF render preset, 344
importing

LUTs (Lookup tables), 140
XML timelines, 128–131

Input Sizing, Sizing palette, 275–276
ISO, changing, 314–316

K
Kakadu-based JPEG 2000 standard, 352
key inputs and outputs, 156–157
key mixer, 84
keyboard shortcuts

bypassing node trees, 33
Cinema Viewer, 192
copying and pasting, 51
creating clip versions, 191
cycling through versions, 193
enlarging viewer, 17, 58
keyframe navigation, 286
layer mixer, 171
navigating cut points, 228
navigating viewer, 281
resetting grades in clips, 159
Select All, 147, 220, 224
serial nodes, 44, 263
toggling grades on and off, 15
toggling wipes, 53
undoing actions, 15

keyframes. See also dynamic keyframes; 
static keyframes

navigating between, 286
using to animate grades, 283–290

Keyframes Editor
description, xvi
Expand button, 287

L
layer mixer node, 169–184
layer nodes, creating, 171. See also nodes
lesson files, acquiring, xii–xiii
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Lift, Primaries color wheels, xviii
Lift master, 13, 24–25
Lightbox, 338–342
Live Preview, changing behavior of, 191
Live Save feature, 5–6. See also saving
local versions, working with, 189–193. 

See also remote versions; versions
log and color wheels comparing, 23–26
Loop button, viewer playback controls, 286
Lum Mix, 55

M
Mac displays, using 

DaVinci Resolve with, 148
Magic Mask palette, 240–253, 241 
markers, using with filtering, 43
Mask button, 88
master wheels

adjusting luminance, 10–15
Primaries color wheels, xviii

matching. See also shot match
between clips, 43–57
shots at clip group level, 234–238

matte data, sharing across nodes, 90, 181
memories, saving stills as, 199
memory colors, 121. See also colors
Micro Panel, 366
Mini Panel

curves, 22
features, 368–369
hue curves, 121
Offset mode, 16
Power Windows, 70
qualifiers, 83
tracking, 77

mini-timeline, xv, xvi
Motion Effects palette, 292

N
node cache, 296–299
Node Editor

decluttering, 184
grading workflow in, 9

node grades, disabling/enabling, 15
node order, 157–166
Node Sizing, Sizing palette, 276–279
node trees, bypassing, 33
nodes

adding, 44, 263
anatomy of, 156–157
appending, 194–195
disabling, 15
labeling, 44
removing Resolve FX plug-ins from, 112
switching order of, 158-159

noise reduction, 291–295

O
Object Mask, 241–244
Object Removal effect, 283
objects, tracking, 74–78, 241–244
obscured objects, tracking, 74–78
offline references, 131–133
Offset, Primaries color wheels, xviii
Offset mode, enabling, 16
Output Sizing, Sizing palette, 275–277
overcast skies, fixing, 79–95

P
panels

Advanced Panel, 367
Micro Panel, 366
Mini Panel, 366, 368–369

Parade, Scopes palette, 11, 27
parades

comparing, 47-51
versus waveforms, 27–28

parallel mixer nodes, 167–170, 174
Patch Replacer effect, creating cover-ups 

with, 279–283
people, tracking, 244–246
performance, optimizing with Render 

Cache, 296–304
Person Mask mode, 244–246
physical features, masking, 247–253
Pivot control, 14
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plug-ins, removing from nodes, 112
position values, animating, 284–286
post-clip grade. See also clips

adjusting clips after, 258–262
applying, 254–258

Power Windows, 63–65, 68–69
PowerGrade stills, 198–202
pre-clip grade, 203–233. See also clips
Premiere XML render preset, 344
preset render settings, saving, 348–350
Primaries color wheels

accessing, xv
described, xvi
overview, xviii
toggling between log wheels, 25, 28

Primary knobs, Mini Panel, 369
Pro Tools render preset, 345
project backups, setting up, 5–7
ProRes render preset, 343
proxy workflows, 144

Q
qualifiers, 79–89

R
raw clips, identifying, 308. See also clips
raw projects, setting up, 307
raw settings

adjusting at clip level, 314–317
adjusting at project level, 308–313

RCM (Resolve Color Management), 
140, 146–152, 222–226. See color 
management

Rec.709 color space, 146–152. See also 
color space

Reference Sizing, Sizing palette, 
54, 236, 276

remote rendering, 362. See also 
Render Settings

remote versions, 193. See also local 
versions; versions

Render Cache, optimizing performance 
with, 296–304. See also caching

render jobs, editing, 361–362

Render Settings. See also remote rendering
Advanced Settings, 356–361
“Bypass re-encode when possible,” 359
Color Space tag, 358–359
“Data burn-in,” 359
Data Levels, 358
“Disable sizing and blanking output,” 360
“Enable Flat Pass,” 360
Encoding Profile, 357
“Force sizing to highest quality,” 360
Gamma tag, 358–359
Key Frames, 357
“Pixel aspect ratio,” 358
Quality parameter, 356–357

render workflow and presets, 342–345
renders, customizing, 348–350
Replay render preset, 344
Reset UI Layout, 10
resolution

and aspect ratios, 276
versus file size, 357
rescaling media to, 273

Resolve FX plug-ins, removing from 
nodes, 112

RGB parade, 11, 27, 27–28, 47–51
RGB Mixer palette, 158, 172–175

S
sampling visual data, 277–279
saving

grades for projects, 198–203
render presets, 348–350
scene cuts, 219
stills as memories, 199

Scene Cut Detection, using to prepare 
media, 216–221

scene cuts, saving, 219
scopes, using to match clips, 46–57
Scopes palette button, 10–11
Scopes palette, Parade, 27–28, 47–51
secondary grading, performing, 8
Select All command, 147, 220, 224
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serial nodes, creating, 44, 263
Shadow master wheel, 26, 28–29
shallow depth of field, mimicking, 66–67
shared nodes, 198
sharpening, 71–73
shot match. See also matching

applying, 43–45
manually, 51–57
using stills, 46–51

Sizing palette, opening, 53, 57, 
236, 275, 278

skies, fixing, 79–95
skin, color grading, 105–121
skin tones

adjusting manually, 113–121
enhancing with face refinement, 105–113

Sky Replacement effect, 89–95
Smart Cache, enabling, 226, 296–297
sorting contents of bins, 220
source file locations, switching, 141–143
smart filters, 342
Spatial NR, Motion Effects palette, 292, 294
split-screen views, using to compare clips, 

xvii, 58–59
static keyframes, using, 285, 290. 

See also keyframes
stills

copying grades from, 188
copying nodes from, 196–198
saving as memories, 199
using to match shots, 46–51

subtractive strokes, 252
Super Scale upscaling feature, 273
syncing offline references, 131–133
system requirements, xi

T
Temp field, Primaries palette, 14, 315, 319
Temporal NR, Motion Effects 

palette, 292–294
thumbnail timeline, xv, xvi
Tilt-Shift Blur effect, 66–67

Timeline resolution, Project Settings, 
272–274, 277, 347

timelines
applying blanking to, 276
associating HQ footage with, 141–143
checking prior to delivery, 338–342
configuring for digital cinema, 350–355
conforming, 133–141
exporting, 362
importing, 128–131
sharing, 141

Timelines album, 209–210
Tint field, Primaries palette, 14
tonal ranges, HDR palette, 317–329
tracking

features, 247–253
objects, 241–244
obscured objects, 74–78
people, 244–246

tracks, fixing, 74–78, 250–253
Training and Certification Program, xi
translation errors, fixing, 135–141
Twitter render preset, 344

U
undoing, 15
User Cache modes. See caching

V
versions, 189–193. See also local versions; 

remote versions
Vectorscope, 96, 99, 115–118
viewer

adding data burn-in to, 264–267
enlarging, 17, 58
expanding, 109
features, xv–xvii
Highlight mode, 64, 80, 165, 

178, 293, 323
Loop button, 286
navigating, 281
warping colors in, 95–101
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zooming in and out of, 81
vignettes, 68–69, 272–274
Vimeo render preset, 344

W
warping color ranges, 95–101
watermark, applying over video, 266
waveform, 10–29

versus parade, 27–28
settings window, 12

windows
customizing, 87–88
using to draw attention, 62–65
using to limit qualifiers, 84–86

wipes
inverting, 47
toggling on and off, 53

X
XML file type, 127
XML timeline, importing, 128–131
XYZ color space, DCP (digital cinema 

package), 352, 355

Y
YouTube render preset, 344–348
YRGB color management,  

140, 146–152, 222–226

Z
zooming in and out of viewer, 81
Zones Graph, HDR palette, 324



Color Page Workflows

Reading Scopes

Secondary Grading

Node Editor Pipeline

 The Colorist Guide to

 DaVinci
 Resolve 18
DaVinci Resolve 18 is Hollywood’s most popular color correction 
software and is used to color grade more feature films, television 
shows, and commercials than any other application. This official 
Blackmagic Design hands on training guide takes you through 
a series of practical exercises that teach you how to use DaVinci 
Resolve’s color correction tools in detail. You’ll learn a wide 
variety of workflows, effects, and the tools necessary to perform 
Hollywood caliber grades.

What You’ll Learn
• Launching DaVinci Resolve project files and restoring archives

• Normalizing, balancing, and matching footage

• Analyzing and color correcting images with the help of scopes

• Tracking people and objects with windows and the magic mask

• Migrating XML timelines and roundtrip workflows

• Preparing projects for film and television with color management

• Working with nodes to create sophisticated grades

• Managing and copying grades with stills, versions, and color trace

• Creating groups to streamline your workflow

• Color grading high dynamic range raw footage

• Render cache and delivery settings for optimal quality

• Dozens of tips and tricks that will transform how you work!

Who This Book is For
This book is designed for video editors who want more control over 
the final appearance of their projects and colorists who want a more 
advanced understanding of industry workflows and best practices. It 
contains clear and concise lessons, along with dozens of tips and tricks 
from professional colorists to help you create cinematic images that 
stand out! You’ll learn about the primary grading tools used for balancing 
and matching images, secondary tools for isolating parts of an image, 
how to read scopes, create unique looks, and much more!

http://www.blackmagicdesign.com

	Contents
	Foreword
	Acknowledgments
	About the Author
	Getting Started
	Introducing Blackmagic Cloud
	Interface Review
	Color Page Layout
	Viewer
	Primaries Color Wheels
	Palette Panel

	Color Correcting a DaVinci Resolve Timeline
	1: Balancing Footage
	Opening a DaVinci Resolve Archive
	Setting Up Project Backups
	Understanding the Grading Workflow
	Setting Tonal Range and Contrast
	Balancing Colors
	Comparing Color and Log Wheels
	Self-Guided Exercises
	Lesson Review

	2: Creating Color Continuity
	Building a Shot-Matching Strategy
	Organizing Shots Using Flags and Filters
	Applying Shot Match
	Matching Shots Using Stills
	Comparing and Matching Shots Manually
	Self-Guided Exercises
	Lesson Review

	3: Correcting and Enhancing Isolated Areas
	Controlling the Viewer’s Eye
	Sharpening Key Elements
	Tracking Obscured Objects
	Fixing Overcast Skies
	Warping Color Ranges
	Enhancing Skin Tones with Face Refinement
	Adjusting Skin Tones Manually
	Self-Guided Exercises
	Lesson Review

	Managing Nodes and Grades
	4: Conforming an XML Timeline
	Importing an XML Timeline
	Syncing an Offline Reference
	Conforming a Timeline
	Associating HQ Footage with a Timeline for Online Workflows
	Maximizing the Dynamic Range
	Lesson Review

	5: Mastering the Node Pipeline
	Understanding Node-Based Grade Compositing
	Recognizing the Importance of Node Order
	Creating Separate Processing Pipelines with a Parallel Mixer Node
	Visualizing Mixer Nodes
	Compositing Color Effects with the Layer Mixer Node
	Lesson Review

	6: Managing Grades Across Clips and Timelines
	Copying Grades from Clips and Stills
	Working with Local Versions
	Appending Grades and Nodes
	Saving Grades for Other Projects
	Copying Timeline Grades Using ColorTrace
	Copying Grades Using the Timelines Album
	Self-Guided Exercise
	Lesson Review

	Optimizing the Grading Workflow
	7: Using Groups 
	Preparing Media Using Scene Cut Detection
	Creating a Group
	Applying Base Grades at the Pre-Clip Group Level
	Making Clip-Specific Adjustments at the Clip Group Level
	Automatically Tracking Objects and People
	Creating a Unifying Look Using the Post-Clip Group Level
	Applying Timeline-Level Grades and Effects
	Self-Guided Exercises
	Lesson Review

	8: Adjusting Image Properties
	Understanding Timeline Resolutions and Sizing Palette Modes
	Using Keyframes to Animate Grades 
	Applying Noise Reduction
	Optimizing Performance with Render Cache
	Self-Guided Exercises
	Lesson Review

	9: Setting Up Raw Projects
	Adjusting Raw Settings at the Project Level
	Adjusting Raw Settings at the Clip Level
	Grading High Dynamic Range Media
	Setting Up a Render Cache for Raw Media Projects
	Self-Guided Exercises
	Lesson Review

	10: Delivering Projects
	Using Lightbox to Check Timelines Prior to Delivery
	Understanding the Render Workflow and Presets
	Creating Custom Renders and Saving Presets
	Configuring a Timeline for Digital Cinema
	Exploring Advanced Render Settings
	Lesson Review

	Using the DaVinci Resolve Panels
	Index



